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Preface

Preface
This preface introduces information sources that can help you use the application and this guide.

Using Oracle Applications  

To nd guides for Oracle Applications, go to the Oracle Help Center at hp://docs.oracle.com/.

Documentation Accessibility  

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.

Contacting Oracle  

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For
information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to:
talent_acquisition_doc_feedback_ww_grp@oracle.com.

i

http://docs.oracle.com/
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
mailto:talent_acquisition_doc_feedback_ww_grp@oracle.com.
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1  Introduction

Taleo Connect  

Taleo Connect Server  
Taleo Connect Server is the server-side portion of the Taleo Connect Platform embedded within the Oracle Talent
Acquisition Cloud (OTAC) products. It enables the products to expose their integration oering through a secure
gateway using system-to-system type messages. The Taleo Connect Server export feature allows access to the OTAC
product's dictionary and its import feature accepts instructions to invoke service operations. The Taleo Connect Server
only accepts messages in the proprietary T-XML format wrapped in a standard SOAP envelope with Taleo extensions
(named T-SOAP).

Taleo Connect Client  
Taleo Connect Client (TCC) is the client-side portion of the Taleo Connect Platform that resides in the customer's
environment. It enables customers to build and execute their own integration processes.

Development Environment
The development environment is user-friendly and professional. It allows the design and conguration of simple to
complex integration scenarios.

The TCC design and conguration environment is built with the powerful and extensible Rich Client Platform (RCP) from
the Eclipse foundation. RCP is the standard for Java client user interface development oering a professional grade
experience to the end user.

All the user tasks are either wizard driven or based on natural client application behavior such as drop-down menus and
drag-and-drop functionality.

Integration Engine
The integration engine is powerful and exible. It can communicate with the Taleo environment using multiple le
formats.

TCC communicates with Taleo products using proprietary Taleo message formats that are based on industry standards
such as XML, SOAP, and WS-Addressing. It also supports custom message formats through client-side or server-side
transformations since customer systems usually only support their own formats.

TCC shields the complexity of the asynchronous integration process from the customer and provides a synchronous-like
behavior that can integrate into other business processes.

1
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Taleo Connect Users  
TCC requires a user account to be able to access the zone and conduct integration jobs. This user needs to be
congured with System Integrator permissions for the products that you wish to integrate with.

It is recommended that when creating integration user accounts to be used with TCC, that dierent UID/PWD
combinations are used for each zone. This will remove any inadvertent issues around zone access.

2
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2  Installation

Files and Folders  

File Name  
Distinctive le names facilitate the management of various integration points.

Touchpoints
• Import

An import touchpoint corresponds to an available Taleo product service oering as dened in the data
dictionary. The services have the same name as the business entity for which they oer specic import
operations. For example, in the SmartOrg Data dictionary, the Group service oers create, delete, merge, and
update operations. Other services may oer dierent operations.

• Export

An export touchpoint corresponds to the information to be extracted from a particular Taleo product business
model.

Actions
The import actions correspond to the specic operations oered by the service. There is only one export action, and
that is an export.

File Name Standards
• Import

Load le: <touchpoint>_<action>_ld.xml

Conguration le: <touchpoint>_<action>cfg.xml

Data le: <touchpoint>_<action>.csv

Result le: <touchpoint>_<action>_result_<date_time>.csv

• Export

Query le: <touchpoint>_<action>_sq.xml

Conguration le: <touchpoint>_<action>_cfg.xml

Result le: <touchpoint>_<action>_result_<date_time>.csv

Examples
• Import
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Load le: user_merge_ld.xml

Conguration le: user_merge_cfg.xml

Data le: user_merge.csv

Result le: user_merge_result_20080715T084011.csv

• Export

Query le: newhire_export_sq.xml

Conguration le: newhire_export_cfg.xml

Result le: newhire_export_result_20080715T090517.csv

Folder Structure  
A well organized folder structure facilitates the management, development, testing, and migration from staging to
production of the various integration point les.

The image illustrates a well organized folder structure.

Level 0
This is the root folder for Taleo integrations. It contains the following:

• Zones

A folder for each zone that is available such as production, staging, development.

Level 1
This is the Zones folder level. It contains the following:

• touchpoint_action

4
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A folder for each import and export integration point.

Level 2
This is the integration point folder level. It contains the following:

• For import integration points:

The inbound folder for data les to import.

The outbound folder for result les.

• For export integration points:

The outbound folder for result les.

Level 3
This is the import integration inbound folder level. It contains the following:

• archives

The archives folder to save imported data les.

Windows  

Installing TCC in Windows  
One of the following operating systems pre-installed:

• Windows Server 2008

• Windows Server 2012

• Windows Server 2016

• Linux

Hardware:

• Design and development workstation, ~1GHz, 256 MB RAM

• Large volume production workstation, ~1 GHz, 512MB RAM

Software:

• Product Integration Pack (PIP) setup program

• Taleo Connect Client setup program

Security approval from your information security department to install TCC.

5
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TCC installation packages come bundled with a 32 bit version of Java Runtime Environment.

• 17.0 - JRE 1.8

TaleoConnectClient.exe always uses the information in the jre folder created during installation, no maer what
value is specied in JAVA_HOME. If the jre folder is deleted or renamed, making it impossible to nd, the value set in
JAVA_HOME is used. If JAVA_HOME is set to a 32 bit version everything works. If JAVA_HOME is set to a 64 bit version
the "Can't load IA 32-bit .dll on a AMD 64-bit platform" error is displayed.

TaleoConnectClient.bat will work with 32 or 64 bit versions because there is no UI to display. The presence or absence of
the jre folder, or the value set in JAVA_HOME have no impact.

1. Create an [INSTALL FOLDER] in which to install the PIP and TCC folders.
2. Double click the Product Integration Pack setup program. The Welcome to the Taleo Connect Client Product

Integration Pack Setup Wizard window opens.
3. Follow the installation instructions. The ProductIntegrationPack folder containing the pip and fp type les is

created in the [INSTALL FOLDER].
4. Double click the Taleo Connect Client setup program. The Welcome to the Taleo Connect Client Setup Wizard

window opens.
5. Follow the installation instructions.
6. In the Completing the Taleo Connect Client Setup Wizard window, deselect the Launch Taleo Connect Client

and View README le check boxes before you click Finish.
Taleo Connect Client is installed in the [INSTALL FOLDER].

Testing TCC in Windows  
Testing TCC in Windows validates the endpoints, the user names and passwords, and communication between TCC and
the Taleo products.

• TCC is installed in Windows.

• Production and staging zones are up and running.

• Integrator user name and password for production and staging zones.

On successful completion of the test the TCC graphic user interface opens. On test failure a Ping Error is displayed. To
troubleshoot, refer to the TCC Errors list in Appendix B.

1. Launch Taleo Connect Client.
If you have selected a folder containing at least one valid PIP le during installation, the Ping the Taleo Product
window opens. Otherwise, the No product integration pack le congured window opens. Navigate to the
ProductIntegrationPack folder and select it. The Ping the Taleo Product window opens.

2. Select the product to connect to from the pull down menu.
3. Congure the connectivity information.

a. Select protocol from pull down menu.
b. Enter host name.
c. Enter port number.

Production or staging zone host name, for example acme.taleo.net or stgacme.taleo.net. Taleo zones uses
HTTPS protocol with port 443.

4. Congure the authentication information.

6



Talent Acquisition Cloud
Using Connect Client

Chapter 2
Installation

a. Select authentication.
b. Enter user name.
c. Enter password.

5. Click Ping. The Ping the Taleo product window closes. An information window indicating the creation of a new
endpoint opens.

6. Click OK.

The TCC graphic user interface opens or a Ping Error message appears.

Upgrading TCC in Windows  
Upgrading to the latest version of TCC allows users to take advantage of the latest xes, enhancements, and new
features. Oracle recommends following the upgrade process described below to ensure smooth transition and minimal
impact on existing integration scripts.

An [INSTALL FOLDER] for the new version of TCC, dierent from the current installation location.

1. Download and install the latest TCC version.
2. Download and install the latest product integration packs.

To install a product integration pack, unzip the downloaded le into the [INSTALL DIRECTORY]/
productintegrationpacks directory.

3. Create the conguration board, in order to run existing integration scripts that use conguration board symbols
or endpoints.

4. Synchronize the custom dictionaries in order to have custom elds.
5. Set the last run date to the actual value in export congurations that use a LRD pre-processing step.
6. Test the existing integration scripts with the new TCC version.

If using Net Change, TCC users MUST run the “Net Change Setup” to create the Net Change database for the
new TCC version.

7. Modify any existing reference to the TCC installation location to point to the new location.

Linux  

Installing TCC in Linux  
Installing TCC in Linux enables users to run import and export conguration les, in a command line environment.

• Operating system:

Linux

• Hardware:

Large volume production workstation, ~1 GHz, 512MB RAM

• Software:

JRE 1.8.0 or JRE 8.0

7
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TaleoConnectClient-X.Y.Z.tar.gz le

• Security approval from your information security department to install TCC.

1. Copy the TaleoConnectClient-[version].tar.gz le to your Linux environment.
2. Unzip the le with this instruction, gunzip TaleoConnectClient-[version].tar.gz. The following le is generated,

TaleoConnectClient-[version].tar.
3. Untar the le with this instruction, tar –xf TaleoConnectClient-[version].tar.

The Taleo Connect Client is installed in the tcc-[version] directory.

Testing TCC in Linux  
Testing TCC in Linux validates the conformity of the integration workow between TCC and the Taleo products.

• TCC is installed in Linux.

• Production and staging zones are up and running.

• Linux system has access to zones.

• Valid import specication and data le, and associated conguration le.

• Valid export specication and associated conguration le.

1. Invoke import conguration execution.
2. Invoke export conguration execution.
3. Verify monitoring les.
4. Verify result les.

Upgrading TCC in Linux  
Upgrading to the latest version of TCC allows users to take advantage of the latest xes, enhancements, and new
features. Oracle recommends following the upgrade process described below to ensure smooth transition and minimal
impact on existing integration scripts.

An [INSTALL FOLDER] for the new version of TCC, dierent from the current installation location.

1. Download and install the latest TCC version.
2. Download and install the latest feature packs

To install a feature pack, unzip the downloaded le into the [INSTALL DIRECTORY]/featurepacks directory.

3. Copy the conguration board from [OLD INSTALL DIRECTORY]/system/default.conguration_brd.xml to [NEW
INSTALL DIRECTORY]/system directory, in order to run existing integration scripts that use conguration board
symbols or endpoints.

4. Copy the last run date les from [OLD INSTALL DIRECTORY]/lastrundates/*.xml to [NEW INSTALL
DIRECTORY]/lastrundates directory.

5. Test the existing integration scripts with the new TCC version.

If using Net Change, TCC users MUST run the “Net Change Setup” to create the Net Change database for the
new TCC version.

8
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6. Modify any existing reference to the TCC installation location to point to the new location.
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3  Description

Taleo Connect Client Basics  

Ping Dialog  
The Ping the Taleo product window opens when Taleo Connect Client is started. The ping dialog validates the
endpoints, the user names and passwords, and communication between TCC and the Taleo products.

The ping dialog uses the default conguration board endpoint seings. The original default board le is provided by
your Integration Customer Support representative. If this le has not been provided, you can manually enter zone
information in the Endpoint and the Authentication sections.

11
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Connectivity Information
The Connectivity Information section provides the connectivity information to access the product.

• Product: The product to ping is selected from the pull down menu.

• Company Code: The company code is not used.

• Endpoint: The Endpoint to use is selected from the pull down menu.

Endpoint
The Endpoint section displays the seings of the selected Endpoint. If no endpoints are congured, the information can
be entered manually.

• Protocol: The protocol to use is selected from the pull down menu.

• Host: Production or staging zone name, for example acme.taleo.net or stgacme.taleo.net.

12
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• Port: The port number to access the Taleo product. Port 443 is used by default.

Authentication
The Authentication section provides the authentication context for the requests.

• No authentication: No authentication is listed as an option for testing purposes.

• Basic authentication: This is the minimum requirement to connect to the Taleo environment.

• Cert Based authentication: This is used to sign the requests and responses between Connect Client and Oracle
Taleo Enterprise Cloud Service. This is in addition to basic authentication.

For both types of authentication, the user must provide the following information:

• User: The user name for integration must be created with an integrator role.

• Password: The integration user password.

Import Endpoint
The Import Endpoint link opens a window where the user can locate the original default conguration le supplied by
Oracle Support or a legacy environment properties le and retrieve the endpoint seings.

Certicate Management
The Certicate Management link opens a window where the user can generate, import, download, and delete
certicates.

Oracle supports the signing of requests and responses between Taleo Connect Client (TCC) and the Oracle Taleo
Enterprise Cloud Service zone. To activate communication signing, a certicate must be generated in TCC and imported
in the Taleo zone. A certicate must also be generated in the Taleo zone and imported in TCC. Both certicates are
needed for the signing feature to work. When requests and responses are sent by both TCC and Taleo, they are signed
by the sender. The signature is validated by the receiver before processing the payload.

When generating a Connect Client certicate, you must set the certicate’s validity start date and end date. An alias is
also required to identify the certicate. Only one certicate can be valid at a given time. You must create validity periods
that do not overlap. Once the certicate is generated, you download it. To complete the certicate setup, the Taleo
administrator accesses the TCC Security feature in Taleo and imports the TCC certicate. For instructions on how to
import the TCC certicate in Taleo, see the Recruiting User Guide.

Ping
The Ping buon starts the process. When the process is successful, TCC starts. If there is a failure, an error message is
displayed. Refer to the error messages in Appendix B for additional details.

13
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Eclipse RCP Framework  
The Taleo Connect Client integration development environment is based on the Eclipse foundation's Rich Client
Platform project  (hp://www.eclipse.org) . It is important to understand the underlying concepts of this framework
before going through the features in Taleo Connect Client.

Underlying Concepts
A perspective is a logical grouping of elements that organizes the work for the user in a clear and uncluered fashion
(including views, tool bars, and menu items).

An editor is a user interface that allows a user to create and update a particular part of the integration process. Multiple
editor types and instances may be opened in a single perspective.

A view is a read-only auxiliary element that oers information about the active editor. As such, views react to selections
within the active editor and to changes to dierent editor instances.

A preference is a seing that aects the user experience within the application. All preferences have a default value set
by Taleo that can be changed by the user and preserved between work sessions.

TCC Menu Bar  
The TCC menu bar gives access to le utilities, a report viewer, window utilities, and the help system.

File
• New

New Conguration Wizard: Opens a blank conguration specication in the editor.
New Import Wizard: Opens a blank import specication in the editor.
New Export Wizard: Opens a blank export specication in the editor.
New Prole Wizard: Opens a blank console prole in the editor.

• Open
Conguration: Opens a browser to select an existing conguration specication to open in the editor.
Import: Opens a browser to select an existing import specication to open in the editor.
Export: Opens a browser to select an existing export specication to open in the editor.
Console Prole: Opens a browser to select an existing console prole to open in the editor.
Conguration Board: Opens the Default Conguration Board in the editor.

• Close
Closes the active le in the editor.

• Close All

14
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Closes all les in all editors.

• Save
Saves the active le with the same name in the same folder.

• Save As...
Opens a browser window to save the active le in a specic folder as a specic le name.

• Exit
Closes Taleo Connect Client.

Report
• Schedule monitoring...

Opens the Schedule Monitoring Report. The report lists the Scheduled processes, the next expected run date,
and the last run status and date.

Window
• Open Perspective

Console
Design
Runtime

• Show View

◦ Basic

◦ Client

◦ Document

◦ General

◦ Help

◦ Message

• Preferences

◦ Client
Product Integration Packs root folder*: The path of the root folder where the product Integration Packs
are installed. This value is saved in the TaleoConnectClient.ini le.
*Take note that system property will override the TaleoConnectClient.ini property.

◦ Client>Design
Sample CSV viewer: CSV le editor that opens during sample CSV le creation. Microsoft Excel is the
editor by default.
Maximum depth of the entity tree: Advanced seing, do not change value unless directed by Oracle
Support.
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◦ Client>Runtime

Monitoring auto-refresh rate (seconds): Advanced seing, do not change value unless directed by Oracle
Support.

Number of les to keep in monitoring history: Advanced seing, do not change value unless directed by
Oracle Support.

◦ Console

Advanced seings, do not change values unless directed by Oracle Support.

◦ General

Advanced seings, do not change values unless directed by Oracle Support.

◦ Help

Advanced seings, do not change values unless directed by Oracle Support.

◦ Restore Defaults

Restores all seing to their default values.

◦ Apply

Applies new seings to Taleo Connect Client.

Help
• Help Contents

Opens the online help window.

• About Taleo Connect Client

◦ Feature Details: Opens a list of TCC features.

◦ Plug-in Details: Opens a list of installed plug-ins.

◦ Conguration Details: Displays the TCC conguration details.

Design Perspective  
The design perspective is where the integration process workow is built and where you determine how to extract
information from or upload information to the Taleo environment. A specic editor is oered for each of these activities.

16
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Outline View  
The Outline view shows a structured view of the content of the current editor.
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Entity View  
The Entity View shows the structure of the entity selected within an Export Editor or a service operation parameter
selected within an Import Editor.
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Each service operation oers a specic set of parameters that can be used to dene the characteristics of data columns.
Refer to the data dictionary for additional details.

The root entity has a set of elds and relations. The information section at the boom of the view displays the details of
the selected element.

Product Integration Pack View  
The Product Integration Pack View shows the entire integration oering of a Taleo product with the available standard
content.

Model
The Model section oers a selection of the installed product integration packs. Each product has typically a single
model, although previous models may be included for backwards compatibility purposes.
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The state of the dictionary is indicated for the displayed product model. The Synchronize custom elds buon is used to
update the data dictionary with user dened elds found in the Taleo product.

Dictionary tab

The Dictionary tab describes the entities available in the business model. These entities can be searched with an
update-as-you-type lter box or with available for export or import lter buons.

Each entity has a set of elds and relations. The relationships can be navigated to the related entity by double clicking,
and back to the original entity with the Return icon.
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Services tab

The Services tab lists the services available for this product. The services can be searched with an update-as-you-type
lter box. The available operations are specic to each service.
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Templates tab

An import template is used to create an import specication for the given entity. The columns provided in the template
are typical of integration processes with the Taleo product.

An export template is used to create an export specication for the given entity. The projections (elds) provided in the
template are typical of integration processes with the Taleo product.

An export lter is used as a specic ltering element in an export specication. Export ltering elements from the
Product Integration Pack are resolved only at runtime in the Prepare Export step; that is, the source export le does not
contain the denition of the ltering, but only a reference to the ltering name.
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Log View  
The Log View lists all error messages produced by the various editors and views.

• The rst column shows the severity of the message with an icon.

• The Date column displays the date of the error.

• The Source column displays the source of the error.

• The Message column displays the error message

Diagnostic View  
The Diagnostic View shows the warnings or errors associated to the current Editor.

• The rst column displays the type of Editor that generated the diagnostic message with an icon.

• The second column displays the severity of the message with an icon.

• The File column displays the le name of the Editor that generated the message.

• The Message column displays the actual description of the diagnostic message.

• The Detail column displays additional details.

Jobs View  
The Jobs View lists the jobs running in the background.

Documentation View  
The Documentation view displays eld and relation descriptions from the data dictionary, for the element selected in
the Entity or Production Integration Pack views.
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Default Conguration Board  

Board Editor  
The board editor enables users to create endpoint and symbol elements and save them in the
default.conguration_brd.xml le for later use.

The Default Conguration Board facilitates migration from one environment to another (Staging to Production,
Windows to Linux) by centralizing endpoint and symbol information in one le.

The default conguration board le location is [TCC_HOME]\system\default.configuration_brd.xml. This path and le
must be copied to the production environment (Windows, Linux) to use centralized symbols and endpoints.
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Conguration Board Elements
An ordered list of all the conguration board elements is displayed. The remove buon deletes selected board elements.
The Add buon creates new board elements.

Endpoint Element
• General

The reference name is what is displayed in the ordered list and in the pull down menus when endpoint
information is required.

The Default check box assigns the selected endpoint to be used by default.
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• Endpoint

The Endpoint section provides the actual connectivity information for the Taleo environment:

Protocol: Taleo zones use HTTPS

Host: Production or staging zone name, for example acme.taleo.net or stgacme.taleo.net.

Port:Taleo zones use port 443.

The communication path can be set by default, be provided by the full Path directly, or by a combination of the
service dispatcher Path and Service Name. The complete web service path can also be provided.

• Authentication

The Authentication section provides the authentication context for the requests.

No authentication: No authentication is listed as an option for testing purposes.

Basic Authentication: This is the minimal requirement to connect to the Taleo environment.

Cert Based Authentication: This is used to sign the requests and responses between TCC and Taleo. This is in
addition to basic authentication.

For both types of authentication, the user must provide the following information:

◦ User: The user name for integration must be created with an integrator role.

◦ Password: The integration user password.

Symbol Element
Symbols can be used anywhere in a conguration le and their values are resolved when executing the integration job.
These are name and value pairs.

For example, Name=OUTPUT_FOLDER and Value=c:\tcc\output. The symbol is resolved to the value set in the default
conguration board when it is used in a conguration le.

Note: Windows supports backslash (\) and forward slash (/) as path delimiters. When production and staging zones
run under a Linux operating system, it is recommended to use forward slashes in conguration les since this is the
only path delimiter supported by those systems. This simplies moving integration congurations from staging to
production environments since no modications are required to the le paths in the conguration les.

• NOW (“DateTimePaern”)

The symbol will be replaced by the current date and time. The date and time is resolved only once for a
conguration execution. Therefore if you refer to the NOW( ) symbol in a preprocessing step, it will be that
resolved value.

The default date format is: NOW(“yyyyMMdd'T'HHmmss”) = 20080702T10:12:00

You can specify the time format by using any supported date and time paern: NOW(“EEE, MMM d,
yyyy”)=Wed, Jul 2, 2008

• NUMBER_FORMAT ([symbolName])("paern")

The symbol will be replaced by the formaed number. This token has two parameters which are the number to
format and the paern to apply on the number to format.
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The paern parameter can be composed of the following characters:

◦ 0 - Digit

◦ # - Digit, zero shows as absent

◦ . - Decimal separator or monetary decimal

◦ , - Grouping separator

For example, [NUMBER_FORMAT([itk_aribute_count])("0000000000000")] or
[NUMBER_FORMAT([itk_aribute_count])("#,##0.00")]

• CFGFOLDER
The symbol will be replaced by the conguration le folder location.
The conguration le location is: c:\tcc\myjob\candidateexport_cfg.xml.
The token will be replaced at runtime by: c:\tcc\myjob

• UUID
The symbol will be replaced by a universally unique identier. This is the same token that can be used in the
workow identier.

• HOST
The symbol will be replaced by the host name of the workstation. This is the same token that can be used in the
workow identier.

• RANDOM
The symbol will be replaced by a random integer. This has the same purpose as the UUID but it is smaller (32
bits). There is no warranty to be globally unique.

• SYSTEMPROPERTY(“system.property.name”)
The symbol will be replaced by the specied property name.
For example: [SYSTEMPROPERTY(“java.io.tmpdir”)]/tcc, places temporary les in the tcc folder under the
system's default temporary directory.

• Overriding symbol value
When executing TCC via the command line, you can override any symbol by specifying a system property with
the following paern: com.taleo.client.symbol.TOKEN_NAME
For example, to override the [OUTPUT_FOLDER] symbol dened in the default conguration board, specify the
following system property when launching TCC:
-Dcom.taleo.client.symbol.OUTPUT_FOLDER=c:\folder\override

• Open bracket symbol delimiter
TCC uses the open bracket [ as a symbol delimiter. To use the open bracket more than once it must be doubled.
Normaly the regex_count function is wrien like this:
<quer:customFunction name="REGEXP_COUNT">
 <quer:customFunction name="REGEXP_REPLACE">
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 <quer:field path="ProfileInformation,Candidate,HomePhone"/>
 <quer:string>[^0-9]+</quer:string>
 <quer:string/>
 </quer:customFunction>
 <quer:string>[[:digit:]]</quer:string>
 <quer:string>1</quer:string>
 <quer:string>i</quer:string>
 </quer:customFunction>

To work properly in TCC, it must be wrien like this:

<quer:customFunction name="REGEXP_COUNT">
 <quer:customFunction name="REGEXP_REPLACE">
 <quer:field path="ProfileInformation,Candidate,HomePhone"/>
 <quer:string>[^0-9]+</quer:string>
 <quer:string/>
 </quer:customFunction>
 <quer:string>[[[[:digit:]]</quer:string>
 <quer:string>1</quer:string>
 <quer:string>i</quer:string>
 </quer:customFunction>

Creating Endpoints  
Taleo Connect Client is running.

1. Click File > Open >Conguration Board.

The board editor opens.

2. Click Add.

A popup dialog opens.

3. Select Add a new endpoint element.
4. Click OK.

A new Endpoint board element appears in the list

5. Enter the endpoint information.
a. Enter reference name.
b. Select default to set this endpoint as the default endpoint.
c. Select protocol from pull down menu.
d. Enter host name or IP address.
e. Enter port number. Taleo products use port 443.
f. Select service dispatcher path, and enter information if necessary.

g. Select authentication method.
h. Enter user name.
i. Enter password.

6. Click Save.
7. Close board editor.

28



Talent Acquisition Cloud
Using Connect Client

Chapter 3
Description

Creating Symbols  
Taleo Connect Client is running.

1. Click File > Open > Conguration Board.

The board editor opens.

2. Click Add.

A popup dialog opens.

3. Select Add a new symbol element.
4. Click OK.

A new symbol board element appears in the list.

5. Enter symbol name.
6. Enter symbol value.
7. Click Save.
8. Close board editor.

Import  

Import Editor  
The Import Editor creates a specication to upload comma separated value (CSV) les into a Taleo product.

Each service operation supports a list of parameters that can be simple values or dictionary entities. Each column is
associated to a particular parameter. For entity type parameters, each column is associated to a eld or relation of the
entity itself.

General Tab  
The general tab presents information that applies to the whole load le.

29



Talent Acquisition Cloud
Using Connect Client

Chapter 3
Description

Operation information
The Operation information describes what import service operation of the Taleo product oering is used. This
information is set when creating the import specication le and cannot be changed.

Listed are:

• Product

• Model

• Service

• Operation

Locale
The Locale determines the language used when uploading multilingual values for columns where the default locale
strategy has been selected.

The default language for multilingual elds, such as descriptions, is selected from the pull down list.

Other information
The CSV format determines the characteristics of the request message.
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When Header present is checked, it indicates that the source le contains an initial record containing the header of the
columns. It is required to prevent using the values of the header line as an actual upload record.

Value delimiter determines the character used to separate values within a particular record. CSV le values can be
separated by commas (,), pipes (|), or other characters. Taleo recommends the comma as a value delimiter for CSV les.

Quotation character determines the character used to quote (i.e. surround) a particular value that may contain special
characters, such as the value delimiter. Taleo recommends the double quote (") as quotation character.

Fields with embedded double-quote characters must be delimited with double-quote characters, and the embedded
double-quote characters must be represented by a pair of double-quote characters. For example, width 50”:

• true,“width 50”” etc”,abc is valid

• true,“width 50” etc”,abc is invalid

Advanced: Other import options
The integration processor executes specic code in the Taleo environment before the rst imported entity and after the
last imported entity. The mandatory integration processor is automatically added when selecting the desired import
service. For OLF entity imports, the “olf” integration processor is added. For Department delete, the “maintenance”
integration processor is added.

Additional import options are used to toggle specic behavior when processing the integration document. These are
name and value pairs.

• switch.system.maintenance
This option allows you to automatically switch the zone to maintenance mode when importing Organization,
Location, or JobField (OLF), or deleting Department.

• Possible values:

◦ always: The integration processor will force the zone to switch into maintenance mode.

◦ never: When importing OLF entities or deleting Department entities, the result le displays “To make any
changes, the system must be in maintenance mode.”.

• non.updatable.elds
Special behavior when trying to update a non-updatable eld. This is very useful when calling a merge service
where some values are required to create a new entity but cannot be updated.

• Possible values:

◦ error: the record update will fail when non-updatable elds are found during the import. This is the
default behavior.

◦ error.dierent: the record update will fail when trying to change the value of a non-updatable eld.

◦ warn: will never try to update the eld value. A warning will be logged within the integration message
saying the value has not been updated.

• info.import.limit
This option allows you to retrieve information about your daily import limit and count.

• Possible values:

◦ true: the response SOAP document contains the info.import.daily.limit and the
info.import.daily.count aributes.
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◦ false: the limit and count aributes are absent from the response SOAP document.

• progress.interval

Denes the interval, in number of records processed, used to update the progress of the request in the monitor.
For example, seing a value of 100 on a request containing 2000 records, would limit to 20 the number of
progress updates sent to TCC.

• Possible values:

A positive number, the default value is 1.

Columns Tab  
A Column denes the conversion rules for a particular value of a record of the source le.
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Column
An ordered list of all the columns in the import specication is built by dragging and dropping elds from Entity view
Structure section. The Up and Down buons allows sorting of the elds in the required order. The remove buon
deletes selected column. The Add buon creates new columns:

• data column
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Field from Entity view Structure section. The dierent service operations oer specic parameters that can be
used as data columns.

• locale column

Special column indicating locale, it is used with multilingual elds Record locale type.

• identier column

Adding an Identier column simplies troubleshooting the error messages in the results le. It is not processed
by the Taleo product.

Use the same value as the key eld for the record. It will be returned in the result le with a mention of success,
error, or failure.

• ignore column

An ignore column is never processed. It is used when the customer system generates a column that has no
equivalent in the Taleo product.

There are several import eld types:

• Search or lookup elds are identied with a magnifying glass icon.

• Key elds are identied with an orange key icon (visible after checking Use the value for search or lookup).

• Non updatable elds are identied with a red circle icon.

• User dened elds (UDFs) are identied with a person icon.

Numerous column options can be set in the following sections. Some options are eld specic. To set these options,
click on the column to select it.

Column information
The header is a label used to identify the column for information purposes only. The value is disregarded during the
actual integration process.

The Field entry determines the actual eld of the root entity. Values can be dragged here from the Entity Structure view.

Behavior
The Behavior section determines what kind of information the value provides to the import.

Use the value to search or lookup: The column may be used to search within the Taleo product for existing entities.
There are two types of searches:

• Key column search: The search value aects (targets) the root entity. A key icon marks the column. As such, a
key is used to actually search for the entity within the Taleo product. A record may have several keys to rene
the search; however, an update can only be executed on one entity at a time. As such, the search keys must
turn up either no entities or exactly one; any other result will cause an error.

• Lookup column search: The search value does not aect (target) the root entity. A lookup icon marks the
column. It is used to create a relation between the entity and another entity within the Taleo product. A typical
example of lookups are locations. For example, when creating a requisition for Canada, we need to link the
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entity to the Canada location, not create a new Canada entity. In particular, a eld of the root entity can never
be looked up; a relation is required for this particular type of search.

• Target: When importing a eld that is a relation to another entity, not a standalone eld, it will use the value
to lookup the Target and bind it to the main entity, rather than update it. For example, if you want to use the
Loginname as the search key for your User import, click the browse buon and Select User.

• Also set this value in the entity: When checked, it means that the import will try to update the eld. It will not
work for a lookup, but will work for a search. For example, if you try to import candidates and you use the email
address as a search key, it will also set the email address if it creates a new candidate.

Start a new element in the collection: Some relationships are collections, because an entity can have multiple
occurrences for that relationship. In the Basic Question import template, multiple answer questions mandate the use of
more than one answer. To support this, each of the Answer columns (Question, PossibleAnswers, Description eld) is
marked as starting a new PossibleAnswer element of the PossibleAnswers collection.

• Target: For example, to import 2 job-specic applications for the same candidate with at least 1 work
experience for each application. Change the Target of the collection for the 1st and 2nd requisition to
PreselectionApplication, but leave the Target of the option Use the value to search or lookup as is.

Start a new parameter collection item: The behavior of this option is the same as Start a new element in the collection,
but for parameters rather than entities. For example, if you want to import multiple motives in a candidate move (CSW),
you must nd the motive in the Parameter list box, and then check this option for each motive occurrence. Note that
this option is not frequently used.

Skip column if value is empty: The column may be ignored if the value provided in the le is empty. This is the case
mainly when an entity eld is optional but does not support the empty string as a valid value. In the Basic Question
import template, not all questions will have the same amount of answers. However, you cannot import an empty answer
in a question. To support both these restrictions, all answer related columns are marked as optional. Although the CSV
le must always contain the total number of values in each row, when certain are empty the answers are not created.

Value is the location of a le to aach: The column value may be the location of a le that is to be aached to an entity.
In such cases, the content of the le is compressed using the G-ZIP algorithm and then encoded in the base-64 scheme
to ensure data integrity when embedding the le in the T-XML document. For example, the CurriculumVitaeLocation
column (AachedFiles,Content eld) is congured to contain the location on the local system of a le to aach to the
candidate. The le needs no preparation nor compression nor encryption and all Taleo supported formats are accepted
(HTML, text, Microsoft Word, etc).

Reset the collection: The default and only possible value for this parameter in TCC is TRUE. To change the default
behavior, enter the value FALSE in the corresponding column of the CSV le. The value set in the CSV le will override
the default TCC value for that parameter.

When “Reset the collection” is TRUE, the elements of that collection must not check the “Use the value to search or
lookup” parameter because those elements are removed and therefore don’t exist.

Please refer to the product data dictionary for the list of resetable relations.

Multilingual Fields
Multilingual elds can be imported in several dierent congurations.

• Default locale: Uses the Default locale set in the General Tab for that column.

• Specic locale: Uses the locale set in the Locale pull down menu for that column.
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• Record locale: Uses the Locale column to identify eld locale value. When this option is selected for a column,
the presence of a single locale column is mandatory. The value of this column should be a standard locale code
such as 'en' or 'fr'.

Advanced options
Advanced options are used to toggle specic behavior when processing the column value. These are name and value
pairs.

• default.value

A default value can be specied for columns that have no value set in the customer CSV le. Processing is not
executed when “Skip column if value empty” is checked.

• updatable

Some eld values only need to be sent to the target application once, usually during the create operation. Once
the column is dened as non-updatable, the eld values contained in that column are not sent to the target
application in an update operation. This advanced option is Net Change specic.

• Possible values:

◦ true: will update the eld (default)

◦ false: will not update the eld

Processing Instructions Tab  
Processing instructions allow customization and extension of import processing on elds and relations.

A processing instruction is a name value pair that can be set on any eld or relation available for import in TCC. The
aribute name is a predened string understood by a component in TCC indicating that special processing is required.
The instruction is processed locally by TCC, before or after the import depending on the particular instruction.
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Processing Instructions List
An ordered list of all the elds and relations that require processing instructions is built by dragging and dropping them
from the Entity view Structure section. The Up and Down buons allows sorting the elds and relations in the required
order. The remove buon deletes selected elds and relations. The Add buon creates a blank processing instruction
subject.

Processing Instruction
• Path

Path of the eld or relation for which a processing instruction is specied.

For a blank processing instruction subject, the path to a valid eld or relation can be entered manually.

• Instructions

The add buon enables the user to enter the instruction name value pair. Only predened instructions are
understood by TCC. Seing an invalid or unknown instruction will be ignored and have no eect.

The remove buon deletes the selected instruction.
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Creating a New Import File  
Make sure the Taleo Connect Client application is open.

1. Click File > New > New Import Wizard >Next.

2. Select a service from one of the available product models.
a. Select product from pull down menu. The Model is automatically selected based on the product.
b. Select Import Service from list. The available services have the same name as the entity they act on. A

lter is available to narrow down the choices.
3. Select le base.

Create new import specication is selected by default. This will create an empty import specication.

a. Select Operation from pull down menu.
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Templates are available for certain basic services. When one of those services is selected, Use the following
import template becomes available. This will create a populated import specication.

a. Select Use the following import template.
b. Select Template from pull down menu.

4. Click Finish.

The New import specication is displayed in the import editor.

Saving a New Import File  
Make sure a new import specication le is open in import editor.

1. Click File > Save.
2. Select directory.
3. Enter le name or select existing name in directory.
4. Select le type.
5. Click Save.

Opening an Existing Import File  
Make sure the Taleo Connect Client application is open.

1. Click File > Open > Import.
2. Select directory.
3. Select le in directory.
4. Click Open.

Building an Import Specication  
1. Verify that the information in the General tab is correct.
2. Click the Column tab.
3. Create columns.

a. Drag and drop the required elds from the entity structure view to the column view.
b. Set column behavior.

4. Save le.

Creating a CSV File  
A congured and saved import specication is open in the import editor.

1. Click the icon Generate a sample csv le.

A sample csv le with the import specication columns opens in the default editor.

2. Enter column data.
3. Save as csv le.
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Changing Default CSV Editor  
1. Open the Preferences window by clicking Window > Preferences > Client > Design.
2. In the Sample CSV viewer, click the Open window buon. The Select le window opens.
3. Navigate to the new CSV editor folder.
4. Select the CSV editor.
5. Click Open. The path and name of the new default CSV editor are displayed in the Sample CSV viewer dialog

box.
6. Click Apply then OK.

Export  

Export Editor  
The Export Editor uses a business model from a particular Taleo product version to create a specication for
information to be extracted from Taleo products.

Each export is based on a root entity from which all elds and relations are dened. From that entity, elds and relations
may be selected (projected) for extraction from the Taleo product.

General Tab  
The general tab presents information that applies to the whole export le.
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Entity information
The Entity information describes what entity of the Taleo product oering is exported. This information is set when
creating the export specication le and cannot be changed.

Listed are:

• Product

• Model

• Entity

Locale
The Locale determines the default language used when extracting multilingual elds for projections where the default
locale strategy has been selected.

The default language for multilingual elds, such as descriptions, is selected from the pull down list.
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Other information
The Alias is used to identify the query and reuse return results in sub queries.

The Export Mode determines how the extracted information is returned in the response message:

• T-XML: Uses a structured XML format (akin to a tree view) to represent the data. This mode is well suited to
complex data sets including several relations, for example, exporting new hires with their applications, the
associated requisition (job oer) information, the work experiences, the education elements, etc. The two
main limitations of the T-XML format is that only elds of the business model are allowed and that due to the
structure format, the performance of large exports is usually beer in the other modes.

• XML: Uses a at XML format (akin to a tabular list or an Excel spreadsheet) to represent the data. This mode is
well suited for large exports of simple data sets with no or only direct relations. For example, exporting all of the
users of a Taleo product or all of the currently opened requisitions. The main limitation of the XML mode is that
when n-ary relations are involved, one record per combination of relations is exported (i.e. for a candidate with
two work experiences and three education elements, a total of 6 records would be exported).

• CSV-entity: Based on the T-XML export mode, it handles multiple values and multilingual elds. All data related
to the root entity is located on the same line. When a column contains multiple values (multilingual or relations
of maximum cardinality "N"), the values are serialized inside a single column. The prevent duplicates, grouping,
and joining features are not supported by the CSV-entity export mode.

• CSV-report: Uses a at le format (that can be directly imported as an Excel spreadsheet) to represent the
data. This mode exports exactly the same information as the XML mode, hence has the same strengths and
weaknesses.

The following information only applies to the CSV modes.

When Header present is checked, it indicates that the projection aliases and eld names will be exported as the rst
record.

Value delimiter determines the character used to separate values within a particular record. By default the export uses
the comma (,) character.

Quotation character determines the character used to quote (i.e. surround) a particular value that may contain special
characters, such as the value delimiter. By default the export uses the double quote (") character.

The Record delimiter determines the character used to separate records within the le. By default the export uses the
new line character and thus places each record on a separate line.

Advanced: Other export options
The Advanced export options should only be used by Taleo certied specialists to tune the performance of certain large
extractions.

Additional export options are used to toggle specic behavior when processing the integration document. These are
name and value pairs.

• info.export.limit

This option allows you to retrieve information about your daily export limit and count.

• Possible values:

◦ true: the response SOAP document contains the info.export.daily.limit and the
info.export.daily.count aributes.
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◦ false: the limit and count aributes are absent from the response SOAP document.

• progress.interval

Denes the interval, in number of records processed, used to update the progress of the request in the monitor.
For example, seing a value of 100 on a request containing 2000 records, would limit to 20 the number of
progress updates sent to TCC.

• Possible values:

A positive number, the default value is 1.

Projections Tab  
A Projection denes which elds of the entity will be returned.

The use of projections diers greatly depending on the mode of the export specication:

• When T-XML or CSV-entity mode is used, the only possible projections are eld projections. The sequence of
the projections is irrelevant as they only serve to identify which elements of the business model will be selected
for extraction after the entities have been determined using the ltering elements.

• When a at mode such as XML or CSV-report is used, projections may include transformations. In this mode,
the sequence of projections is critical as they each represent a column in the resulting document.
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Projections
An ordered list of all the projections in the export specication is built by dragging and dropping elds from Entity view
Structure section. The Up and Down buons allows sorting of the projections in the required order. The remove buon
deletes selected projections. The Add buon creates new projections:

• eld projection

A eld projection is the most common projection and directly represents an element of the business model.
The alias of a eld projection is optional. When an alias is not present, the path itself will be used. The
eld is dened by a path that navigates the business model starting from the root entity set for the export
specication.

For multilingual eld projections, the extracted locale values can be selected in the Locale. Filtering window that
is opened with the Field open window buon.

• formaed date projection
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A formaed date projection allows modication of the eld date format. The alias of a formaed date
projection is mandatory. The date eld is dened by a path that navigates the business model starting from the
root entity set for the export specication. The date format denes the presentation of the date elements.

• function projection

Available functions are: Add, Add days, Add weeks, Add months, Add years, Average, Cast as date, Cast as
number, Cast as timestamp, Concatenate, Count, Decode, Divide, Greatest, Least, Maximum, Minimum,
Multiply, Power, Replace, Replace null, Replace null or not, Round, Substring, Subtract, Subtract date, Sum, To
char, To end of day, To start of day, To lower-case, To upper-case, Trim, Truncate

The alias of a function projection is mandatory. The plus and minus buons add and delete parameters. The up
and down symbols moves the selected parameter. Available function parameter data types are: String, Boolean,
Integer, Long, Float, Double, Date, Date/Time, and Field. Parameter values must conform to the selected data
type.

• multilingual eld projection

Allows the language code of related entity elds to be exported in CSV-report format. The alias of a multilingual
eld projection is optional. When an alias is not present, the path itself will be used. The value exported can be
the language code (2), or locale code (en).

• complex projection

Insert the SQ-XML code into the complex projection pane.

Filters Tab  
Filters determine which entities are extracted from the Taleo product.
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Filters
The use of lters is the same for all export modes. The sequence of ltering elements is unimportant since they are
combined by a logical AND to select entities. The Up and Down buons allows sorting of the lters if so desired. The
remove buon deletes selected lters. The Add buon creates new lters:

• simple lter

Field ltering selects entities based on the value of the eld. The eld can be compared in a number of ways to
a specic value that should be of the same type as the eld itself.

Available operators are: Between, Equals, Equals (allow null), Does not equal, Greater than, Greater than or
equal, Is null, Is not null, Is true, Is false, Less than, Less than or equal, Contains (case sensitive), Contains (case
insensitive), Matches (case sensitive), Matches (case insensitive), and Last Run Date.

Last Run Date lters the records that were added or modied since the last export.

• complex lter
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Insert the SQ-XML code into the complex lter pane.

• lter from a template

The template pull down menu displays the available templates for the selected entity.

One/No parameter operator lter
The one parameter operator lter requires the argument to be specied. The no parameter operator lter argument is
embedded in the operator.

The available parameter data types are: String, Boolean, Integer, Long, Float, Double, Date, Date/Time, and Field.

Sorting Tab  
Sorting denes the order in which the selected entities will be returned from the Taleo product.
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Sorting
The use of sorting is the same for all export modes. The sequence of the sorting elements is important as the rst
sorting will be applied rst and the subsequent sorting only for matching entities. The Up and Down buons allows
placement of the sorting elements in the required order. The remove buon deletes selected projections. The Add
buon creates new sorting elements:

• eld sorting

Field sorting is the most common sorting and orders entities based on the value of the eld. The only option is
to select the Order of the sort, which can either be Ascending or Descending.

• complex sorting

Insert the SQ-XML code into the complex sorting pane.

• eld based projection sorting
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When exporting in T-XML or CSV-entity, eld based projection sorting allows specifying the sorting order of
sub-entities. The only option is to select the Order of the sort, which can either be Ascending or Descending.

• complex projection sorting

Insert the SQ-XML code into the complex projection sorting pane.

Advanced Tab  
The advanced tab enables users to insert SQ-XML code of advanced elements to the export specication.
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Advanced
The remove buon deletes selected elements. The Add buon creates new elements:

• subquery

• projection ltering

• sorting ltering

• grouping

• joining

Creating a New Export File  
Make sure the Taleo Connect Client application is open.

1. Click File > New > New Export Wizard > Next.
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2. Select an exportable entity from one of the available product models.
a. Select product from pull down menu. The Model is automatically selected based on the product.
b. Select exportable entity from list. A lter is available to narrow down the choices.

3. Select le base.

Create new export is selected by default. This will create an empty export specication.

Templates are available for certain entities. When one of those entities is selected, Create export from a
template becomes available. This will create a populated export specication.

a. Select Create export from a template.
b. Select Template from pull down menu.

4. Click Finish.

The New export specication is displayed in the export editor.
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Saving a New Export File  
Make sure a new export specication le is open in export editor.

1. Click File > Save.
2. Select directory.
3. Enter le name or select existing name in directory.
4. Select le type.
5. Click Save.

Opening an Existing Export File  
Make sure the Taleo Connect Client application is open.

1. Click File > Open > Export.
2. Select directory.
3. Select le in directory.
4. Click Open.

Building an Export Specication  
1. Verify that the information in the General tab is correct.
2. Click the Projections tab.
3. Create projections.

a. Drag and drop the required elds from the entity structure view to the projections list.
b. Click Add to insert other types of projections.

4. Click the Filters tab.
a. Drag and drop the elds to use as simple lters from the entity structure view to the lters list.
b. Set values, data types, and operator.
c. Click Add to create other types of lters.

5. Click Sorting.
a. Drag and drop the elds to sort from the entity structure view to the lters list.
b. Set sorting order.
c. Click Add to create other types of sorters.

6. Click Advanced.
a. Click Add to create advanced queries.

7. Save le.
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Conguration  

Conguration Editor  
The Conguration Editor creates the integration process workow that sends the request le to the Taleo product and
retrieves the response le.

The conguration is what denes:

• The overall behavior of the integration process workow

• The type of monitoring associated to a workow execution

• The alerts triggered by the workow execution

• How to handle and transform the source le eventually sent as a the request message to the Taleo environment

• The connectivity information required to contact the Taleo environment

• How to handle and transform the response message received from the Taleo environment

General Tab  
The general tab presents information that applies to the whole conguration le.
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Workow
The Workow identier should be suciently unique to unambiguously dene each particular execution instance of the
workow.

The Message type determines the format of the request and response messages exchanged with the Taleo
environment. This does not place any restrictions on the original request or ultimate response messages, except for
possibly requiring transformations within the workow.

The Product selected at le creation.

The Communication type denes where the integration instructions are sent within the Taleo environment.

• PRODUCT: The messages are exchanged directly with the Taleo product. This requires a T-SOAP or RS-XML
message type.
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• MIDDLEWARE: The messages are exchanged with the Taleo middleware. There are no requirements on the
message type.

• MIXED: This communication type is deprecated and should not be used. It is present only to support legacy
processes.

The T-SOAP format denes the structure of T-SOAP messages. The current version is 2.1.0, version 2.0.0 is available
only to support legacy processes.

The temporary les folder denes where the les created during workow execution are stored. By default, the
temporary les are deleted upon workow completion.

Enable Schedule Monitoring determines the conservation of conguration execution records. The execution records can
be viewed in the scheduling monitoring report available from the TCC menu bar Report.

Request/Response
File information for the initial request and ultimate answer.

The Format describes the structure of the message.

• T-SOAP: main message format used by the current Taleo Connect platform, it contains information wrapped in
an industry standard SOAP envelope with certain Taleo specic information.

• RS-XML: proprietary Taleo legacy message format similar in nature but not in structure to the T-SOAP format.

• SQ-XML: proprietary Taleo XML format that expresses export specications.

• XML: any le in the industry standard XML format.

• CSV: at le format containing records with character delimited values.

• TEXT: any le in a plain text format.

• OTHER: any other le format.

The Encoding states the way the le is encoded. The Taleo environment only supports UTF-8 encoding. Conversion is
available in the Pre- and post-processing steps.

The File name can be determined in three ways:

• The le can be provided in the client parameters when invoking a workow execution at the command line.
This option is currently not supported when executing a workow within the user interface in the runtime
perspective.

• The le can be a pre-dened value in which case the le is simply the location on disk of the initial request le.

• The le can be generated using an identier in which case the folder denes where on disk to resolve the le
name.

Monitoring Tab  
Taleo Connect Client enables end users to track the progress and inspect the nal status of workow executions by
using the monitoring feature. The feature is based on the workow result information that is updated at each step of
the workow execution. This information can be saved to disk in its original XML format, in a text or HTML formaed
version, or in a custom format using an XSL transformation.
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Monitoring
The Enable Monitoring check box determines if monitoring is active or not. It is highly recommended to always have at
least one type of monitoring active as this is the principal source of information about workow executions.

Monitoring Location
Folder identies the folder where all monitoring les are stored. This value can be modied from its default value;
however, when using the HTML monitoring type, the web subfolder is required for the images and style sheets.

A specic monitoring le is generated for each workow execution and updated after each step. The Reuse the
workow identier as the le name seing will use the workow identier as dened in  General Tab > Workow >
Workow identier  for the monitoring le name. The Use a custom identier seing allows you to specify the
monitoring le name instead of using reusing the workow identier as the le name. In addition, the monitoring le
name can use either a static or a unique identier:

• Use a static identier. A static or constant identier for the monitoring le name gives you easy access to the
result of a given integration process over time. Each workow execution would overwrite the previous one, but
a simple shortcut could be added to an Internet browser to quickly access the current result.
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By default, the monitoring le name is static.

• Use a unique identier. A unique identier creates a dierent monitoring le name for each workow execution.
This ensures that the monitoring information is always available and easily retrievable for a particular
execution.

A unique identier can be used either when the le name reuses the workow identier or when the le name
uses a custom identier.

There are two ways to add a unique identier to a monitoring le name:

a. Append a token (UUID, time stamp) to the le name.
b. Add a system property named "com.taleo.integration.client.uniquemonitoringid=true" to the command

line or set "-Dcom.taleo.integration.client.uniquemonitoringid=true" in the ini le.

Monitoring Type
The Monitoring Type section determines what information is stored and how it is presented.

The XML monitoring le contains all the information produced by the workow execution. It is not easily readable and is
more suited for automated system treatment.

The HTML monitoring le oers a styled view of the main monitoring information that is easy to read and interpret.

The TEXT monitoring le contains the minimal subset of monitoring information and is mostly used in a production
environment where an HTML le cannot be accessed.

The Custom monitoring le allows a personalized view of the monitoring information. The custom le is generated by
applying an XSL transformation to the XML monitoring le. The le extension determines what is appended to the le
location set in the previous location to create the actual le on disk.

Alerting Tab  
The Alerting feature of Taleo Connect Client (TCC) enables the user to receive e-mail notication of workow
completion or failure.

The TCC Monitoring feature is very helpful to get detailed information about the workow execution of an integration
process during its execution. However, when processes are scheduled to run at times where it is not practical for a user
to monitor the execution, an e-mail report can help the user stay informed on the status of the integration processes.
The end user can choose to receive e-mails as text or in a custom format using an XSL transformation.
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General
The mail host SMTP server address is determined by specifying the host alias or the IP address and the server port.

Completed/Error
The Completed and Error sections determine if and how an e-mail alert is sent when the workow is completed or
completes with an error, respectively.

To species a list of comma-separated e-mail addresses of recipients that will receive the alert e-mail.

CC species a list of comma-separated e-mail addresses of recipients that will receive a copy of the alert e-mail.

Subject determines the subject line of the alert e-mail.

The alert e-mail can be provided in two formats:

• Text format is a plain text version of the monitoring information.

• Custom format is built by applying an XSL transformation to the XML monitoring le. The Content-type or the
resulting content can also be specied to facilitate e-mail reception processing.
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Pre-processing Tab  
The Pre-processing steps dene all handling and transformations to the source le, as well as any other task that needs
to be done, prior to sending the request message to the Taleo environment.

Pre-processing steps
The Add buon creates new steps. The remove buon deletes selected step. The Up and Down buons allows sorting of
the steps in the required order.

• Prepare Import

The Prepare Import step converts an initial request message in CSV format to a standard Taleo T-XML import
document. The conversion rules are set in the import specication le.

• Last Run Date Export

The Prepare Last Run Date (LRD) step gets the current date and time, and on successful completion of the
workow updates the LRD le. By default, Use date from the zone is selected. Use date from current computer
is for extracting from Professional 7.0.4 or earlier.

• Prepare Export
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The Prepare Export step adjusts and embeds an initial request message in SQ-XML format to a Taleo standard
T-XML export document. The request details and specic congurations are set in the export specication le.

• XSL based transformation
The Transform with XSL step is used to convert an XML le to a valid data le compliant with the dened
import specication. It determines XSL le path and name, output format, and encoding.
The pre-processing step processes the whole document at once. XSL technology is not designed to support
large transformations, the whole le must be loaded in memory prior to conversion. Make sure you have
enough available memory to use the XSL transformation preprocessing step with large import les.

• Wrap Soap
The Wrap SOAP step wraps a T-XML document within a T-SOAP envelope to create a message that can be sent
to the Taleo environment. This is a mandatory step when using the Prepare Import or Prepare Export steps.

• Generate ID

• The Generate ID step determines how to construct the unique message identier for the T-SOAP message
sent to the Taleo environment. If the workow identier is unique, then it can be reused; if not, a new identier
can be specied. It is required to use a unicity token within the identier to ensure uniqueness of the resulting
message identier.

• Validate Encoding
The Validate Encoding step ensures the le is correctly encoded.

• Convert Encoding
The Convert encoding step changes the encoding of the request message.
Expected encoding: Current type
Target encoding: Desired type
A Byte order mark (BOM) byte can be generated if required.

Custom Steps
• Default Custom step

Allows implementors to basically execute any logic they want. Java class is the fully qualied name of a class
that extends com.taleo.integration.client.step.BaseCustomStep. The custom step can access any number of
parameters provided in the conguration le in the form of name/value pairs.

• CSV Mapping
The CSV Mapping step processes the input CSV le columns and maps the values to a new value based on an
external mapping le.
Standard Parameters
Value delimiter: CSV input le column delimiter character.
Quotation character: CSV input le quotation character.
Mapping columns: List of column numbers that represent the rst column of each block of columns that are
used as a key in the mapping process. Each block number must be separated by a semi-colon (;). The rst
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column in the CSV le is always 1. For example, the key length is 2, the rst block of 2 columns starts at column
number 4, and the next block starts at column 12, the value in this eld must be "4;12" (without the double
quotes).
Mapping le: Mapping process denition le. It must contain 1 more column than the number of columns
used for the key. The last column in this le contains the value that will be used as a replacement value for the
specied column(s). The le must be encoded in UTF-8, must have a CSV header, must use a comma (,) for
value delimiter and a double quote (") for the quotation character.
Case sensitive keys: Indicates if the mapping process must be case sensitive for the key(s) comparison.
Advanced parameters
DefaultValue: Default value to use when a key is not found in the mapping le. Provides value to prevent
mapping process generating an error by default.
DuplicateKeys: Duplicate keys in the mapping le generate an error by default. Seing the value to "ignore" will
use the last dened duplicate key value as replacement in the original CSV le. Possible Values: error, ignore.

• Net Change Computation
Compares the customer CSV request le with the Net Change database to determine the changes (create,
update, delete, etc...) required to synchronize the target application.

• Net Change Setup
Creates the Net Change reference database for the selected service (entity). First, it clears the existing entity Net
Change tables. Then it extracts data from the target application, based on the Import File specication, to ll
the entity Net Change reference table.

• FTP Get
Retrieves a le from an FTP server.
Standard Parameters
Host: Name or IP address of the FTP server.
Port: Port number on which the FTP server listens for requests (for example, 4566), The default is 21.
User: The valid user that will be used for the logon on the remote FTP server.
Password: The valid password for the FTP user specied in username that will be used for the logon on the
server.
Transfer type: Ftp supports both ASCII and binary image le transfer types. The default is binary. You should
use ASCII when transferring text les. In ASCII mode, character conversions to and from the network standard
character set are performed. For example, end-of-line characters are converted as necessary, based on the
target operating system.
Remote path: Working directory of the FTP server (for example, /tmp/pub). If the directory does not exist, the
server throws an exception.
File name: Name of the remote le.
Move le: The request le will be moved into a specic folder determined by Move Folder parameter.
Move folder: The move request le destination folder name. If not specied the request le will not be moved.
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Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.

Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.

Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

Advanced parameters

Account: Optional. The user name for an account on the FTP server (for example, FADA). Specify account if
your FTP host requires account information. The account is dened in the FTP protocol to further identify the
user that is identied by the username and password input variables.

Transfer mode: Ftp supports both of the following le transfer modes: passive or active. The default is passive.

Data port: Optional. Listener port number of the data transfer channel. If you do not specify dataport, the FTP
Client will throw an exception. This value is used only when the transfer type value is active. In active mode,
the FTP client opens a dynamic port, sends the FTP server the dynamic port number on which it is listening
over the control stream and waits for a connection from the FTP server. When the FTP server initiates the data
connection to the FTP client it binds the source port to port 20 on the FTP server.

Client host: Optional. The client host that listen on a port determined by above DataPort. The host name can
either be a machine name, such as "www.taleo.com", or a textual representation of its IP address. If a literal IP
address is supplied, only the validity of the address format is checked.

Timeout: Optional. Sets the timeout in milliseconds to use when reading from the data connection. This
timeout will be set immediately after opening the data connection.

Create remote path if missing: Create the working directory on the FTP server (for example, /tmp/pub/a/b).

• FTP Put

Sends a le to an FTP server.

Standard Parameters

Host: Name or IP address of the FTP server.

Port: Port number on which the FTP server listens for requests (for example, 4566), The default is 21.

User: The valid user that will be used for the logon on the remote FTP server.

Password: The valid password for the FTP user specied in username that will be used for the logon on the
server.

Transfer type: Ftp supports both ASCII and binary image le transfer types. The default is binary. You should
use ASCII when transferring text les. In ASCII mode, character conversions to and from the network standard
character set are performed. For example, end-of-line characters are converted as necessary, based on the
target operating system.

Remote path: Working directory of the FTP server (for example, /tmp/pub). If the directory does not exist, the
server throws an exception.
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File name: Name of the remote le.

Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.

Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.

Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

Advanced parameters

Account: Optional. The user name for an account on the FTP server (for example, FADA). Specify account if
your FTP host requires account information. The account is dened in the FTP protocol to further identify the
user that is identied by the username and password input variables.

Transfer mode: Ftp supports both of the following le transfer modes: passive or active. The default is passive.

Data port: Optional. Listener port number of the data transfer channel. If you do not specify dataport, the FTP
Client will throw an exception. This value is used only when the transfer type value is active. In active mode,
the FTP client opens a dynamic port, sends the FTP server the dynamic port number on which it is listening
over the control stream and waits for a connection from the FTP server. When the FTP server initiates the data
connection to the FTP client it binds the source port to port 20 on the FTP server.

Client host: Optional. The client host that listen on a port determined by above DataPort. The host name can
either be a machine name, such as "www.taleo.com", or a textual representation of its IP address. If a literal IP
address is supplied, only the validity of the address format is checked.

Timeout: Optional. Sets the timeout in milliseconds to use when reading from the data connection. This
timeout will be set immediately after opening the data connection.

Create remote path if missing: Create the working directory on the FTP server (for example, /tmp/pub/a/b).

• FTP Delete

Removes a le from An FTP server.

Standard Parameters

Host: Name or IP address of the FTP server.

Port: Port number on which the FTP server listens for requests (for example, 4566), The default is 21.

User: The valid user that will be used for the logon on the remote FTP server.

Password: The valid password for the FTP user specied in username that will be used for the logon on the
server.

Remote path: Working directory of the FTP server (for example, /tmp/pub). If the directory does not exist, the
server throws an exception.

File name: Name of the remote le.

Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.
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Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.

Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

Advanced parameters

Account: Optional. The user name for an account on the FTP server (for example, FADA). Specify account if
your FTP host requires account information. The account is dened in the FTP protocol to further identify the
user that is identied by the username and password input variables.

Transfer mode: Ftp supports both of the following le transfer modes: passive or active. The default is passive.

Data port: Optional. Listener port number of the data transfer channel. If you do not specify dataport, the FTP
Client will throw an exception. This value is used only when the transfer type value is active. In active mode,
the FTP client opens a dynamic port, sends the FTP server the dynamic port number on which it is listening
over the control stream and waits for a connection from the FTP server. When the FTP server initiates the data
connection to the FTP client it binds the source port to port 20 on the FTP server.

Client host: Optional. The client host that listen on a port determined by above DataPort. The host name can
either be a machine name, such as "www.taleo.com", or a textual representation of its IP address. If a literal IP
address is supplied, only the validity of the address format is checked.

Timeout: Optional. Sets the timeout in milliseconds to use when reading from the data connection. This
timeout will be set immediately after opening the data connection.

• HTTP

Posts data to an HTTP/HTTPS URL.

Standard Parameters

Endpoint:) Represents the endpoint to use for the post operation. This endpoint must use the HTTP or HTTPS
protocol.

Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.

Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.

Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

Advanced parameters

Custom HTTP headers are supported through the use of advanced parameters. A parameter having the prex
Header: followed by the name of the header as the name of the parameter can be dened. For example, to
dene the Content-type the parameter name will be Header:Content-type.

• SMTP

Sends import/export result le by email.
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Standard Parameters

Host:The address of the host SMTP server.

Port: The port of the host SMTP server. 25 by default.

From: The address of the sender. Taleo Connect Client by default.

To: The address(es) of the receiver(s).

Cc: The address(es) of the receiver(s).

Subject: The subject of the email.

MessageTemplate: The template string that contains the email message body. The template supports the
following velocity standard tools: DateTool and MathTool. See the Apache velocity website for details. It also
supports the following Taleo custom velocity tools: StringTool and FileTool. The StringTool variables are:
$string.rightPad("123", 10), $string.rightPad("123", 10, "_"), $string.leftPad("123", 10) and $string.leftPad("123", 10,
"0"). The FileTool variables are: $le.content(), $le.lineCount() and $le.size().

Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.

Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.

Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

SendAachment: Send the step input le as aachment. True by default.

Aachment Maximum File Size: The maximum le size is now defaulted to 100MB (104857600 bytes). This
can be modied by seing a dierent value, in bytes, for the aachment.max.le.size advanced parameter. For
example, aachment.max.le.size=104857600

ZipAachment: Compress the aached le.

Aachment le name: Enter name for aached le. The le name MUST NOT have leading or trailing spaces.
The le name MUST NOT contain the \ / : * ? < > | characters. If left empty, the default le name will be used.

Send Notication: Sends notication email on selected condition. Condition is determined by processing status
provided by previous step. Select "Always" to disregard previous step processing status and send notication
on all step executions. Select "On warning or error" to send a notication only if the previous step processing
status is "warning" or "error". Select "On error" to send a notication only if the previous step processing status
is "error". The possible values are: Always, On warning or error, On error.

This applies only to Net Change steps, in all other cases the notication email is sent no maer what choice is
selected.

Send Tab  
The Send processing step denes the connectivity information required to contact the Taleo environment.
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Endpoint Source
Endpoint information can originate from the default conguration board le, the conguration le board tab, or from
the current step.

Endpoint
The Endpoint section provides the actual connectivity information for the Taleo environment:

• Protocol: HTTP or HTTPS

• Host: Alias or IP address

• Port: Number

The communication path can be provided by the full Path directly or by a combination of the service dispatcher Path
and Service Name. The complete web service path can also be provided.

Authentication
The Authentication section provides the authentication context for the requests.

• No authentication: No authentication is listed as an option for testing purposes.

• Basic Authentication: This is the minimal requirement to connect to the Taleo environment.
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• Cert Based Authentication: This is used to sign the requests and responses between TCC and Taleo. This is in
addition to basic authentication.

For both types of authentication, the user must provide the following information:

• User: The user name for integration must be created with an integrator role.

• Password: The integration user password.

Quality
The Quality section determines how communication failures are handled within the workow execution.

Retry determines what action is taken when a particular processing operation fails. This option is optional for the send
step.

• Interval determines the number of seconds between each try.

• Acknowledgement Aempts is a deprecated option only kept for backwards compatibility reasons and should
not be used.

• Completion aempts is the number of times the request le will be sent to the zone before halting the workow
and generating an error message.

• Ignore errors determines if retries are aempted even if an error has occurred. This option is mandatory when
using retries in the send step as the only two possible outcomes are success or error.

Socket time-out determines how much time a particular processing operation will wait for a response. This is a highly
technical seing and only needs to be modied in particular cases where connectivity issues occur with the Taleo
environment.

Middleware
The Middleware section provides extra information required when communicating with the Taleo middleware. These
seings are only enabled if the communication type is set to MIDDLEWARE.

Sender ID, Receiver ID and Event ID specify information required for the routing of the request message within the
middleware.

Miscellaneous
The Miscellaneous section sets some very technical send step information.

Chunked limit aects how large request messages are sent using the HTTP protocol.

Validate request is a legacy option only oered in RS-XML workows where the request message was pre-validated.

Preview
Preview the send conguration connectivity information dened in the endpoint section.

Poll Tab  
The Poll processing step denes the connectivity information required to contact the Taleo environment.
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Endpoint Source
Endpoint information can originate from the default conguration board le, the conguration le board tab, or from
the current step.

Endpoint
The Endpoint section provides the actual connectivity information for the Taleo environment:

• Protocol: HTTP or HTTPS

• Host: Alias or IP address

• Port: Number

The communication path can be provided by the full Path directly or by a combination of the service dispatcher Path
and Service Name. The complete web service path can also be provided.
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Authentication
The Authentication section provides the authentication context for the requests.

• No authentication: No authentication is listed as an option for testing purposes.

• Basic Authentication: This is the minimal requirement to connect to the Taleo environment.

• Cert Based Authentication: This is used to sign the requests and responses between TCC and Taleo. This is in
addition to basic authentication.

For both types of authentication, the user must provide the following information:

• User: The user name for integration must be created with an integrator role.

• Password: The integration user password.

Quality
The Quality section determines how communication failures are handled within the workow execution.

Retry determines what action is taken when a particular processing operation fails. This option is mandatory for the poll
step. An integration process will very rarely complete on the rst polling aempt.

• Interval determines the number of seconds between each try.

• Acknowledgement Aempts is a deprecated option only kept for backwards compatibility reasons and should
not be used.

• Completion aempts is the number of times the zone will be polled for the result le before halting the
workow and generating an error message. The completion aempt counter automatically resets when the
zone processed record count changes.

• Ignore errors determines if retries are aempted even if an error has occurred. This seing only applies to
polling errors and not document errors.

The workow will stop when the following document states are encountered: Interrupted, Suspended, or Error.

Socket time-out determines how much time a particular processing operation will wait for a response. This is a highly
technical seing and only needs to be modied in particular cases where connectivity issues occur with the Taleo
environment.

Preview
Preview the poll conguration connectivity information dened in the endpoint section.

Retrieve Tab  
The Retrieve processing step denes the connectivity information required to contact the Taleo environment.
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Endpoint Source
Endpoint information can originate from the default conguration board le, the conguration le board tab, or from
the current step.

Endpoint
The Endpoint section provides the actual connectivity information for the Taleo environment:

• Protocol: HTTP or HTTPS

• Host: Alias or IP address

• Port: Number

The communication path can be provided by the full Path directly or by a combination of the service dispatcher Path
and Service Name. The complete web service path can also be provided.

Authentication
The Authentication section provides the authentication context for the requests.

• No authentication: No authentication is listed as an option for testing purposes.

• Basic Authentication: This is the minimal requirement to connect to the Taleo environment.
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• Cert Based Authentication: This is used to sign the requests and responses between TCC and Taleo. This is in
addition to basic authentication.

For both types of authentication, the user must provide the following information:

• User: The user name for integration must be created with an integrator role.

• Password: The integration user password.

Quality
The Quality section determines how communication failures are handled within the workow execution.

Retry determines what action is taken when a particular processing operation fails. This option is optional for retrieve
step.

• Interval determines the number of seconds between each try.

• Acknowledgement Aempts is a deprecated option only kept for backwards compatibility reasons and should
not be used.

• Completion aempts is the number of times to try and retrieve the result le from the zone before halting the
workow and generating an error message.

• Ignore errors determines if retries are aempted even if an error has occurred. This option is mandatory when
using retries in the retrieve step as the only two possible outcomes are success or error.

Socket time-out determines how much time a particular processing operation will wait for a response. This is a highly
technical seing and only needs to be modied in particular cases where connectivity issues occur with the Taleo
environment.

Middleware
The Middleware section of the retrieve step provides extra information required when communicating with the Taleo
middleware. These seings are only enabled if the communication type is set to MIDDLEWARE.

Sender ID, Receiver ID and Event ID specify information required for the routing of the request message within the
middleware.

Miscellaneous
The Miscellaneous section sets some very technical send step information.

Chunked limit aects how large request messages are sent using the HTTP protocol.

Validate request is a legacy option only oered in RS-XML workows where the request message was pre-validated.

Preview
Preview the retrieve conguration connectivity information dened in the endpoint section.

Post-processing Tab  
The Post-processing steps dene how to handle and transform the source le eventually sent as the response message
from the Taleo environment.
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Post-processing steps
The Up and Down buons allows sorting of the steps in the required order. The remove buon deletes selected step.
The Add buon creates new steps:

• Strip SOAP

Determines how the SOAP envelope will be removed from the response message:

Document: leaves an XML message with the content and the aributes of the document.

Content: leaves an XML message with the business content of the document.

CSV: leaves a CSV message with the business content of the document, applies to CSV mode export responses
only.

The Fail on export error stops processing if the response message contains an error.

• XSL based transformation

Applies an XSL transformation to a response message. This step works at the record level. The template le
must contain a placeholder ([RECORD_OUTPUT]) that will contain the transformed data.

XSL le: Species the path and le name to use.

Template le: Species the path and le name to use.
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Export mode: File format before transformation T-XML or XML

Output format: File format after transformation, OTHER, TEXT, CSV, XML, SQ-XML, T-XML, T-SOAP, RS-XML

• Import Result Transformation

Converts the import results to a CSV le using the following specications.

File: Species the path and le name to use.

Output properties: When selected, inserts operation properties at begining of result le.

Advanced Parameters are available to add data columns to the CSV result le.

EXTRA_COLUMN_NAME_x: The parameter value sets the column header name.

EXTRA_COLUMN_XPATH_x: The parameter value sets the Xpath for the data inserted into the column. The
Xpath for a particular set of data can be found in the T-XML response le returned by the operation. Since the
response document contains a namespace, the "local name" must be specied. For example, if the Xpath in the
T-XML le is //Candidate/Number, the parameter value is expressed as //*[local-name()="Candidate"]/*[local-
name()="Number"].

Note: Make sure to replace the x at the end of the pairs of parameter names with the same number to
ensure they remain matched. For example, EXTRA_COLUMN_NAME_1 and EXTRA_COLUMN_XPATH_1,
EXTRA_COLUMN_NAME_2 and EXTRA_COLUMN_XPATH_2, etc...

• Export Result Transformation

Converts the exports results to a CSV le using the export specications

• Convert Encoding

Changes the encoding of the response message if necessary.

Expected encoding: Current type

Target encoding: Desired type

A Byte order mark (BOM) byte can be generated if required.

Custom Steps
• Default Custom step

Allows implementors to basically execute any logic they want. Java class is the fully qualied name of a class
that extends com.taleo.integration.client.step.BaseCustomStep. The custom step can access any number of
parameters provided in the conguration le in the form of name/value pairs.

• CSV Mapping

The CSV Mapping step processes the input CSV le columns and maps the values to a new value based on an
external mapping le.

Standard Parameters

Value delimiter: CSV input le column delimiter character.

73



Talent Acquisition Cloud
Using Connect Client

Chapter 3
Description

Quotation character: CSV input le quotation character.

Mapping columns: List of column numbers that represent the rst column of each block of columns that are
used as a key in the mapping process. Each block number must be separated by a semi-colon (;). The rst
column in the CSV le is always 1. For example, the key length is 2, the rst block of 2 columns starts at column
number 4, and the next block starts at column 12, the value in this eld must be "4;12" (without the double
quotes).

Mapping le: Mapping process denition le. It must contain 1 more column than the number of columns
used for the key. The last column in this le contains the value that will be used as a replacement value for the
specied column(s). The le must be encoded in UTF-8, must have a CSV header, must use a comma (,) for
value delimiter and a double quote (") for the quotation character.

Case sensitive keys: Indicates if the mapping process must be case sensitive for the key(s) comparison.

Advanced parameters

DefaultValue: Default value to use when a key is not found in the mapping le. Provides value to prevent
mapping process generating an error by default.

DuplicateKeys: Duplicate keys in the mapping le generate an error by default. Seing the value to "ignore" will
use the last dened duplicate key value as replacement in the original CSV le. Possible Values: error, ignore.

• Net Change Result Processor

Generates a simple XML report that indicates how many entities have been processed during the operation.

• Net Change Result Transformation

Processes the le generated by the "Net Change Result Processor" to transform it into a standard TCC CSV le.
This step is optional for Initial Load processing.

• FTP Put

Sends a le to an FTP server.

Standard Parameters

Host: Name or IP address of the FTP server.

Port: Port number on which the FTP server listens for requests (for example, 4566), The default is 21.

User: The valid user that will be used for the logon on the remote FTP server.

Password: The valid password for the FTP user specied in username that will be used for the logon on the
server.

Transfer type: Ftp supports both ASCII and binary image le transfer types. The default is binary. You should
use ASCII when transferring text les. In ASCII mode, character conversions to and from the network standard
character set are performed. For example, end-of-line characters are converted as necessary, based on the
target operating system.

Remote path: Working directory of the FTP server (for example, /tmp/pub). If the directory does not exist, the
server throws an exception.

File name: Name of the remote le.
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Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.

Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.

Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

Advanced parameters

Account: Optional. The user name for an account on the FTP server (for example, FADA). Specify account if
your FTP host requires account information. The account is dened in the FTP protocol to further identify the
user that is identied by the username and password input variables.

Transfer mode: Ftp supports both of the following le transfer modes: passive or active. The default is passive.

Data port: Optional. Listener port number of the data transfer channel. If you do not specify dataport, the FTP
Client will throw an exception. This value is used only when the transfer type value is active. In active mode,
the FTP client opens a dynamic port, sends the FTP server the dynamic port number on which it is listening
over the control stream and waits for a connection from the FTP server. When the FTP server initiates the data
connection to the FTP client it binds the source port to port 20 on the FTP server.

Client host: Optional. The client host that listen on a port determined by above DataPort. The host name can
either be a machine name, such as "www.taleo.com", or a textual representation of its IP address. If a literal IP
address is supplied, only the validity of the address format is checked.

Timeout: Optional. Sets the timeout in milliseconds to use when reading from the data connection. This
timeout will be set immediately after opening the data connection.

Create remote path if missing: Create the working directory on the FTP server (for example, /tmp/pub/a/b).

• FTP Delete

Removes a le from An FTP server.

Standard Parameters

Host: Name or IP address of the FTP server.

Port: Port number on which the FTP server listens for requests (for example, 4566), The default is 21.

User: The valid user that will be used for the logon on the remote FTP server.

Password: The valid password for the FTP user specied in username that will be used for the logon on the
server.

Remote path: Working directory of the FTP server (for example, /tmp/pub). If the directory does not exist, the
server throws an exception.

File name: Name of the remote le.

Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.

Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.
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Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

Advanced parameters

Account: Optional. The user name for an account on the FTP server (for example, FADA). Specify account if
your FTP host requires account information. The account is dened in the FTP protocol to further identify the
user that is identied by the username and password input variables.

Transfer mode: Ftp supports both of the following le transfer modes: passive or active. The default is passive.

Data port: Optional. Listener port number of the data transfer channel. If you do not specify dataport, the FTP
Client will throw an exception. This value is used only when the transfer type value is active. In active mode,
the FTP client opens a dynamic port, sends the FTP server the dynamic port number on which it is listening
over the control stream and waits for a connection from the FTP server. When the FTP server initiates the data
connection to the FTP client it binds the source port to port 20 on the FTP server.

Client host: Optional. The client host that listen on a port determined by above DataPort. The host name can
either be a machine name, such as "www.taleo.com", or a textual representation of its IP address. If a literal IP
address is supplied, only the validity of the address format is checked.

Timeout: Optional. Sets the timeout in milliseconds to use when reading from the data connection. This
timeout will be set immediately after opening the data connection.

• HTTP

Posts data to an HTTP/HTTPS URL.

Standard Parameters

Endpoint:) Represents the endpoint to use for the post operation. This endpoint must use the HTTP or HTTPS
protocol.

Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.

Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.

Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

Advanced parameters

Custom HTTP headers are supported through the use of advanced parameters. A parameter having the prex
Header: followed by the name of the header as the name of the parameter can be dened. For example, to
dene the Content-type the parameter name will be Header:Content-type.

• SMTP

Sends import/export result le by email.

Standard Parameters
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Host:The address of the host SMTP server.

Port: The port of the host SMTP server. 25 by default.

From: The address of the sender. Taleo Connect Client by default.

To: The address(es) of the receiver(s).

Cc: The address(es) of the receiver(s).

Subject: The subject of the email.

MessageTemplate: The template string that contains the email message body. The template supports the
following velocity standard tools: DateTool and MathTool. See the Apache velocity website for details. It also
supports the following Taleo custom velocity tools: StringTool and FileTool. The StringTool variables are:
$string.rightPad("123", 10), $string.rightPad("123", 10, "_"), $string.leftPad("123", 10) and $string.leftPad("123", 10,
"0"). The FileTool variables are: $le.content(), $le.lineCount() and $le.size().

Number of retries: Represents the number of retries that will be done if the operation fails. Zero by default.

Time between retries: Represents the number of seconds to wait between the retry aempts. Zero by default.

Retry factor: This factor is used as a multiplier on the "Time between retries" between each aempt. It
multiplies the last time waited by this amount. i.e. If "Time between retries" is 10 seconds and the retry factor is
2, the rst wait time will be 10sec, the second will be 20sec, the third will be 40sec and so on, until the maximum
number of retries has been reached.

SendAachment: Send the step input le as aachment. True by default.

Aachment Maximum File Size: The maximum le size is now defaulted to 100MB (104857600 bytes). This
can be modied by seing a dierent value, in bytes, for the aachment.max.le.size advanced parameter. For
example, aachment.max.le.size=104857600

ZipAachment: Compress the aached le.

Aachment le name: Enter name for aached le. The le name MUST NOT have leading or trailing spaces.
The le name MUST NOT contain the \ / : * ? < > | characters. If left empty, the default le name will be used.

Send Notication: Sends notication email on selected condition. Condition is determined by processing status
provided by previous step. Select "Always" to disregard previous step processing status and send notication
on all step executions. Select "On warning or error" to send a notication only if the previous step processing
status is "warning" or "error". Select "On error" to send a notication only if the previous step processing status
is "error". The possible values are: Always, On warning or error, On error.

This applies only to Net Change steps, in all other cases the notication email is sent no maer what choice is
selected.

• Report Filtering

Filters record results by criteria.

reportFiltering: Select from drop down list. All (no lter), On error or warning, On error only.
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Board Tab  
The Board Tab allows the user to to create endpoint and symbol elements specic to the current conguration le.

With specic endpoints and symbols the user can override the seings of the default conguration board.

For additional information on endpoints and symbol elements refer to the Default Conguration Board section.

Creating a New Conguration File  
Make sure the Taleo Connect Client application is open.

1. Click File > New > New Conguration Wizard > Next.
2. Select the conguration le base.
3. Click the Navigate icon.
4. Select directory.
5. Select le.
6. Click Open.
7. Click Next.
8. Verify connectivity information.
9. Click Finish.

The New conguration specication is displayed in the conguration editor.
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Saving a New Conguration File  
Make sure a new conguration specication le is open in conguration editor.

1. Click File > Save.
2. Select directory.
3. Enter le name or select existing name in directory.
4. Select le type.
5. Click Save.

Opening an Existing Conguration File  
Make sure the Taleo Connect Client application is open.

1. Click File > Open > Conguration.
2. Select directory.
3. Select le in directory.
4. Click Open.

Executing a Conguration  
Make sure a conguration le is open and active.

1. Click Execute the conguration icon.

Runtime  

Runtime Perspective  
The Runtime perspective displays the workow execution details in graphical and tabular formats.

Workow Identier
The workow identier for the current execution displays above the Workow Execution Details icons.

Workow Execution Details
A graphical overview of the step progress groups all processing steps in a single aggregated icon.
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Basic Information
The basic monitoring information can be seen in the left hand column and consists of the overall state of the workow
execution and the individual step statuses.

• If the workow execution is completed, then all steps will also be completed.

• If the workow execution is in progress, then a subset of all steps will be completed.

• If the workow execution is in error, then a particular step may also be in error. However, certain error scenarios
occur at the initialization or nalization of the workow execution, hence either no steps or all steps will have
been completed.

General Information
General information is provided and consists of:

1. Workow type, start, nish, and duration of the execution (when applicable).
2. The original location of the request message le and the target location of the response message le.

The presence of the response message target location DOES NOT imply that the le was actually created. This is only
the case if the workow execution completed will success.

Step Details
The step details tabular view shows the start, nish, duration (when applicable), and the request and response message
information when applicable.

Monitoring a Workow  
A workow conguration le is available for execution.

1. Click Window > Open Perspective > Runtime. The Runtime Perspective opens.
2. Click File > Open Conguration.
3. Select directory.
4. Select le.
5. Click Open. The conguration le opens.
6.
7. Click the Execute the conguration icon.
8. Maximise the Runtime Perspective.

The workow execution details are displayed.

Console  

Console Perspective  
The Console perspective displays a real-time view of all integration processes handled by a Taleo product.
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The console perspective uses a single editor, the message list viewer, that lists all the messages in a Taleo product
matching a particular criteria. This perspective distinguishes between the message and the document contained in the
message.This perspective oers multiple views that analyze each message from dierent angles.

Message List Viewer
The Message List Viewer is an editor that primarily shows a list of messages from the target Taleo Connect Server.
Technically, it is an editor, since the prole of the target Taleo Connect Server can be edited and saved here.

The information available in the message list is:

• Identier: A universally unique external identier for the message.

• Type: Determines if the message is a request or a response.

• State: The current position of the message in the Taleo Connect Server processing workow.

• Creation Date: Indicates the date and time the message was received or created by the Taleo Connect Server.

The three actions available in the Message List viewer are:

• Refresh the current list of messages.

• Filter the list of messages according to a set of criteria.

• Edit the prole of the target Taleo Connect Server.

Filters
The Filters dene which messages will be part of the displayed list. The available lters are:

• Key: Filters the messages based on whether the key matches the exact value provided. Since the message
key is a unique value within a Taleo Connect Server instance, specifying a value here guarantees that a single
message will be displayed.

• Identier: Filters the messages based on the whether the identier contains the value provided. For example,
using the value 'Candidate' would match 'CandiateImport-2006-03-12' and 'Extract-Candidates-2005-12-12'.

• Conversation: Filters the messages based on whether the conversation contains the value provided. This is the
same behavior as the Identier lter.

• Target: Filters the messages based on whether they are requests or responses. The Request option is an alias
for the Application target. The Response option includes the Middleware, External, and Queue targets.

• State: Filters the messages based on their state in the Taleo Connect Server workow. The Incomplete option
matches all states except In Progress.

• Date: Filters the messages based on their creation date in the Taleo Connect Server. Selecting a specic date
shows all messages from 00:00:00 to 23:59:59, local time of the computer running the Taleo Connect Console.
Selecting a range of dates shows all message from 00:00:00 of the 'from' date to 23:59:59 of the 'to' date, local
time of the computer running the Taleo Connect Console.

Prole
A Prole denes the connectivity information required to access the Taleo Connect Server embedded in a target Taleo
product. The general information of a prole is:

• Description: Information with no functional signicance. May be used by customers to distinguish or identify
proles.
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• Version: The version of the target Taleo Connect Server. This value determines the communication protocol and
the available features.

The connectivity information of a prole is:

• Protocol: The type of HTTP communication used: plain HTTP or secure HTTPS.

• Host: The host alias or the IP address of the target Taleo product.

• Port: The port number of the target Taleo product.

• Dispatcher: The location of the target Taleo product web service dispatcher entry point. For the Taleo
Professional product this is /servlets/ServiceDispatcher?ServiceName=. For other Taleo products, the value is /
product name/ServiceDispatcher?ServiceName=.

• Username: The username required to authenticate web service requests to the Taleo Connect Server.

• Password: The password required to authenticate web service requests to the Taleo Connect Server.

Message Details
The Message Details View shows the top level information of the integration message

• Key: An internal identier used by the Taleo Connect Server embedded in a target Taleo product. The message
key's only external use is to uniquely associate request and response message instances. The key values are
only unique within a particular Taleo product.

• Identier: A universally unique external identier for the message. It is used by external systems to link
messages within larger business processes.

• Conversation: An identier that loosely links several messages together in a business process. This is not a
transaction identier in the usual sense of the word (including two-phase commit and integrity concerns). A
conversation is only used for monitoring purposes. In particular, a response generated by a Taleo Connect
Server will always have the same conversation identier as the request message (if none was provided, then the
conversation identier of the response will be the message identier of the request).

• Target: Determines the processing target in the Taleo Connect Server.

Application indicates that this message contains a request and is to be processed by the Taleo product.

Middleware or External indicates that this message contains a response and is to be pushed to another
application.

Queue also indicates that the message contains a response, but that the message should remain within the
Taleo product and will be polled by an external party.

• State: Either a Request or a Response. An integration message is a generic transmission from a source to a
target application. The concept of request and response is only linked to the business document contained
within the message.

• Service: The unique identier of the processing strategy of the Taleo Connect Server. This value only apply to
messages with an Application target, i.e. request messages.

The full raw message content is available using the show full message action.
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Message Actions
Under certain specic circumstances, it is possible to interact with messages from the console.

• Suspend halts the processing of a message. This action is only applicable to request messages that are in the
In Progress state. A signal will be sent to the Taleo product and the message will be marked as Suspending; the
actual suspension is dependent on the type of processing and may not be immediate.

• Resume resumes the processing of a message. This action is only applicable to messages that are in the
Suspended or Interrupted states. The result of this action is to mark the message as Ready so the Taleo
Connect Server will process it through the normal message queue. In the case of a request message, the
processing will start after the last complete record. In the particular case of an export request, as there is only
one record, the entire export is restarted. For response messages, the resume action resends the response to
the middleware system when required.

Message Errors
When a technical process error occurs, the details of the problem are available in the second section of the view. It is
important to note that only internal processing errors are visible in this view and specically only when messages are
either in the Interrupted or In Error states. Any business errors that occur during the processing of a particular record
are stored in the response document and do not aect the overall processing of the message.

• Source: Either the Server or the Client. An integration message is a generic transmission from a source to a
target application. The concept of request and response is only linked to the business document contained
within the message.

• Code: An external unique identier for the type of problem that occurred.

• Reason: A contextualized message giving more information about the problem that occurred.

• Detail: Further technical information about the problem. Specically, if the problem was caused by an
unmanaged Java language exception, this detail would be the stack trace of the exception.

Document Detail
The Document Detail View shows the top level information of the integration document.

• Action: Denes how the target application is to process the records. The three possible values are Export,
Import, or Business Service. In the two rst actions, the records are handled by the generic integration services
provided by the Taleo Connect Client. The last action signies that the records are delegated to product specic
business services for individual processing.

• Progress: Shows how many records have currently been processed. In most cases, this value is identical for both
the request and response message. For exports, the request document has a single record and the progress
is only signicant for the response document where the total indicates the number of entities that will be
exported.

Each record processed during the integration is assigned a status: success or error. The total section rst shows the
overall number of records in the document then the amount of successful records and the amount of records in error.

Document Content
The document content view can display the content of the document or save it to le.
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Creating a Console Prole  
1. Click File > New > New Prole Wizard > Next.
2. Select the prole type.

◦ Endpoint: Create the prole based on an endpoint. Select product from pull down menu. Select Endpoint
from pull down menu

◦ Blank prole: Create a blank prole and ll the connectivity information manually.

◦ Demo prole: Use an o-line demo prole to explore the console features.

3. Click Next
4. Verify or complete connectivity information.
5. Click Finish.

The New console prole is displayed in the console perspective Message list viewer.

Saving a Console Prole  
Make sure a new console prole is open in the message viewer.

1. Click File > Save.
2. Select directory.
3. Enter le name or select existing name in directory.
4. Select le type.
5. Click Save.

Command Line  

Script Execution  
Taleo Connect Client workow execution in a production environment is run by a command line script. The command
line script can be scheduled to run automaticaly.

There are three possible command line scripts to launch TCC execution. They are the same for all operating systems.
The only dierence being that Windows uses .bat les and Linux uses .sh les. The following les can be specied in a
command line script:

• The TCC batch le that is included in the installation package.

TaleoConnectClient.bat

• An import or export conguration le.

<touchpoint>_<action>cfg.xml

• An import or export request le.

<touchpoint>_<action>_ld.xml
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<touchpoint>_<action>_sq.xml

• An import or export result le.

<touchpoint>_<action>_result_<date_time>.csv

<touchpoint>_<action>_result.xml

<touchpoint>_<action>_<date_time>.txt

lename.other

The three possible command line scripts will have the following layout. The path is the absolute or relative location of
the specied le.

• “path\TaleoConnectClient.bat” “path\conguration le” “path\request le” “path\result le”

The rst script is the typical use for Taleo Connect Client where both the request and response message les
are specied explicitly. The workow conguration usually contains only communication information that
applies to a variety of dierent messages.

• “path\TaleoConnectClient.bat” “path\conguration le” “path\request le”

The second script is typical of a scheduled integration process where the request message varies and the
response message le is generated based on the timestamp.

• “path\TaleoConnectClient.bat” “path\conguration le”

The third script is typical of a specialized workow with extensive pre and/or post-processing that only applies
to a single integration process. In this situation, the request and response les are often known and can thus be
specied in the conguration itself.

Scheduling Tasks  
Scheduling tasks automates the Taleo Connect Client ongoing import and export processes. Scheduled imports and
exports are programmed and maintained by users, on scheduler software running in the environment (Windows, Linux).

Linux use Cron to schedule tasks. Refer to your system documentation to implement scheduling under Linux.

Scheduling in Windows  
Integration scripts that have been tested and are ready to scheduled.

1. Click Start > Programs > Accessories > System Tools > Scheduled Tasks.

The Scheduled Tasks window opens.

2. Double-click Add Scheduled Task.

The Scheduled Task Wizard opens.

3. Click Next.

A le selection window opens in the Wizard.
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4. Click Browse...

The Select Program to Schedule browser window opens.

5. Navigate to the folder where the batch le to schedule is located.
a. Click on the batch le to select it.
b. Click Open.

6. Enter task name (optional).

If the batch le name is well constructed and reects the specic task being automated, you might as well leave
the task name as is.

a. Select task frequency.
b. Click Next.
c. Select task frequency details.
d. Click Next.
e. Enter Windows domain user name.
f. Enter password.

g. Conrm password.
h. Click Next.

7. Click Finish.

The task is displayed in the Scheduled Tasks window.

Execution from Java  
Execution of a Taleo Connect Client workow from within another Java application is possible. The host
application must match the environment constraints dened in the TaleoConnectClient.bat script and invoke the
com.taleo.integration.client.Client.execute() method.

For Taleo Connect Client to execute correctly, the proper execution environment must be available. The following
execution script is the minimal required conguration for a typical Windows installation:

SET IC_HOME="C:\Program Files\Taleo Connect Client";

SET CLASSPATH="%IC_HOME%\lib\taleo-integrationclient.jar";"%IC_HOME%\log";

java.exe

-Dcom.taleo.integration.client.install.dir="%IC_HOME%"

-Djava.endorsed.dirs="%IC_HOME%\lib\endorsed"

-Djavax.xml.parsers.SAXParserFactory=org.apache.xerces.jaxp.SAXParserFactoryImpl

-Dorg.apache.commons.logging.Log=org.apache.commons.logging.impl.Log4JLogger

-classpath %CLASSPATH% com.acme.integration.ACMEIntegrationProcess

The IC_HOME variable denes the installation directory of the Taleo Connect Client. This information is required
because several libraries and resources are delivered with the installation bundle.

The classpath of the application is fairly simple because the taleo-integrationclient.jar contains the full classpath
embedded in its manifest. This works ne with most JRE implementations. If any classpath problems occurs, you may
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also explicitly dene the classpath by including all Java libraries (*.jar) in the lib and lib/endorsed folders. Of course,
the classpath must also contain the required references to the host Java application.

In the Java invocation command itself, we rst set the Taleo Connect Client installation directory explicitly. This is
required mainly to locate the feature pack les. The next instruction ensures that the proper version of the Xerces XML
parser is used. The nal system property directs the Apache Jakarta Commons Logging project to use the Apache
Log4J system. This is the reason why the log folder is part of the classpath, as the log4j.properties conguration le
is located there. The invoked class com.acme.integration.ACMEIntegrationProcess is used here only as an example and
should be replaced by the actual entry point of your Java application hosting the Taleo Connect Client.

The correct entry point to execute the Taleo Connect Client is: com.taleo.integra-tion.client.Client.execute(). The
JavaDoc provided for this method in the docs/api folder of the product describes the behavior and parameter values.
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4  Geing Started

Starting  

The Objective  
The objective is to import one record into a Taleo product and then to export basic information from that same record
back to TCC.

A new candidate will be imported into the Taleo Professional product. This example will create a candidate prole only,
e.g. it will not create an application on a requisition.

Basic information regarding the candidate previously uploaded will be extracted. Various features of the export editor
will be used to build powerful custom queries to extract data from the Taleo product.

The candidate has:

• An e-mail address
psmith@abc.com

• A rst name
Paul

• A last name
Smith

• A curriculum vitae provided as a Microsoft Word document
psmith_cv.doc

• A few work experiences
Senior Consultant at ABC International in 2011
Analyst at XYZ Inc. for the rst half of 2012

All the relevant les will be created in the C:\tcc\starter folder.

Creating Starter Folder  
1. From Windows desktop open My Computer.
2. Open Local Disk (C:).
3. File>New>Folder.

a. Rename New Folder tcc.
b. Double click tcc

Tcc is open, the address bar shows C:\tcc.

4. File>New>Folder.
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a. Rename New Folder starter.
b. Double click starter.

starter is open, the address bar shows C:\tcc\starter.

5. Navigate to the Taleo Connect Client installation folder.
a. Open monitor folder.
b. Copy web folder.
c. Navigate back to the starter folder.
d. Paste web folder

The HTML monitoring page needs the graphic elements from that folder to display properly.

6. Minimize window.

Creating Curriculum Vitae  
1. Open Microsoft Word or a compatible editor.
2. Create a new document.
3. Enter Curriculum Vitae Paul Smith.
4. Save as psmith_cv.doc in C:\tcc\starter.
5. Close editor.

Starting Taleo Connect Client  
1. Start Taleo Connect Client.

First the splash screen appears, then the Ping the Taleo Product window opens.

2. Select the product to connect to from the pull down menu.

The product to ping is selected.

3. Select the Endpoint.

Make sure the Endpoint selected is for a staging, development, or testing zone, not the production zone. The
information in this procedure will truly be imported to your Taleo Professional product and there is no undo
action possible.

4. Verify the authentication information.
5. Click Ping.

The Ping the Taleo product window closes. The TCC graphic user interface opens.
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Importing  

Creating Import Specication  
The rst task is to create an import specication that will describe the structure of the CSV format request le, by
dening the information represented by each column.

1. File>New>New Import Wizard

The New Import Wizard window opens

2. Select Professional/Recruiting [Version] product from pull down menu.
3. Select Candidate Import Service from list.
4. Select Create new import specication.
5. Select Merge Operation from pull down menu.

The merge operation will delegate processing to the create or the update operation as needed. If the record
does not exist it will create it, if it exists it will update it.

6. Click Finish.

The New import specication is displayed in the import editor.

Dening Import Specication  
1. Verify General tab information and correct if necessary.
2. Click on Entity tab.

The Entity view displays the Candidate entity structure.

3. Click on Columns tab.

The Columns tab displays an empty columns list.

4. Drag and drop EmailAddress from the Entity Structure to the Columns list.
a. In Behavior section check Use the value to search or lookup.
b. Verify that Target is Candidate.
c. Check Also set this value in the entity.

5. Drag and drop FirstName from the Entity Structure to the Columns list.
6. Drag and drop LastName from the Entity Structure to the Columns list.
7. Scroll Entity Structure to AachedFiles and expand.

a. Expand CandidateAachedFile.
b. Drag and drop FileName from the Entity Structure to the Columns list.
c. Drag and drop FileContent from the Entity Structure to the Columns list.

8. Click AachedFiles,FileContent in Columns list.
a. Select Value is the location of a le to aach.

Indicates that the eld is the path and le name of the le to aach.

9. Scroll Entity Structure to TalentUser and expand.

In terms of the business model, the TalentUser relation is where we create a general prole for the candidate.
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10. Scroll Entity Structure to Prole and expand.
11. Drag and drop Locale from the Entity Structure to the Columns list.

The language of the prole is a mandatory eld.

a. Click TalentUser,Prole,Locale in Columns list.
b. Select Header check box in Column information section.
c. Enter Locale as header label.

12. Scroll Prole to Experiences and expand.
13. Drag and drop DisplaySequence from the Entity Structure to the Columns list.

The display sequence of the experience is a mandatory eld.

14. Click TalentUser,Prole,Experiences,DisplaySequence in Columns list.
a. Select Header check box in Column information section.
b. Enter Exp1-Sequence as header label.

15. Drag and drop OtherEmployerName from the Entity Structure to the Columns list.
16. Click TalentUser,Prole,Experiences,OtherEmployerName in Columns list.

a. Select Header check box in Column information section.
b. Enter Exp1-Employer as header label.

17. Drag and drop OtherJobTitle from the Entity Structure to the Columns list.
18. Click TalentUser,Prole,Experiences,OtherJobTitle in Columns list.

a. Select Header check box in Column information section.
b. Enter Exp1-JobTitle as header label.

19. Drag and drop BeginDate from the Entity Structure to the Columns list.
20. Click TalentUser,Prole,Experiences,BeginDate in Columns list.

a. Select Header check box in Column information section.
b. Enter Exp1-BeginDate as header label.

21. Drag and drop EndDate from the Entity Structure to the Columns list.
22. Click TalentUser,Prole,Experiences,EndDate in Columns list.

a. Select Header check box in Column information section.
b. Enter Exp1-EndDate as header label.

23. Drag and drop DisplaySequence from the Entity Structure to the Columns list.

This is the beginning of the columns that describe the second work experience

24. Click TalentUser,Prole,Experiences,DisplaySequence in Columns list.
a. Select Header check box in Column information section.
b. Enter Exp2-Sequence as header label.
c. Select Start a new element in the collection in Behavior section.

Indicates the start of a new element in the experience collection.

d. Select Skip column if value is empty in Behavior section.

Indicates that a second experience is optional. This makes the specication more exible.

25. Drag and drop OtherEmployerName from the Entity Structure to the Columns list.
26. Click TalentUser,Prole,Experiences,OtherEmployerName in Columns list.

a. Select Header check box in Column information section.
b. Enter Exp2-Employer as header label.
c. Select Skip column if value is empty in Behavior section.

27. Drag and drop OtherJobTitle from the Entity Structure to the Columns list.
28. Click TalentUser,Prole,Experiences,OtherJobTitle in Columns list.
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a. Select Header check box in Column information section.
b. Enter Exp2-JobTitle as header label.
c. Select Skip column if value is empty in Behavior section.

29. Drag and drop BeginDate from the Entity Structure to the Columns list.
30. Click TalentUser,Prole,Experiences,BeginDate in Columns list.

a. Select Header check box in Column information section.
b. Enter Exp2-BeginDate as header label.
c. Select Skip column if value is empty in Behavior section.

31. Drag and drop EndDate from the Entity Structure to the Columns list.
32. Click TalentUser,Prole,Experiences,EndDate in Columns list.

a. Select Header check box in Column information section.
b. Enter Exp2-EndDate as header label.
c. Select Skip column if value is empty in Behavior section.

Saving Import Specication  
1. File>Save as...
2. Select C:\tcc\starter as save in folder.

This folder was created earlier.

3. Enter candidate_merge as le name.
4. Select import (*_ld.xml) for save as type.
5. Click Save.

Creating Candidate CSV File  
1. Click Generate a sample csv le.

A sample csv le with the import specication columns opens in the default editor.

2. Enter column data.
a. EmailAddress: psmith@abc.com
b. FirstName: Paul
c. LastName: Smith
d. AachedFiles,Name: psmith_cv.doc
e. AachedFiles,Content: C:\tcc\starter\psmith_cv.doc
f. ProleLocale: en

g. Exp1-Sequence: 1
h. Exp1-Employer: ABC International
i. Exp1-JobTitle: Senior Consultant
j. Exp1-BeginDate: 2007-01-02

k. Exp1-EndDate: 2007-12-31
l. Exp2-Sequence: 2

m. Exp2-Employer: XYZ Inc.
n. Exp2-JobTitle: Analyst
o. Exp2-BeginDate: 2008-01-02
p. Exp2-EndDate: 2008-06-30
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3. File>Save as...
4. Select C:\tcc\starter as save in folder.
5. Enter candidate_merge as le name.
6. Select csv les (*.csv) for save as type.
7. Click Save.

Creating Import Conguration  
1. File>New>New Conguration Wizard

The New Conguration Wizard window opens.

2. Select Based on an import specication.
a. Click the Browse icon.
b. Select C:\tcc\starter.
c. Select candidate_merge_ld.xml.
d. Click Open.

3. Click Next.
4. Verify Endpoint.

Make sure the Endpoint selected is for a staging, development, or testing zone, not the production zone. The
information in this procedure will truly be imported to your Taleo Professional product and there is no undo
action possible.

5. Click Finish.

The New conguration specication is displayed in the conguration editor.

Dening Import Conguration  
1. Verify general tab information and correct if necessary.
2. In Request select Pre-dened value.

a. In le, click the Browse icon.
b. Look in: C:\tcc\starter.
c. Select candidate_merge.csv.
d. Click Open.

3. In Response select Generated using an identier.
a. In folder, click the Browse icon.
b. Select C:\tcc\starter.
c. In Identier, click the Browse icon.

The Choose Identier window opens.

d. Enter [FILE]_[NOW].
e. Click OK.

4. Click Monitoring tab.
a. Verify Enable Monitoring is checked.
b. In folder, click the Browse icon.
c. Select C:\tcc\starter.
d. Verify Reuse the workow identier as the le name is selected.
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e. Verify Create XML monitoring les is checked.
f. Verify Create HTML monitoring les is checked.

g. Verify Create text monitoring les is checked.
5. Click Send tab.

a. Verify Endpoint.

Make sure the Endpoint selected is for a staging, development, or testing zone, not the production zone.
The information in this procedure will truly be imported to your Taleo Professional product and there is
no undo action possible. The Preview section displays the URL of the endpoint.

6. Click Poll tab.
a. Verify Use Endpoint from the list is selected.
b. Verify Endpoint is same as previous.
c. In Quality section, verify Retry is checked.
d. Verify Interval (in seconds) is 10
e. Verify Completion aempts is checked and set to 30.

7. Click Retrieve tab.
a. Verify Use Endpoint from the list is selected.
b. Verify Endpoint is same as previous.

Saving Import Conguration  
1. File>Save
2. Select C:\tcc\starter as save in folder.
3. Enter candidate_merge as le name.
4. Select Client conguration (*_cfg.xml) for save as type.
5. Click Save.

Executing Import Conguration  
Import conguration le candidate-merge_cfg.xml is open and selected.

1. Window>Open perspective>Runtime
2. Click Execute the conguration icon.
3. Maximise Monitoring perspective. The workow execution details are displayed.
4. Wait for execution to complete.
5. Open C:\tcc\starter\candidate_merge-<datetime>.csv result le in CSV editor.

The result le opens.

Exporting  

Creating Export Specication  
1. File>New>New Export Wizard

95



Talent Acquisition Cloud
Using Connect Client

Chapter 4
Geing Started

The New Export Wizard window opens

2. Select Professional/Recruiting [Version] product from pull down menu.
3. In Filter enter the leer c.

The candidate entity moves to the top of the list.

4. Select Candidate.
5. Verify Create new export is selected.
6. Click Finish.

The New export specication is displayed in the import editor.

Dening Export Specication  
1. Click on Entity.

The entity view displays the Candidate elds and relations.

2. Click General tab.
a. Verify Locale is English.
b. In Export mode select CSV-report from pull down menu.
c. Check CSV header present.
d. Check CSV value delimiter and enter comma (,).
e. Check CSV quotation character and enter double quote (“).

3. Click Projections tab.
4. Drag and drop EmailAddress from the Entity Structure to the Projections list.
5. Click Add

a. Select Add a function projection.
b. Select Concatenate from the Function pull down menu.
c. Click OK.

6. In Alias enter FullName
a. Drag and drop LastName from the Entity Structure to the Function parameters list.
b. Select LastName and move to top with up arrow.
c. Select second parameter.
d. Select String from Data type pull down menu.
e. Enter a comma followed by a space (, ).
f. Select last parameter and delete with minus icon.

g. Drag and drop FirstName from the Entity Structure to the Function parameters list.
7. Click Filters tab.

a. Drag and drop EmailAddress from the Entity Structure to the Filters list.
b. Click Filter (Equal) in the Filters list.
c. Verify rst value is EmailAddress.
d. Verify rst Data type is Field.
e. Verify Operator is Equals.
f. Enter psmith@abc.com in second Value.

g. Verify Second Data type is String.
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Saving Export Specication  
1. File>Save as...
2. Select C:\tcc\starter as save in folder.

This folder was created earlier.

3. Enter candidate_export as le name.
4. Select Export (*_sq.xml) for save as type.
5. Click Save.

Creating Export Conguration  
1. File>New>New Conguration Wizard

The New Conguration Wizard window opens.

2. Select Based on an export specication.
a. Click the Browse icon.
b. Select C:\tcc\starter.
c. Select candidate_export_sq.xml.
d. Click Open.

3. Click Next.
4. Verify Endpoint. Make sure the Endpoint selected is same one used for the record import.
5. Click Finish.

The New conguration specication is displayed in the conguration editor.

Dening Export Conguration  
1. Verify general tab information and correct if necessary.
2. In Request select Pre-dened value.

a. In le, click the Browse icon.
b. Look in: C:\tcc\starter.
c. Select candidate_export_sq.xml.
d. Click Open.

3. In Response select Generated using an identier.
a. In folder, click the Browse icon.
b. Select C:\tcc\starter.
c. In Identier, click the Browse icon.

The Choose Identier window opens.

d. Enter Candidate-[NOW].
e. Click OK.

4. Click Monitoring tab.
a. Verify Enable Monitoring is checked.
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b. In folder, click the Browse icon.
c. Select C:\tcc\starter.
d. Verify Reuse the workow identier as the le name is selected.
e. Verify Create XML monitoring les is checked.
f. Verify Create HTML monitoring les is checked.

g. Verify Create text monitoring les is checked.
5. Click Send tab.

a. Verify Endpoint.

Make sure the Endpoint selected is same one used for the record import.

The Preview section displays the URL of the endpoint.

6. Click Poll tab.
a. Verify Use Endpoint from the list is selected.
b. Verify Endpoint is same as previous.
c. In Quality section, verify Retry is checked.
d. Verify Interval (in seconds) is 10
e. Verify Completion aempts is checked and set to 30.

7. Click Retrieve tab.
a. Verify Use Endpoint from the list is selected.
b. Verify Endpoint is same as previous.

Saving Export Conguration  
1. File>Save
2. Select C:\tcc\starter as save in folder.
3. Enter candidate_export as le name.
4. Select Client conguration (*_cfg.xml) for save as type.
5. Click Save.

Executing Export Conguration  
Export conguration le candidate_export_cfg.xml is open and selected.

1. Window>Open perspective>Runtime
2. Click the Execute the conguration icon.
3. Maximise Monitoring perspective

The workow execution details are displayed.

4. Wait for execution to complete.
5. Open C:\tcc\starter\candidate-<datetime>.csv result le in CSV editor.

The result le opens and displays the extracted data.
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5  Using TCC

Hierarchical Entities  

Hierarchical Entities  
Hierarchical entities are organized in a tree structure. They are composed of parents and children. The root entity has no
parent and is the ancestor of all the other entities.

Types
There are two types of hierarchical entities. The rigid type such as Organization, Location and JobField in SmartOrg and
the exible type such as Department in Professional.

Rigid hierarchical entities require special aention in import operations. To create a rigid type entity you must specify its
Parent. To delete a rigid type entity you must rst delete all its children or move them to a new Parent.

Flexible type entities prey much behave as regular entities in import operations. They can be created individually
without a parent or structured in a hierarchy. To delete a exible type entity its dependencies, if any, must be reassigned
to another entity.

Model
We will use the Organization entity to illustrate various import operations on hierarchical entities. We will create an
Organization, update its multilingual elds, reorganize it, and delete parts of it.

Here is the top of the organization:

To keep the model manageable we have only expanded the sales division. Here is the sales division:
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Once the Organization has been created and updated, the sales division will be restructured. Here is the restructured
sales division:
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Fields
We will use the following elds and relations from the Organization entity to perform our operations:

• Code: Unique identier that provides a meaningful key. Unilingual string.

• CustomerID: Customer identier used to reference the organization in an external system for integration
purposes. Unilingual string.

• Name: Name of the organization instance. Multilingual string.

• Parent, Organisation.Code: Unique identier that provides a meaningful key. Unilingual string.

• Industry.Number: Associated industry number that is pre-loaded in the Taleo application. Integer.

• Sequence: Specied sorting order that overrides the default sorting order when viewing the entity in the Taleo
application. Integer.

Finding Root Code  
To nd the root code, we will extract it from the entity. The root code value will be the parent code of the rst record of
the hierarchical entity we will create.

Taleo Connect Client is running and ready for use.

Taleo application is available for integration.

1. Click File, New to open the New Export Wizard.
2. In Product pull down menu, Select SmartOrg [Version].

a. In Filter, enter leer o.
b. Click Organization.
c. Select Create new export.
d. Click Finish. A New Export editor opens.

3. In General tab, select CSV header present. We will use default values for the CSV aributes.
4. Select Projections tab.
5. Drag and Drop Code, Name, and Level from Entity view to Projections list.
6. Select Filters tab.

a. Drag Level from Entity view to Filters list and select it.
b. In the boom Data type drop down menu select Integer.
c. In value, Enter 0. Level 0 is the root level.

7. Save as OrgRoot-export_sq.xml in organization-export folder. Level 0 is the root level.
8. Click File, New to open the New Conguration Wizard.
9. Select Based on an export specication.

a. Click the Browse icon.
b. Navigate to organization-export folder.
c. Select OrgRoot-export_sq.xml.
d. Click on Open.
e. Click on Next.
f. Select Endpoint.

g. Click on Finish. A New Conguration editor opens.
10. In General tab, under Request, select Pre-dened value.

a. Click the Browse icon. A Select le window opens.
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b. Navigate to organization-export folder.
c. Select OrgRoot-export_sq.xml.
d. Click Open. The le path and name are displayed in the dialog box.

11. In General tab, under Response, select Generated using an identier.
a. Click the Browse icon.
b. Navigate to organization-export folder.
c. Click OK. The le path is displayed in the dialog box.
d. Click the Browse icon.
e. In the Template dialog box enter [FILE]-[NOW].
f. Click OK. [FILE]-[NOW] is displayed in the dialog box.

12. Save as OrgRoot-Extract_cfg.xml in organization-export folder.
13. Click the Execute the conguration icon. and wait for the workow to complete the extraction.
14. Open organization-export folder.
15. Open CSV result le OrgRoot-export_sq-yyyyMMddTHHmmss.csv in a csv editor or notepad

The root code, organization name, and level are displayed below the header.

Code,Name,Level 
ROOT-ORGANIZATION,[en]=New Millenium,0

Creating an Organization  
Taleo Connect Client is running and ready for use.

Taleo application is available for integration.

1. From TCC open New Import Wizard  File>New>New Import Wizard.

The New Import Wizard opens.

2. In Product, Select SmartOrg [Version] from pull down menu.
a. Click on Organization.
b. Select Use the following import template.
c. In Template pull down menu, select Basic Organization create.
d. Click on Finish.

A New Import editor opens.

3. Verify that the information in the General tab is correct.
a. Header present is selected.
b. Value delimiter is comma.
c. Quotation character is double quotes.

4. In Advanced: Other import options click the Browse icon.
a. Integration Processor is selected.
b. olf is specied in dialog box.
c. In Additional import options, switch.system.maintenance parameter is set to always.
d. Click OK.

5. Click on Columns tab.
6. Select each column and verify Column information and Behavior.
7. Save as organization-create_ld.xml in organization-create folder.
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8. Click Generate a sample csv le.

The sample csv le opens in the default editor.

9. Enter the following data in the csv le.

The rst line is the le header. The second line is the rst line of data. ROOT-CODE is the root code extracted
previously from the Taleo product.

Code,CustomerID,Name,ParentCode,IndustryNumber,DisplaySequence 
CPCORP0,CORP-CONPROD,Corporate Headquarters,ROOT-CODE,12,1 
CPRD0,RD-CONPROD,Research & Development,CPCORP0,12,300 
CPHR0,HR-CONPROD,Human Ressources,CPCORP0,12,500 
CPPRD0,PROD-CONPROD,Production,CPCORP0,12,400 
CPFIN0,FINANCE-CONPROD,Finance,CPCORP0,12,200 
CPSAL0,SALES-CONPROD,Sales,CPCORP0,12,100 
CANSAL0,SALES-CAN,Canada,CPSAL0,12,130 
USASAL0,SALES-USA,United States of America,CPSAL0,12,110 
MEXSAL0,SALES-MEX,Mexico,CPSAL0,12,120 
CANSAL1,SALES-MAR,Maritimes,CANSAL0,12,131 
CANSAL2,SALES-QC,Quebec,CANSAL0,12,132 
CANSAL3,SALES-ON,Ontario,CANSAL0,12,133 
CANSAL4,SALES-PRA,Prairies,CANSAL0,12,134 
CANSAL5,SALES-BC,British Columbia,CANSAL0,12,135 
USASAL1,SALES-NE,New England,USASAL0,12,111 
USASAL2,SALES-MA,Mid-Atlantic,USASAL0,12,112 
USASAL3,SALES-SE,Southeast,USASAL0,12,113 
USASAL4,SALES-CGL,Central Great Lakes,USASAL0,12,114 
USASAL5,SALES-SGC,South / Gulf Coast,USASAL0,12,116 
USASAL6,SALES-MW,Midwest,USASAL0,12,115 
USASAL7,SALES-WM,Western Mountains,USASAL0,12,117 
USASAL8,SALES-CA,California,USASAL0,12,118 
MEXSAL1,SALES-BA,Baja California,MEXSAL0,12,126 
MEXSAL2,SALES-NM,Northern Mexico,MEXSAL0,12,125 
MEXSAL3,SALES-TB,The Bajio,MEXSAL0,12,124 
MEXSAL4,SALES-CM,Central Mexico,MEXSAL0,12,121 
MEXSAL5,SALES-PC,Pacific Coast,MEXSAL0,12,123 
MEXSAL6,SALES-YP,Yucatan Peninsula,MEXSAL0,12,122

10. Save le as organization-create.csv in organization-create folder.
11. From TCC open New Conguration Wizard File>New>New Conguration Wizard.

The New Conguration Wizard opens.

12. Select Based on an import specication.
a. Click the Browse icon.

A Select folder window opens.

b. Navigate to organization-create folder.
c. Select organization-create_ld.xml.
d. Click on Open.
e. Click on Next.
f. Select Endpoint.

g. Click on Finish.

A New Conguration editor opens.

13. In General tab, under Request, select Pre-dened value
a. Click the Browse icon.

A Select le window opens.
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b. Navigate to organization-create folder.
c. Select organization-create.csv.
d. Click on Open.

The le path and name are displayed in the dialog box

14. In General tab, under Response, select Generated using an identier
a. Click the Browse icon.

A Select folder window opens.

b. Navigate to organization-create folder.
c. Click on OK.

The le path is displayed in the dialog box

d. Click the Browse icon.

A Choose Identier window opens.

e. In the Template dialog box enter [FILE]-[NOW]
f. Click OK.

[FILE]-[NOW] is displayed in the dialog box

15. Save as organization-create_cfg.xml in organization-create folder.
16. Click the Execute the conguration icon and wait for the workow to complete the import.
17. Open organization-create folder.
18. Open CSV result le organization-create-yyyyMMddTHHmmss.csv in a csv editor or notepad

The following results are displayed.

"Index","Identifier","Status","TransactionType","Result","Message" 
"1","","success","organization.create",,"" 
"2","","success","organization.create",,"" 
"3","","success","organization.create",,"" 
... 
"26","","success","organization.create",,"" 
"27","","success","organization.create",,"" 
"28","","success","organization.create",,""

Updating an Organization  
Updating organisation multilingual elds with the specic locale method.

Taleo Connect Client is running and ready for use.

Taleo application is available for integration.

Taleo application has more than one active language.

1. From TCC open New Import Wizard  File>New>New Import Wizard.

The New Import Wizard opens.

2. In Product, Select SmartOrg [Version] from pull down menu.
a. Click on Organization.
b. Select Use the following import template.
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c. In Template pull down menu, select Basic Organization update.
d. Click on Finish.

A New Import editor opens.

3. Verify that the information in the General tab is correct.
a. Header present is selected.
b. Value delimiter is comma.
c. Quotation character is double quotes.

4. In Advanced: Other import options click the Browser buon.
a. Integration Processor is selected.
b. olf is specied in dialog box.
c. In Additional import options, switch.system.maintenance parameter is set to always.
d. Click OK.

5. Click on Columns tab.
6. Select Organisation: name.

a. In Column information select Header and enter Name (en) in dialog box.
b. In Behavior select Skip column if value is empty.
c. Expand Multilingual elds.
d. In locale type select Specic locale from pull down menu.
e. In locale select english from pull down menu.

7. Drag and drop Name from Entity view.
a. Select Organisation: name.
b. Click Up buon to move it above DisplaySequence and below Name (en).
a. In Column information select Header and enter Nom (fr) in dialog box.
b. In Behavior select Skip column if value is empty.
c. In Multilingual elds, Locale type select Specic locale from pull down menu.
d. In Multilingual elds, Locale select french from pull down menu.

8. Drag and drop Name from Entity view.
a. Select Organisation: name.
b. Click Up buon to move it above DisplaySequence and below Nom (fr).
c. In Column information select Header and enter Nombre (es) in dialog box.
d. In Behavior select Skip column if value is empty.
e. In Multilingual elds, Locale type select Specic locale from pull down menu.
f. In Multilingual elds, Locale select spanish from pull down menu.

9. Save as organization-update_ld.xml in organization-update folder.
10. Click Generate a sample csv le.

The sample csv le opens in the default editor.

11. Enter the following data in the csv le.

The rst line is the le header. The second line is the rst line of data.

Code,CustomerID,Name (en),Nom (fr),Nombre (es),DisplaySequence 
CPCORP0,CORP-CONPROD,Corporate Headquarters,Siège social,Domicilio social,1 
CPRD0,RD-CONPROD,Research & Development,Recherche et développement,Investigatiión y desarrollo,300 
CPHR0,HR-CONPROD,Human Ressources,Ressources humaines,Recursos humanas,500 
CPPRD0,PROD-CONPROD,Production,Production,Producción,400 
CPFIN0,FINANCE-CONPROD,Finance,Finance,Finanzas,200 
CPSAL0,SALES-CONPROD,Sales,Ventes,Ventas,100 
CANSAL0,SALES-CAN,Canada,Canada,Canada,130 
USASAL0,SALES-USA,United States of America,États Unis d'Amérique,Estados Unidos de América,110 
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MEXSAL0,SALES-MEX,Mexico,Mexique,Mexico,120 
CANSAL1,SALES-MAR,Maritimes,Maritimes,Marítimos,131 
CANSAL2,SALES-QC,Quebec,Québec,Quebec,132 
CANSAL3,SALES-ON,Ontario,Ontario,Ontario,133 
CANSAL4,SALES-PRA,Prairies,Prairies,Praderas,134 
CANSAL5,SALES-BC,British Columbia,Colombie Britannique,Colombia Británica,135 
USASAL1,SALES-NE,New England,Nouvelle Angleterre,Nueva Inglaterra,111 
USASAL2,SALES-MA,Mid-Atlantic,Atlantique centre,Atlántico central,112 
USASAL3,SALES-SE,Southeast,Sud-est,Sudeste,113 
USASAL4,SALES-CGL,Central Great Lakes,Grands lacs central,Gran lagos central,114 
USASAL5,SALES-SGC,South / Gulf Coast,Sud / Côte du golfe,Sur / Costa del golfo,116 
USASAL6,SALES-MW,Midwest,Midwest,Midwest,115 
USASAL7,SALES-WM,Western Mountains,Montagnes de l'ouest,Montañas del oeste,117 
USASAL8,SALES-CA,California,Californie,California,118 
MEXSAL1,SALES-BA,Baja California,Baja California,Baja California,125 
MEXSAL2,SALES-NM,Northern Mexico,Mexique du Nord,Mexico del norte,125 
MEXSAL3,SALES-TB,The Bajio,Le Bajio,El Bajío,124 
MEXSAL4,SALES-CM,Central Mexico,Mexique central,Mexico central,121 
MEXSAL5,SALES-PC,Pacific Coast,Côte du Pacifique,Costa del Pacífico,123 
MEXSAL6,SALES-YP,Yucatan Peninsula,Péninsule du Yucatan,Península del Yucatan,122

12. Save le as organization-update.csv in organization-update folder.
13. From TCC open New Conguration Wizard File>New>New Conguration Wizard.

The New Conguration Wizard opens.

14. Select Based on an import specication.
a. Click the Browse icon.

A Select folder window opens.

b. Navigate to organization-update folder.
c. Select organization-update_ld.xml.
d. Click on Open.
e. Click on Next.
f. Select Endpoint.

g. Click on Finish.

A New Conguration editor opens.

15. In General tab, under Request, select Pre-dened value
a. Click the Browse icon.

A Select le window opens.

b. Navigate to organization-update folder.
c. Select organization-update.csv.
d. Click on Open.

The le path and name are displayed in the dialog box.

16. In General tab, under Response, select Generated using an identier.
a. Click the Browse icon.

A Select folder window opens.

b. Navigate to organization-update folder.
c. Click on OK.

The le path is displayed in the dialog box.

d. Click the Browse icon.
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A Choose Identier window opens.

e. In the Template dialog box enter [FILE]-[NOW].
f. Click OK.

[FILE]-[NOW] is displayed in the dialog box.

17. Save as organization-update_cfg.xml in organization-export folder.
18. Click the Execute the conguration icon and wait for the workow to complete the import.
19. Open organization-update folder.
20. Open CSV result le organization-update-yyyyMMddTHHmmss.csv in a csv editor or notepad.

The following results are displayed.

"Index","Identifier","Status","TransactionType","Result","Message" 
"1","","success","organization.update",,"" 
"2","","success","organization.update",,"" 
"3","","success","organization.update",,"" 
... 
"26","","success","organization.update",,"" 
"27","","success","organization.update",,"" 
"28","","success","organization.update",,""

Modifying an Organization  
Taleo Connect Client is running and ready for use.

Taleo application is available for integration.

1. From TCC open organization-create_ld.xml in organization-create folder.
2. Click Generate a sample csv le.

The sample csv le opens in the default editor.

3. Enter the following data in the csv le.

The rst line is the le header. The second line is the rst line of data.

Code,CustomerID,Name,ParentCode,IndustryNumber,DisplaySequence 
NMSAL1,SALES-NA,North America,CPSAL0,12,101 
NMSAL2,SALES-EME,Europe & Middle East,CPSAL0,12,102 
NMSAL3,SALES-ASIA,Asia,CPSAL0,12,103

4. Save le as reorganization-create.csv in organization-create folder.
5. From TCC open organization-create_cfg.xml in organization-create folder.
6. In General tab, under Workow modify Workow identier to Reorganization-create-[NOW].
7. In General tab, under Request, select Pre-dened value

a. Click the Browse icon.

A Select le window opens.

b. Navigate to organization-create folder.
c. Select reorganization-create.csv.
d. Click on Open.

The le path and name are displayed in the dialog box

8. Save as reorganization-create_cfg.xml in organization-export folder.
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9. Click the Execute the conguration icon and wait for the workow to complete the import.
10. Open organization-create folder.
11. Open CSV result le reorganization-create-yyyyMMddTHHmmss.csv in a csv editor or notepad.

The following results are displayed.

"Index","Identifier","Status","TransactionType","Result","Message" 
"1","","success","organization.create",,"" 
"2","","success","organization.create",,"" 
"3","","success","organization.create",,""

Moving an Organization  
Taleo Connect Client is running and ready for use.

Taleo application is available for integration.

1. From TCC open New Import Wizard  File>New>New Import Wizard.

The New Import Wizard opens.

2. In Product, Select SmartOrg [Version] from pull down menu.
a. Click on Organization.
b. Select Use the following import template.
c. In Template pull down menu, select Basic Organization move.
d. Click on Finish.

A New Import editor opens.

3. Verify that the information in the General tab is correct.
a. Header present is selected.
b. Value delimiter is comma.
c. Quotation character is double quotes.

4. In Advanced: Other import options click the Browse icon.
a. Integration Processor is selected.
b. olf is specied in dialog box.
c. In Additional import options, switch.system.maintenance parameter is set to always.
d. Click OK.

5. Click on Columns tab.
6. Select each column and verify Column information and Behavior.

The move operation requires two parameters, the organization to move and the new parent organization. The
parameters are selected from the Parameter pull down menu in the Entity view.

7. Save as organization-move_ld.xml in organization-move folder.
8. Click Generate a sample csv le.

The sample csv le opens in the default editor.

9. Enter the following data in the csv le.

The rst line is the le header. The second line is the rst line of data.

"OrganizationCode","NewParentCode" 
CANSAL0,NMSAL1 
USASAL0,NMSAL1 
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MEXSAL0,NMSAL1

10. Save le as organization-move.csv in organization-move folder.
11. From TCC open New Conguration Wizard File>New>New Conguration Wizard.

The New Conguration Wizard opens.

12. Select Based on an import specication.
a. Click the Browse icon.

A Select folder window opens.

b. Navigate to organization-move folder.
c. Select organization-move_ld.xml.
d. Click on Open.
e. Click on Next.
f. Select Endpoint.

g. Click on Finish.

A New Conguration editor opens.

13. In General tab, under Request, select Pre-dened value
a. Click the Browse icon.

A Select le window opens.

b. Navigate to organization-move folder.
c. Select organization-move.csv.
d. Click on Open.

The le path and name are displayed in the dialog box

14. In General tab, under Response, select Generated using an identier
a. Click the Browse icon.

A Select folder window opens.

b. Navigate to organization-move folder.
c. Click on OK.

The le path is displayed in the dialog box

d. Click the Browse icon.

A Choose Identier window opens.

e. In the Template dialog box enter [FILE]-[NOW]
f. Click OK.

[FILE]-[NOW] is displayed in the dialog box

15. Save as organization-move_cfg.xml in organization-move folder.
16. Click the Execute the conguration icon and wait for the workow to complete the import.
17. Open organization-move folder.
18. Open CSV result le organization-move-yyyyMMddTHHmmss.csv in a csv editor or notepad

The following results are displayed.

"Index","Identifier","Status","TransactionType","Result","Message" 
"1","","success","organization.move",,"" 
"2","","success","organization.move",,"" 

109



Talent Acquisition Cloud
Using Connect Client

Chapter 5
Using TCC

"3","","success","organization.move",,""

Deleting an Organization  
Taleo Connect Client is running and ready for use.

Taleo application is available for integration.

1. From TCC open New Import Wizard  File>New>New Import Wizard.

The New Import Wizard opens.

2. In Product, Select SmartOrg [Version] from pull down menu.
a. Click on Organization.
b. Select Use the following import template.
c. In Template pull down menu, select Basic Organization delete.
d. Click on Finish.

A New Import editor opens.

3. Verify that the information in the General tab is correct.
a. Header present is selected.
b. Value delimiter is comma.
c. Quotation character is double quotes.

4. In Advanced: Other import options click the Browse icon.
a. Integration Processor is selected.
b. olf is specied in dialog box.
c. In Additional import options, switch.system.maintenance parameter is set to always.
d. Click OK.

5. Click on Columns tab.
6. Select each column and verify Column information and Behavior.

The delete operation oers two parameters, the Organization to delete and the Reassignorganization for
the orphans. If the entity to delete has children, they can be reassigned to a new parent. The parameters are
selected from the Parameter pull down menu in the Entity view.

7. Select ReassignOrganisation and click Remove.
8. Save as organization-delet_ld.xml in organization-delete folder.
9. Click Generate a sample csv le.

The sample csv le opens in the default editor.

10. Enter the following data in the csv le.

The rst line is the le header. The second line is the rst line of data.

OrganisationCode 
MEXSAL1 
MEXSAL2 
MEXSAL3 
MEXSAL4 
MEXSAL5 
MEXSAL6 
MEXSAL0
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Note that the parent is the last entry. All the children will be deleted before the parent.

11. Save le as organization-delete.csv in organization-delete folder.
12. From TCC open New Conguration Wizard File>New>New Conguration Wizard.

The New Conguration Wizard opens.

13. Select Based on an import specication.
a. Click the Browse icon.

A Select folder window opens.

b. Navigate to organization-delete folder.
c. Select organization-delete_ld.xml.
d. Click on Open.
e. Click on Next.
f. Select Endpoint.

g. Click on Finish.

A New Conguration editor opens.

14. In General tab, under Request, select Pre-dened value
a. Click the Browse icon.

A Select le window opens.

b. Navigate to organization-delete folder.
c. Select organization-delete.csv.
d. Click on Open.

The le path and name are displayed in the dialog box

15. In General tab, under Response, select Generated using an identier
a. Click the Browse icon.

A Select folder window opens.

b. Navigate to organization-delete folder.
c. Click on OK.

The le path is displayed in the dialog box

d. Click the Browse icon.

A Choose Identier window opens.

e. In the Template dialog box enter [FILE]-[NOW]
f. Click OK.

[FILE]-[NOW] is displayed in the dialog box

16. Save as organization-delete_cfg.xml in organization-move folder.
17. Click the Execute the conguration icon and wait for the workow to complete the import.
18. Open organization-delete folder.
19. Open CSV result le organization-delete-yyyyMMddTHHmmss.csv in a csv editor or notepad

The following results are displayed.

"Index","Identifier","Status","TransactionType","Result","Message" 
"1","","success","organization.delete",,"" 
"2","","success","organization.delete",,"" 
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"3","","success","organization.delete",,"" 
"4","","success","organization.delete",,"" 
"5","","success","organization.delete",,"" 
"6","","success","organization.delete",,"" 
"7","","success","organization.delete",,""

Filters  

Last Run Date  
The Last Run Date (LRD) is used in export specications to lter records based on the value of a date eld. This feature
facilitates the extraction of records created or modied since the last execution of the workow.

The LRD is set after the extract is completed and only if there were no errors during the process. The Last Run Date that
is saved will be the one captured at the beginning of the process.

Files
The date and time of a successful export workow is stored as a *.lrd le in the ...\Taleo Connect Client
\lastrundates folder. The LRD le name is based on the conguration le that creates and updates it. For example:
Candidate_export_cfg.xml creates or updates Candidate_export.lrd.

Because the LRD value is associated to a specic conguration le, each export specication that uses LRD ltering
must be paired with its own conguration le. For example: Candidate_export_sq.xml is matched exclusively to
Candidate_export_cfg.xml. Using multiple LRD export specications with a single conguration le will cause saved
LRD conicts.

Delay
By default, LRD ltering uses the current zone time minus 5 minutes to set the LRD lter value.
The default LRD minute adjustment can be modied with the following system property:
com.taleo.integration.client.lrd.ltering.minute.adjustment.zone=[minute value]

Seing Last Run Date  
Seing Last Run Date will create the *.lrd le with an LRD value for rst time use.

The corresponding export specication le that uses the LRD lter exists.

1. Create a new conguration based on the corresponding export specication.
2. Save the conguration le.
3. Click on the Pre-processing tab.
4. Click on Prepare Last Run Date.
5. Select time and date source.

◦ TEE 7.0.5 and higher : Use date from the zone (default).

◦ TEE 7.0.4 and lower : Use date from current computer.

6. Click on the Change link.
a. Select date and time.
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b. Click OK.

Last Run Date value : displays selected date and time.

Strip Non Numeric Characters  
Non numeric characters can be removed quickly from a projection with the REGEXP_REPLACE function.

Phone numbers are commonly entered in multiple formats:

• (123)456-7890

• (123) 456-7890

• 123-456-7890

• 123 456-7890

This projection removes non numeric characters to output the results in the same format (1234567890) with the
REGEXP_REPLACE function.

<quer:projection alias="HomePhone"> 
 <quer:customFunction name="REGEXP_REPLACE"> 
 <quer:field path="Candidate,HomePhone"/> 
 <quer:string>\D</quer:string> 
 <quer:string/> 
 </quer:customFunction> 
</quer:projection>

Regular expressions are a powerful tool that can also be used for other data transformations.

Filtering vs ProjectionFiltering  
<lterings> and <projectionsFilterings> have dierent semantics. This is to disambiguate where the lter should be
applied: the driving table or a joined table.

For example, we want to create a query for the following model: Requisition -> CieLocation. This is an N relation where
there are many CieLocation for one Requisition.

We create a query for Requisition and add a projection for CieLocation. If we have a <ltering> on CieLocation, it lters
out Requisition that doesn’t satisfy the lter. If we have a <projectionltering> on CieLocation, it lters out CieLocation
that doesn’t satisfy the lter.

In other words, <ltering> is a lter on an inner join and <projectionltering> is a lter on an outer join.
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Miscellaneous  

Removing Element From Collection  
Taleo Connect Client can remove a specic element from a collection. When updating a record, the user can remove a
specic element from a collection before adding new ones.

Taleo Connect Client is running and ready for use.

Taleo application is available for integration.

• This operation is only available for removable relations. Please refer to the data dictionary entity relation
summary table for documentation about removable relations.

1. From TCC open New Import Wizard  File>New>New Import Wizard.

The New Import Wizard opens.

2. In Product, Select SmartOrg [Version] from pull down menu.
a. Click on User.
b. Select Create a new import specication.
c. In Operation pull down menu, update.
d. Click on Finish.

A New Import editor opens.

3. Verify that the information in the General tab is correct.
a. Header present is selected.
b. Value delimiter is comma.
c. Quotation character is double quotes.

4. Click on Columns tab.
5. Select the user search key.

a. Drag User.CorrespondenceEmail from entity structure to Column list.
b. In Behavior section, select Use the value for search or lookup.

6. Add a column to remove a Group from the user account.
a. Drag UserAccount,Groups,Description from entity structure to Column list.
b. Select UserAccount,Groups,Description in the column list.
a. In Behavior section, select Use the value for search or lookup.
b. In Behavior section, select Remove element from the collection.

To remove multiple items from the collection, repeat step as many times as required. In Behavior section, select
"Start a new element in the collection" for the second and following items.

Exporting Language Codes  
Language codes can be exported in CSV-report format. The user can identify the language code associated to
multilingual elds, allowing the exported string to be matched to the locale.
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Taleo Connect Client is running and ready for use.

Taleo application is available for integration.

1. From TCC open New Export Wizard  File>New>New Export Wizard.

The New Export Wizard opens.

2. In Product pull down menu, Select SmartOrg [Version].
a. In Filter, enter leer o.
b. Click on Organization.
c. Select Create new export.
d. Click on Finish.

A New Export editor opens.

3. In General tab, Other information, Export mode, select CSV-report from pull down menu. header present.
4. In General tab, Other information, select CSV header present.

We will use default values for the CSV aributes.

5. Select Projections tab.
6. Drag and Drop Name from Entity view to Projections list.

a. Select Name in projection list.
b. Select Alias and enter ParentName in dialog box.
c. Click Field open window buon.
d. Select Show the value only in the default locale.
e. Click OK

7. Drag and Drop Code from Entity view to Projections list.
a. Select Code in projection list.
b. Select Alias and enter ParentCode in dialog box.

8. Drag and Drop Children,Name from Entity view to Projections list.

Expand Children and BaseComposite to expose Name.

a. Select Children,Name in projection list.
b. Select Alias and enter ChildName in dialog box.
c. Click Field open window buon.
d. Select Show values in all locales.
e. Click OK.

9. Click Add.
a. Select Add a multilingual eld projection.
b. Click OK.
c. Select multilingual eld projection.
d. Select Alias and enter ChildLocale in dialog box.
e. Select Locale from Field pull down menu.
f. Drag and drop the Children relation into the Relation dialog box.

10. Select Filters tab.
a. Drag Code from Entity view to Filters list and select it.

By default rst Value is set to Code, Data type is set to Field, and Operator is set to Equals.

b. Set second Value to CPCORP0.
c. Select String from pull down menu for second Data type.

115



Talent Acquisition Cloud
Using Connect Client

Chapter 5
Using TCC

11. Save as OrgLocale-export_sq.xml in organization-export folder.

Folder structure is described in Installation section.

12. From TCC open New Conguration Wizard  File>New>New Conguration Wizard.

The New Conguration Wizard opens.

13. Select Based on an export specication.
a. Click the Browser buon.

A Select folder window opens.

b. Navigate to organization-export folder.
c. Select OrgLocale-export_sq.xml.
d. Click on Open.
e. Click on Next.
f. Select Endpoint.

g. Click on Finish.

A New Conguration editor opens.

14. In General tab, under Request, select Pre-dened value
a. Click the Browser buon.

A Select le window opens.

b. Navigate to organization-export folder.
c. Select OrgLocale-export_sq.xml.
d. Click on Open.

The le path and name are displayed in the dialog box

15. In General tab, under Response, select Generated using an identier
a. Click the Browser buon.

A Select folder window opens.

b. Navigate to organization-export folder.
c. Click on OK.

The le path is displayed in the dialog box

d. Click the Browser buon.

A Choose Identier window opens.

e. In the Template dialog box enter OrgLocale-[NOW]
f. Click OK.

OrgLocale-[NOW] is displayed in the dialog box

16. Save as OrgLocale-Extract_cfg.xml in organization-export folder.
17. Click the Execute the conguration icon and wait for the workow to complete the extraction.
18. Open organization-export folder.
19. Open CSV result le OrgLocale-yyyyMMddTHHmmss.csv in a csv editor or notepad

ParentName,Parentcode,ChildName,ChildLocale 
Corporate Headquarters,CPCORP0,Research & Development,en 
Corporate Headquarters,CPCORP0,Investigatiión y desarrollo,es 
Corporate Headquarters,CPCORP0,Recherche et développement,fr 
Corporate Headquarters,CPCORP0,Human Ressources,en 
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Corporate Headquarters,CPCORP0,Recursos humanas,es 
Corporate Headquarters,CPCORP0,Ressources humaines,fr 
Corporate Headquarters,CPCORP0,Production,en 
Corporate Headquarters,CPCORP0,Producción,es 
Corporate Headquarters,CPCORP0,Production,fr 
Corporate Headquarters,CPCORP0,Finance,en 
Corporate Headquarters,CPCORP0,Finanzas,es 
Corporate Headquarters,CPCORP0,Finance,fr 
Corporate Headquarters,CPCORP0,Sales,en 
Corporate Headquarters,CPCORP0,Ventas,es 
Corporate Headquarters,CPCORP0,Ventes,fr

CSV Multilingual Field Support  

The Language Token
A specialized token that contains an instruction to apply on the column denition is added to a multilingual CSV column
header. It is used to support the addition of new languages by adding multilingual eld columns to an existing CSV le
without having to modify the corresponding load le.

To use the CSV multilingual eld support in TCC-TCB:

• The properties section of the CSV le MUST contain the "csv.multilingual=true" property. The property name is
case sensitive and MUST be lowercase.

• The CSV header MUST be present. It means that the load le MUST have "Header present" checked, and that
the rst row of the CSV input le data is the header.

• All the CSV le header names MUST match the column path or the column alias (header) specied in the load
le.

To add new multilingual eld columns, at least one column of this multilingual eld MUST already exist in the load le.
The new column header added to the CSV le MUST be placed after all the existing column headers dened in the load
le for that eld. It is not mandatory to put the new header right after the last existing header, it could be placed at the
end of the row.

To specify a locale, the token [locale=xx] MUST be used at the end of the header name (where xx is a specied locale for
example "fr"). The "locale" token is case sensitive and MUST be lowercase.

Example

Original CSV le:

 Identifier,"UserLoginname","Title","ManagerLoginname"
abc123,abc123,architect,manager123

CSV le with additional multilingual elds:

#BEGINPROPERTIES
csv.multilingual=true
....
#ENDPROPERTIES
Identifier,"UserLoginname","Title","Title [locale=fr]",
"Title [locale=es]","ManagerLoginname"
abc123,abc123,architect,architecte,arquitecto,manager123
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Note:The locale information is optional for the initial multilingual eld columns dened in the load le.

• When the locale is NOT specied in the CSV le, the locale information is retrieved from the load le.

• When the locale is specied in the CSV le and the "csv.multilingual=true" property is set, it always overrides
the locale information from the load le.

CSV le using specic locale:

#BEGINPROPERTIES
csv.multilingual=true
....
#ENDPROPERTIES
Identifier,"UserLoginname","Title [locale=fr]","ManagerLoginname"
abc123,abc123,architecte,manager123

Internal Load File
When TCC loads a set of additional multilingual columns, it creates an internal load le that matches the structure of the
CSV le. The aribute values for the new columns are copied from the rst multilingual column dened in the load le.
The locale token value sets the locale aribute value for each new column.

Original Load File

<load:column parameter="1" type="DATA" path="CorrespondenceEmail" ignoreEmpty="true" localeType="NONE"/>
<load:column parameter="1" type="DATA" path="Title" ignoreEmpty="true" localeType="DEFAULT"/>
<load:column parameter="1" path="Department,CostCenter" searchType="NONE" localeType="DEFAULT" type="DATA"/>

New CSV File

#BEGINPROPERTIES
csv.multilingual=true
#ENDPROPERTIES
CorrespondenceEmail,Title,"Title [locale=fr]",
"Department,CostCenter","Department,CostCenter [locale=fr]"
abc123@xyz.com,plumber,plombier,plumbing,plomberie

Internal Load File

<load:column parameter="1" type="DATA" path="CorrespondenceEmail" ignoreEmpty="true" localeType="NONE"/>
<load:column parameter="1" type="DATA" path="Title" ignoreEmpty="true" localeType="DEFAULT"/>
<load:column parameter="1" type="DATA" path=" Title" ignoreEmpty="true" localeType="SPECIFIC"
 localeValue="fr"/>
<load:column parameter="1" path="Department,CostCenter" searchType="NONE" localeType="DEFAULT" type="DATA"/>
<load:column parameter="1" path="Department,CostCenter" searchType="NONE" localeType="SPECIFIC"
 localeValue="fr" type="DATA"/>

Note that only the locale aributes are dierent for the new columns, all the others are the same.

UDF with Standard Name Export  
How to export a UDF that has the same name as a standard eld using TCC without any XML modication.

When a UDF and a standard eld share the same name, the standard eld is exported. If the UDF is a selection, you get
an error message when trying to export the description of the code.
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The workaround for this problem is adding "CustomField:" in the eld name.

For example, "Candidate,Prex" is a standard eld. To extract the UDF, you must use "Candidate,CustomField:Prex".

The same is true for a selection UDF, "Candidate,CustomField:Prex,Description".

Integration with RSOFFER module  
When a candidate selection workow includes the RSOFFER, there are various integration restrictions/limitations using
TCC.

The following tasks can be done using TCC:

• TCC can export draft oers and import them back using Oer number as key. Example would be to update
Salary, Pay Basis and Pay Frequency Basis.

• After few manual steps, TCC can export the "approval pending" data and import them back as "oer approved"
based on the approval list thats pre-dened.

The following tasks cannot be done using TCC:

• Cannot create a new oer record.

• Cannot use CSW MOVE operation to move from a step and status to another with in RSOFFER module.

• Cannot request for oer approval using TCC. It has to be a manual process.

Temporary File Compression  
The compression feature for temporary les is now activated by default. The compressed temporary les now have a
"zip"extension instead of a "tmp" extension.

This feature:

• Reduces the risk of reaching the 4 gigabyte maximum le size limitation due to the 32 bit JDK.

• Increases communication speed between each work-ow step.

• Saves disc space.

You can deactivate  the compression mode by adding the following parameter in your TaleoConnectClient.ini le
available under your TCC installation path.

-Dcom.taleo.integration.compress.tempfile=false(or FALSE)
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6  Net Change

Description  

Operation  
The Net Change operation extends the functionality of TCC by allowing the customer to reduce the amount of
transactions that are required to synchronize his system with the Taleo Enterprise application.

Purpose
The Net Change operation increases the update process eciency when it's impossible to send only the required
changes to a Taleo application, and the only alternative is to send all the data for a certain type of entity.

Net Change checks the data being sent, and removes all unchanged data from the transmission. This improves the
integration process by limiting the amount of data applied to the database and making it easier to respect the volume
limits.

Process
Net Change uses a at le proprietary database system to store the data that is equivalent to the target application (e.g.
Taleo Recruiting). The Net Change tables are created on an Entity by Entity basis on rst time use whether it be Net
Change Setup or ongoing run. This information is used to synchronize customer system and target application.

The customer's data must be provided in a standard TCC CSV le. The structure of this le must be created with the
TCC Import Wizard. The customer selects the entity on which to apply the Net Change process and builds the CSV le
structure by selecting the entity elds available in the entity data model. Standard Net Change templates are available.

The Net Change work-ow is dened in a standard TCC conguration le.

To start a Net Change process, the TCC execution mode (GUI or Command Line) must be invoked. The customer data
CSV le is retrieved and processed by Net Change. At this point, the customer data is compared to the Net Change
database and transactions are generated for all the dierences that are detected. The output of this computation is a T-
XML le containing all the transactions required to update the target application. The T-XML le is then wrapped in a
SOAP envelope and is sent to the target application.

TCC polls the target application for an import request completion, and retrieves the result document when it's ready.
The result processor output is a SOAP wrapped T-XML le that contains Net Change transaction status and aributes
for each entity processed. The T-XML output le is converted to a standard TCC CSV response document.

The Net Change Result Processor validates the answer for each transaction, and those successfully processed by the
target application are commied to the Net Change database. Transactions reported in error are not commied and will
be reprocessed on the next Net Change run. The entities are now synchronized in application and customer databases.

Master Slave Concept
When synchronizing customer and target application data with Net Change, the Master-Slave concept must always be
respected. The customer data is the Master and the modied data replicated to the target is the Slave. Modications
must always be done in the Master (CSV le). The modied data replicated to the target (Slave) with Net Change should
not be modied in any way.
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Certain business cases require that only some of the data be managed by Net Change in a Master-Slave relation, while
the target application manages other data known only to itself. Candidate entities give us a good example. There are
two types of candidates, external and internal. Internal candidates are managed by the customer system (master) and
the external candidates by the Taleo Enterprise system (slave). Only the internal candidates need to be synchronized
with the target application.

Recruiting Entities  

Candidate
• Create: Invokes entity merge operation.

• Update: Invokes entity update operation.

• Delete: Inactivate. Invokes entity update operation to set Internal Application to ‘N’ as specied in the CSV le.

• Recover: Reactivate. Invokes entity merge operation to set Internal Application to ‘Y’ as specied in the CSV le.

Department
• Create: Invokes entity merge operation.

• Update: Invokes entity update operation.

• Delete: Inactivate. Invokes the entity update operation to set the Department StateNumber to '1' (Inactive).

• Recover: Reactivate. Invokes entity merge operation to set the Department StateNumber to '0' (Active).

Department is a hierarchical entity.

Hierarchical entities require a complete Net Change Setup prior to regular usage of Net Change.

Hierarchical entities require that you select "Skip column if value is empty" for the parent column. Otherwise it will not
be possible to import the root element because its parent column will be empty.

Job Template
• Create: Invokes entity merge operation.

• Update: Invokes entity update operation.

• Delete: Inactivate. Invokes the entity update operation to set the Job Template State Number to '3' (Inactive).

• Recover: Reactivate. Invokes the entity merge operation to set the Job Template State Number to '1' (Active).

LUDS (UDSElement)
• Create: Invokes entity merge operation.

• Update: Invokes entity update operation.

• Delete: Inactivate. Invokes the entity update operation to set the UDS Element Active aribute to false (Inactive).

• Recover: Reactivate. Invokes the entity merge operation to set the UDS Element Active aribute to true (Active).

The LUDS (UDSElement) Net Change import le (load le), must have two columns dened on the same path to work
correctly.
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The rst column denes the User Dened Selection (UDS) that contains the UDS Element. This is required because the
key is UDS+UDS Element.

• The column contains "UserDenedSelection,Code".
Check “Use the value to search or lookup”.
Select UDSElement as Target.

The second column denes to which UDS the UDS Element belongs to.

• The column contains "UserDenedSelection,Code".
Check “Use the value to search or lookup”.
Select UserDenedSelection as Target.
Check “Start a new element in the collection”.
Select UserDenedSelection as Target.

SmartOrg Entities  

Employee
• Create: First invokes the recover operation then the merge operation. The Employee is created if it does not

exist, or updated if it exists.

• Update: Invokes entity merge operation.

• Delete: Invokes the delete operation that performs a soft delete of the Employee.

• Recover: First invokes the recover operation. Once the Employee is recovered, it invokes the merge operation to
update the Employee.

Employee is a hierarchical entity.

Hierarchical entities require a complete Net Change Setup prior to regular usage of Net Change.

Hierarchical entities require that you select "Skip column if value is empty" for the parent column. Otherwise it will not
be possible to import the root element because its parent column will be empty.

Group
• Create: Invokes entity merge operation.

• Update: Invokes entity update operation.

• Delete: Invokes entity delete operation.

• Recover: No recover on hard delete.

JobField
• Create: Invokes entity merge operation.

• Update: Invokes entity update operation.
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• Delete: Invokes entity delete operation.

• Recover: No recover on hard delete.

• Special Processing: Switches the zone into maintenance mode, if not already so, to perform create, update, and
delete operations.

JobField is a hierarchical entity.

Hierarchical entities require a complete Net Change Setup prior to regular usage of Net Change.

Hierarchical entities require that you select "Skip column if value is empty" for the parent column. Otherwise it will not
be possible to import the root element because its parent column will be empty.

Location
• Create: Invokes entity merge operation.

• Update: Invokes entity update operation.

• Delete: Invokes entity delete operation.

• Recover: No recover on hard delete.

• Special Processing: Switches the zone into maintenance mode, if not already so, to perform create, update, and
delete operations.

Location is a hierarchical entity.

Hierarchical entities require a complete Net Change Setup prior to regular usage of Net Change.

Hierarchical entities require that you select "Skip column if value is empty" for the parent column. Otherwise it will not
be possible to import the root element because its parent column will be empty.

Organization
• Create: Invokes entity merge operation.

• Update: Invokes entity update/move operation. Update can generate up to two transactions, one to update and
one to move. Update invokes entity update operation for changes in elds other than Parent eld. For changes
detected in Parent eld, Update invokes move operation to link Organization to dierent Parent.

• Delete: Invokes entity delete operation.

• Recover: No recover on hard delete.

• Special Processing: Switches the zone into maintenance mode, if not already so, to perform create, update, and
delete operations.

Organization is a hierarchical entity.

Hierarchical entities require a complete Net Change Setup prior to regular usage of Net Change.

Hierarchical entities require that you select "Skip column if value is empty" for the parent column. Otherwise it will not
be possible to import the root element because its parent column will be empty.

Position
• Create: Invokes entity merge operation.

• Update: Invokes entity update operation.

• Delete: Inactivate. Invokes entity update operation to set the Position Active aribute to false (Inactive).
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• Recover: Reactivate. Invokes entity merge operation to set the Position Active aribute to true (Active).

User
• Create: First invokes the recover operation then the merge operation. The User is created if it does not exist, or

updated if it exists.

• Update: Invokes entity update operation.

• Delete: Invokes entity delete operation that performs a soft delete of the User.

• Recover: First invokes the recover operation. Once the User is recovered, it invokes the merge operation to
update the User.

Creating a Net Change Integration  
1. Create a TCC import script.
2. Create the Base File that contains the complete data set for the specied columns in the import script.
3. Create a TCC Net Change Setup conguration le using the TCC import script.
4. Run the TCC script to perform the Net Change Setup.

This creates and populates the Net Change table locally on the computer where TCC is installed.

5. Create a TCC Net Change Computation conguration le using the same TCC import script.
6. Run the TCC script to perform the Net Change Computation.

This will update the Net Change table and the Taleo database.

Import Files  

CSV and Load Files  
Net Change requires an import denition load le and a CSV data le to function. These two les are used by Net
Change for both the Setup and Computation runs.

CSV File
Net Change expects a TCC CSV le as input. The le must contain all customer data for an entity. It is:

1. Used as a reference to create the Net Change database during Setup.
2. Compared to the Net Change database to detect any changes during Computation.

Load File Creation
Use the Import Wizard to create the Net change load le that will dene the CSV le structure.
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Select the net-change operation. This operation is only available for Net Change supported entities.

Column Import Options  

Entity Key Column
An entity must have a search key. A key can be composed of one or more elds. This key is used to retrieve
corresponding information in the Net Change database.

In the Behavior section, check “Use the value to search or lookup” and “Also set this value in the entity” to create a new
entity or to update an existing entity. If “Also set this value in the entity” is not checked for a create operation, certain
entity types will create records without a known key value, and it will then be impossible to search for these records to
update them afterwards. For other entity types, the records are not created and an error message is returned.
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Collections
Do not check “Reset the collection” and “Remove element from the collection”. The Net Change process is designed to
manage collection synchronization automatically.

Skip column if value is empty
To prevent the processing of elds where no value is provided, select Skip column if value is empty in the Behavior
section.

Hierarchical entities such as Organization, Location, JobField, and Department, where root elements do not have a value
in the parent column will be processed anyway.
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Collection handling

When using the Skip column if value is empty option on a collection, it is important to understand and apply the
following rules:

1. In the CSV le, the collection elements are not positional. Therefore it makes no sense to set the Skip column if
value is empty option only on some columns of the collection.

2. The Skip column if value is empty option applies to the entire collection. It does NOT apply to an individual
element of the collection.

3. A collection is empty when ALL its elements are empty.

Simple collection

A Candidate who has a collection of JobShifts.
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Let say that in the CSV le we support up to three JobShifts:

Candidate, EmailAddress JobShift 1. Code JobShift 2. Code JobShift 3. Code

cand_001@abc.com DayJob OnCall

Rule 1:

In the CSV le, the collection elements are not positional. Therefore it makes no sense to set Skip column if value is
empty only on some columns of the collection.

The following CSV le has exactly the same meaning as the one above:

Candidate, EmailAddress JobShift 1. Code JobShift 2. Code JobShift 3. Code

cand_001@abc.com OnCall DayJob

The point here is the DayJob value is not associated to the JobShift1.Code column. It is only an element of the JobShifts
collection. The Net Change engine will load all the elements of the collection and then it will compare them with the one
in its database.

Rule 2
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The Skip column if value is empty option applies to the entire collection. It does NOT apply to an individual element of
the collection.

First run:

Candidate, EmailAddress JobShift 1. Code JobShift 2. Code JobShift 3. Code

cand_001@abc.com DayJob OnCall

The engine will add the DayJob and OnCall job shift values in the JobShifts collection.

Second run:

Candidate, EmailAddress JobShift 1. Code JobShift 2. Code JobShift 3. Code

cand_001@abc.com DayJob

Even if the OnCall job shift is no longer in the collection (empty) the entire collection in itself is not empty. The Net
Change engine will generate a command to remove the OnCall job shift from the JobShifts collection.

Rule 3

A collection is empty when ALL its elements are empty.

The Skip column if value is empty option will be applicable only in the following scenario:

First run:

Candidate, EmailAddress JobShift 1. Code JobShift 2. Code JobShift 3. Code

cand_001@abc.com DayJob OnCall

DayJob and OnCall are added in the JobShifts collection.

Second run:

Candidate, EmailAddress JobShift 1. Code JobShift 2. Code JobShift 3. Code

cand_001@abc.com

When the Skip column if value is empty option is set of the JobShift1.Code, JobShift2.Code and JobShift3.Code columns,
then the empty values are ignored (skipped).

Complex collection
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Let say that in the CSV le we support two Studies:

Candidate. EmailAddress Study1. Display Sequence Study1. Institution.
Description

Study2. Display Sequence Study2. Institution.
Description

cand_001@abc.com 1 College A 2 University Z

Rule 1

In the CSV le, the collection elements are not positional. Therefore it makes no sense to set Skip column if value is
empty only on some columns of the collection.

The following CSV le as exactly the same meaning as the one above:
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Candidate. EmailAddress Study1. Display Sequence Study1. Institution.
Description

Study2. Display Sequence Study2. Institution.
Description

cand_001@abc.com 2 University Z 1 College A

Rule 2

The Skip column if value is empty option applies to the entire collection. It does NOT apply to an individual element of
the collection.

First run:

Candidate. EmailAddress Study1. Display Sequence Study1. Institution.
Description

Study2. Display Sequence Study2. Institution.
Description

cand_001@abc.com 1 College A 2 University Z

The engine will add the 1, College A and 2, University Z study to the Studies collection.

Second run:

Candidate. EmailAddress Study1. Display Sequence Study1. Institution.
Description

Study2. Display Sequence Study2. Institution.
Description

cand_001@abc.com 1 College A

Even if the 2 - University Z values are no longer in the collection (empty) the entire collection in itself is not empty. The
Net Change engine will generate a command to remove the 2 – University Z study element from the Studies collection.

Rule 3

A collection is empty when ALL its elements are empty.

With the following collection, the Skip column if value is empty option will be applicable only in the following scenario:

First run:

Candidate. EmailAddress Study1. Display Sequence Study1. Institution.
Description

Study2. Display Sequence Study2. Institution.
Description

cand_001@abc.com 1 College A 2 University Z

1, College A and 2, University Z are added to the candidate Studies collection.

Second run:

Candidate. EmailAddress Study1. Display Sequence Study1. Institution.
Description

Study2. Display Sequence Study2. Institution.
Description

cand_001@abc.com
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If the Skip column if value is empty option is set on ALL the columns of the Studies collection (Study1.DisplaySequence,
Study1.Institution.Description, Study2.DisplaySequence and Study2.Institution.Description), then the empty values are
ignored (skipped).

The following collection is not considered to be empty:

Candidate. EmailAddress Study1. Display Sequence Study1. Institution.
Description

Study2. Display Sequence Study2. Institution.
Description

cand_001@abc.com 1

Note: If you set the "Skip column if value is empty" option to only one element of the collection, the Net Change engine
will automatically set it on the other elements of the collection. So take the good habit of seing that option on all the
elements of the collection the same way.

Ignore Column
When the customer system has a column that is known and used only by itself. An ignore column that is never
processed can be specied. To dene, click Add buon, select “Add an ignore column”, and click OK.

Default Column Value
A default value can be specied for columns that have no value set in the customer CSV le. For example, to use English
as default value for eld User.CorrespondenceLanguage, set the default value to “en” in the column advanced options:

Note that “Default Column Value” processing is not executed when “Skip column if value empty” is checked.
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Non-Updatable Column
Some eld values only need to be sent to the target application once, usually during the create operation. Once the
column is dened as Non-Updatable, the eld values contained in that column are not sent to the target application in
an update operation.

This advanced option is Net Change specic. No other TCC functionality uses it. Set updatable value to false in the
column advanced options:
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When all columns are dened, save the input le and generate the CSV le.

Net Change Partial Load  
The Net Change partial load processing instruction limits the extraction of collection type relation items to those
specied in the customer data le during Net Change Setup. This subset of relation items is used to populate the Net
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Change database. This allows customers to work with partial collection data sets without creating deletes in their zone
with ongoing Net Change runs.

• netchange.load.partial

Possible values are true (case-insensitive) or false. Anything other than true is considered false.

Seing this processing instruction on a eld rather than on a relation has no eect.

Multiple Parameter Entities  
The User, Organization, Location, and JobField entity import services have more than one parameter.

During Net Change CSV load le creation, it is mandatory that every available parameter of the service be included in
the le. Not doing so will cause Net Change to fail.

The User import service exposes three parameters:

1. User
2. Password
3. ForceChangePassword

You must include the Password and ForceChangePassword simple parameters, and at least one eld from the User
entity parameter in the CSV le.

The Organization, Location, and JobField import services expose two parameters:

1. Organization, Location, or JobField
2. Sequence

You must include the Sequence simple parameter, and at least one eld from the Organization, Location, or JobField
entity parameter in the CSV le.

In the Behavior section check “Skip column if empty” for the columns that might not contain a value.
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Hierarchical Trees  
Net Change must apply a set of special processing rules to entities that are part of a hierarchical tree. For example,
before deleting a parent node, all of its children must have been deleted. Net Change recreates the entire hierarchical
tree to correctly sequence the order of operations required to synchronize the target application.

Hierarchical Entities:

• Department

• Employee

• JobField

• Location

• Organization

There are two modes for hierarchical entities, full and partial. The full mode allows only a single root element, while the
partial mode allows multiple root elements. By default the mode is full for hierarchical entities. The Employee entity can
be full or partial.

The customer input CSV le must contain the entire data set of the hierarchical tree. The rst line of the CSV le
must be the root element, and will have no parent. In the Parent column, make sure “Skip column if value is empty” is
checked. For partial mode, the root elements must precede their children in the CSV le. See partial example below.

Full

"Code(Child)","Parent,Code","Description",... 
"-1",,"Organization",... 
"DIV-A","-1","Division A",... 
"DIV-B","-1","Division B",... 
"T1","DIV-A","Team 1",... 
"T2","DIV-A","Team 2",... 
"T3","DIV-B","Team 3",...

Partial

"Code(Child)","Parent,Code","Description",... 
"-1",,"Boss",... 
"MNG-A","-1","Manager A",... 
"E1","MNG-A","Employee 1",... 
"E2","MNG-A","Employee 2",... 
"MNG-B",,"Manager B",... 
"E3","MNG-B","Employee 3",...

Errors
Hierarchical entities must be handled properly to prevent errors. The three main causes that generate errors using Net
Change with hierarchical entities (HE) are:

1. Using a parent relation that doesn't exist.

Each time you create an HE that refers to a parent that doesn't exist in Monarch, you will get this kind of error.

Monarch Functional Error: The parent node associated to this key has not been found: …
2. Working with a partial “tree”.
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Each time you create an HE that refers to a parent that doesn't exist in partial “tree” but exists in Monarch, you
will get this kind of error.

Monarch Functional Error: The parent node associated to this key has not been found: …
3. Transactions done directly in the Monarch application.

a. We can generate an invalid structure in “Net Change database ” and destroy the “Net Change process”
when we are doing modication in the UI of Monarch (Element in Green) while doing Net Change with
TCC.

If we do a “Net Change Setup” action using an existing element ( in Monarch, Element J) that is not
directly linked to an element of the partial “tree” (used in “Net Change”), the “tree” is not valid anymore.

b. If we do a “Net Change Setup” action using an existing element (in Monarch, Element E) that is directly
link to an element of the partial “tree” (used in the “Net Change”), the “tree” is valid and it's possible to do
Net Change if we do a “Setup” rst and then a “Computation”.

Examples:

• Case-1: Do Net Change Computation only (Move “Element J” under “Element B”).

Monarch Functional Error: …You cannot update the following eld: BaseComposite.Parent.

Note that the eld value and the supplied value don't match (as described in 3-a).

• Case-2: Do Net Change Setup & Computation (Move “Element J” under “Element B”).

◦ Setup runs with success.

◦ Computation TCC WorkFlow Error: The parent node associated to this key has not been found …. (as
described in 3-a).

• Case-3: Do Net Change Computation only (Move “Element E” under “Element B”).

Monarch Functional Error: …You cannot update the following eld: BaseComposite.Parent.

138



Talent Acquisition Cloud
Using Connect Client

Chapter 6
Net Change

Note that the eld value and the supplied value don't match (as described on 3-b).

• Case-4: Do Net Change Setup & Computation (Move “Element E” under “Element B”).

◦ Setup runs with success.

◦ Computation runs with success (as described on 3-b).

The Partial hierarchical entity “Employee” is not impacted by the behavior described above. When doing Net Change
with an Employee, you can get an empty parent or a parent that is not present in your Net Change Database.

We recommend that you always work with a full structure and respect the “Mater-Slave” concept when doing your Net
Change otherwise you can end up with a Employee structure that does not represent your company.

CSV File Properties  
Special header properties can be added to customize Net Change processing behavior. They are placed at the beginning
of the CSV le.

CSV Properties section:

#BEGINPROPERTIES
PropertyName=PropertyValue
#ENDPROPERTIES

CSVLineCount
This property indicates to Net Change the number of data rows in the request CSV le (excluding the column header
row). A mismatch is considered an error.

Example:

#BEGINPROPERTIES
CSVLineCount=2
#ENDPROPERTIES
ColumnHeader1,ColumnHeader2,ColumnHeader3
Line1_CH1_Data,Line1_CH2_Data,Line1_CH3_Data
Line2_CH1_Data,Line2_CH2_Data,Line2_CH3_Data

Import File Modication  
Net Change import le modication may or may not have any impact on Net Change. Here are the possible cases:

Entity Search Key Modication
If the dened entity search key must be changed after the rst Net Change run, the Net Change database for this entity
must be recreated. This can be achieved using the Net Change Setup feature.

Adding a new column
Net Change sees the new column as a new entity eld.

139



Talent Acquisition Cloud
Using Connect Client

Chapter 6
Net Change

When “Skip column if value is empty” is NOT checked, an update is generated for every record.

When “Skip column if value is empty” is checked, an update is only generated for records that have a value for the new
column.

Note that only the elds that are detected as changed are sent to the target application.

Removal of a column
If a column is removed, the data associated to this column is no longer part of the Net Change computation process and
no actions/updates are sent to the zone.

Changing the column from Updatable to Non-Updatable
The next Net Change computation does not take into account the value of this column for an update operation.

Conguration Files  

Setup and Computation Conguration Files  
Net Change requires a Setup and a Computation conguration le for each individual integration point. The Setup
conguration le is used to create and populate the Net Change database. The Computation conguration le is used
for Net Change ongoing runs. The dierences between the les are found in the pre and post processing steps.

Conguration File Creation
Use the Conguration Wizard to create the Net change conguration le.

Select Based on another type of request message and the product for that integration point.

All communications with the target application use T-SOAP.

Select T-SOAP in the message type selection window.

Select Endpoint to authenticate yourself to the target application.

General Tab
Net Change requires that both the request and response les be of CSV type.

Pre-processing Steps  

Setup
Add a Net Change Setup custom step.

Select the load le to use as import le for this integration. This is the same le as the one used for Computation.

Add a Wrap SOAP step
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Select Import in the Action panel.

Computation
Add a Net Change Computation custom step.

Select the load le to use as import le for this integration. This is the same le as the one used for Setup.

Thresholds

You can dene thresholds, to limit the number of actions that Net Change applies to the target application. For example,
in normal operation mode, the generation of delete actions deleting almost all of the target application database should
be considered as an erroneous situation and should be prevented.

The threshold can be dened as a percentage or a number of records. For example a value of 25% stops the Net Change
computation and process if more that 250 records out of a 1000 are generating Net Change actions.

An absolute value can be specied that will stop the Net Change computation and process as soon as the number of
actions is reached. The number of record in the le has no inuence on this threshold. A le of 50 records or 1000
records will stop after 25 processed records.

To disable the threshold, set the value to -1.

A threshold must be dened for each Net Change action: Create, Update and Delete. Recommended values for
thresholds are as follow:

• Threshold for element creation: 10%

• Threshold for element update: 10%

• Threshold for element deletion: 10%

Add a Wrap SOAP step

Select Import in the Action panel.

Post-processing Steps  

Setup
Add a Net Change Result Processor custom step.

Report Filtering

Filters are available to control the output of the Net Change result le:

• All: Detailed status of all actions are reported.

• Error only: Detailed status of failed actions are reported.

• Error and warning only: Detailed status of actions that have generated an error or a warning message are
reported.

When performing a Net Change Setup, this step generates a simple XML report that indicates how many entities have
been processed during the operation. Since a Net Change Setup does not import any data into the product, there are no
entity results in this report.
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Add a Net Change Result Processor custom step.

This step is optional for Net Change Setup. It transforms the le generated by the Net Change Result Processor into a
standard TCC CSV le.

Select the load le to use as import le for this integration. This is the same le as the one used for Computation.

Select the Output properties check box to include the CSV le properties in the result le.

Property Description Example

CSVLineCount
 

Number of data rows present in the CSV result
le (excluding the column header row). In the
case of an Net Change Setup process, this value
will always be 0.

CSVLineCount=0
 

total.[entity]
 

Total number of entities processed. If no
entities are processed by the target application,
 this property is not included.

total.jobeld=96
 

duration
 

Time taken by target application to process
entire import le generated by Net Change
engine. In the case of an Net Change Setup, no
entities are imported in the customer zone, the
duration should be close to 0.

duration=0:00:00.106
 

CSV Result File Format
The le generated by Net Change Result Transformation has the following format (Note that if in the conguration
general tab you have specied to not output the column header, then no header will be included in the result CSV le):

#BEGINPROPERTIES
PropertyName=PropertyValue
#ENDPROPERTIES
"Index","Identifier","Status","TransactionType","Result","Message"

CSV Result File Description

Net Change Setup processing does not generate any rows in the CSV le since no imports are done on the customer
zone.

Computation
Add a Net Change Result Processor custom step.

Report Filtering

Filters are available to control the output of the Net Change result le:

• All: Detailed status of all actions are reported.

• Error only: Detailed status of failed actions are reported.

• Error and warning only: Detailed status of actions that have generated an error or a warning message are
reported.

This step processes the target application result le to update the local Net Change reference database in order to
reect the state of the target application.
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For each record, if the transaction was successfully processed, then the local Net Change reference database is updated
with the new value. If the record was not successfully processed, the Net Change reference database is not updated.

Add a Net Change Result Processor custom step.

This step transforms the le generated by the Net Change Result Processor into a standard TCC CSV le.

Select the load le to use as import le for this integration. This is the same le as the one used for Computation.

Select the Output properties check box to include the CSV le properties in the result le.

Property Description Example

CSVLineCount
 

Number of data rows present in the CSV result
le (excluding the column header row).

CSVLineCount=96
 

total.[entity]
 

Total number of entities processed.
If no entities are processed by the target
application, this property is not included.
 

total.jobeld=96
 

total.[entity].create
 

Total number of entities created.
If no entities are created, this property is not
included.
 

total.jobeld.create=48
 

total.[entity].update
 

Total number of entities that are updated.
If no entities are updated, this property is not
included.
 

total.jobeld.update=10
 

total.[entity].delete
 

Total number of entities that are deleted.
If no entities are deleted, this property is not
included.
 

total.jobeld.delete=10
 

total.status.success
 

Number of entities that are processed with
success by the target application.
If no success has been detected, this property is
included with a value of 0.
 

total.status.success=30
 

total.status.error
 

Number of entities reported in error at the
target application.
If no error is reported, this property is included
with a value of 0.
 

total.status.error=48
 

total.warning
 

Number of warning messages generated by the
target application.
If no warning is generated, this property is
included with a value of 0.
 

total.warning=18
 

duration
 

Time taken by target application to process
entire import le generated by Net Change
engine.

duration=0:00:03.2890
 

CSV Result File Format
The le generated by Net Change Result Transformation has the following format (Note that if in the conguration
general tab you have specied to not output the column header, then no header will be included in the result CSV le):
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#BEGINPROPERTIES
PropertyName=PropertyValue
#ENDPROPERTIES
"Index","Identifier","Status","TransactionType","Result","Message"

Column Name Description

Index
 

Row sequential number
 

Identier
 

Unique key name used Net Change to identify the entity. This key is composed of the following sub
sections:
Entity Name|Net Change Action|Entity Search Key Id
 
Example:
 
JobTemplate|create|NC2_00791130771
 

Status
 

Net Change Result Status for the entity. Indicates whether Net Change operation completed with
success or error.
The possible values are:
 

• success

• error

TransactionType
 

Target application transaction type to perform Net Change action.
For example, if an update has been detected for the job template entity, the transaction type will be
“jobtemplate.update”.
 
Note that the action done on the target application might be dierent than the Net Change action. For
example, in the case of inactivation when a Net Change delete action is detected, an update operation
is required. In this case the Net Change Action will be delete and the transaction type will be update.
 

Result
 

Not used for now.
 

Message
 

Detailed message about the error or the warning returned by the target application.

Using Net Change  

Hierarchical Entities Setup  
Special care must be taken with hierarchical entities during Net Change Setup. You must make sure to respect the
hierarchical structure in order to maintain consistency.
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Extract Net Change Setup Data

Net Change Setup extracts from the target application data matching the data keys present in the customer CSV le
and lls the Net Change database. Other data, not specied in the CSV le that exist in the target application is not
downloaded to the Net Change database.
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After Net Change Setup

After a Net Change Setup, a standard Net Change process can be started to synchronize customer data with the target
application. Data that is the same does not generate Net Change transactions. Dierent data generates transactions,
customer data that does not exist in the target application generates a create transaction.

First Net Change
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Final Result

Invalid Requests
Missing Root

Missing Element
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Dierent Structures
Prior to Net Change Setup

The Net Change Setup of the Net Change database is performed with the keys provided in the Customer input le. The
Net Change Setup will fail to create a valid hierarchical structure if the Customer and Taleo structures do not match.

Net Change Setup Data Extraction
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User Entity Constraints  
During User Net Change Setup, it is impossible to extract the values for the Password and ForceChangePassword
parameters. Therefore, the Net change database is not perfectly synchronized with the Taleo zone.

The User Password and ForceChangePassword parameters require special treatment during rst Net Change. Protecting
or overwriting the values for those parameters in the Taleo zone determines the treatment to apply.

Protect Values

To protect a password that has already been modied by the user, specify the columns corresponding to the Password
and ForceChangePassword parameters as non-updatable. In the advanced options section, enter updatable for the
name and false for the value.

Overwrite Values

To overwrite the Password and ForceChangePassword parameter values in the Taleo zone, set the updatable value to
true in the advanced options section. This is the default value for the option, therefore it does not need to be specied.
During Net change rst run all values will be overwrien and the databases will be synchronized.
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Setup Usage  
The Net Change Setup feature must be used in the implementation phase to ll the Net Change database with target
application data.

It can also be used to resynchronize the Net Change database with the target application data. This should be done only
in exceptional cases.

It must also be used when the entity key changes. The Net Change tables need to be recreated.

Note that only the Net Change tables for the entity being processed will be deleted at the start of the Net Change Setup
process.

Also note that no backup is made before erasing the tables.

Known Limitations  
The following limitations must be taken into account when implementing a solution that uses Net Change.

Entity Delete Mode Selection
The delete mode is currently dened in the entity Net Change denition le (feature pack). Only one delete mode is
dened. The actual solution does not support the selection of dierent delete modes per conguration.

Aachment File Support
Aachment les are not supported by Net Change.

Entity Key Modication
If you change a dened entity key after the rst Net Change run, the Net Change database for this entity must be
recreated. Use the Net Change Setup feature to recreate Net Change database.

storage.properties File Modication
The storage.properties le parameters determine how Net Change stores data in its reference database. The properties
than can be set are data compression and encryption, repository location, storage unit interface, and block size.

The values dened in the storage.properties le (UseCompression, EncryptionMode, StorageUnitImplementation, and
FileStorageUnit.DefaultBlockSize) must not be changed after the rst Net Change run.

If this is required, ALL Net Change database tables must be recreated. Perform an Net Change Setup on every entity
subject to a Net Change process.

Multiple Database Synchronization
Net Change maintains a single database to synchronize a customer system data and a Taleo Product data. This implies
installing and running a separate instance of TCC for each customer system synchronizing with a Taleo product.
For example, synchronizing three dierent Human Resource Information System (HRIS) databases with one Taleo
zone means installing and running three separate instances on TCC. The data provided for synchronization by each
HRIS must be mutually exclusive to prevent reversal of operations. For example, if one system deletes an entity on
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an ongoing integration and the same entity exists on another system, it will be recreated when that system runs its
integration.

The same principle applies to synchronizing customer HRIS data with several Taleo zones. For example, synchronizing
one customer HRIS with a Taleo production zone and a Taleo staging zone requires installing and running two separate
instances of TCC.

Net Change Conguration  
The TCC Net Change plug-in uses a conguration le to dene properties related to its database. The le name is
storage.properties

Properties
• UseCompression:

Determines the compression or not of stored Net Change data. This property is set to true in the default
conguration le, the data is compressed. If the property is removed from the conguration le, the value will
default to false, the data will not be compressed.

• EncryptionMode:

Determines the type of encryption to apply on Net Change data. This property is set to 2 in the default
conguration le.

0=No encryption

1=Custom TCC internal encryption

2=AES 128-bit ciphers

• RepositoryLocation:

Determines Net Change data les repository location. This property is empty in the default conguration le.
The default location is [TCCInstallFolder]/system/repository. If the property is absent or empty the default
location is used.

• StorageUnitImplementation:

Advanced property, modify only as instructed by Taleo.

Determines Storage Unit interface implementation. The default value is
com.taleo.integration.storage.FileStorageUnitand is the only value supported at this time.

• FileStorageUnit.DefaultBlockSize:

Advanced property, modify only as instructed by Taleo.

Determines le storage block size in KB (min. 1, max. 128). This property is set to 1 in the default conguration
le. If the value is not specied or invalid, the value will default to 2.

Overriding a plug-in conguration location
There are two ways to specify the location of plug-in conguration les:
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Default:

• By default, the plug-in conguration le location is:
[PLUGIN_FOLDER]\[PLUGIN_COLLECTION_NAME]\conguration.

• Nothing special needs to be setup.

• E.g.: The le “storage.properties” will be located at “c:\Program Files\Taleo Connect Client\extensions\plugins
\tcc-netchange\storage.properties”

Root conguration folder:

• To change the location of plug-in conguration le for every plug-in at the same time.

• System Property: “com.taleo.integration.client.extensions.plugins.conguration.dir”.

• E.g: com.taleo.integration.client.extensions.plugins.conguration.dir=c:\PluginCong.The le
“storage.properties” will be located at: c:\PluginCong\tcc-netchange\storage.properties.
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7  Templates

Best Practice Templates  
Best practice templates are included with TCC to give customers the foundations on which to build standard integration
points.

Net Change
Net Change is used whenever possible for imports to Taleo zone. It reduces the possibility of errors by detecting
the proper operation to apply according to its reference database. Use of Net Change also reduces the number of
transactions making it easier to respect the zone volume limits.

Custom Fields
Custom eld place holders are included in the templates. Make sure to synchronize the custom elds to update the data
dictionary with user dened elds found in the Taleo product. You will then be able to replace the place holders with the
required custom elds in the various integration points.

Candidate Standard Net Change  
The candidate standard net change synchronizes the candidate data with the Taleo product.

• Identier

Use the same value as the Username or Email. This value will come back in the results le and facilitate
reconciliation of the results.

• UserName

This eld is mandatory and must be unique. It is used as the primary key targeting the Candidate entity.

• Password

When no password is provided, a default password is generated.

• Language

This eld is mandatory.

• Location

Geographic location where the candidate resides.

Valid Location Code.

Must exist in Taleo Location Table.

• LocationInterest
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Locations where the candidate has expressed an interest to get a job.
Required to populate EEO / EE elds. Must contain code from Location table to represent US or Canada if EEO/
EE elds are populated.
A candidate can have multiple locations of interest. Multiple locations of interest can be imported by adding as
many locations of interest columns as necessary in TCC to cover the maximum a candidate can have according
to your data.

• CA/USA EE Question
Remove country elds that do not apply.
Valid Question Number.
Must exist in Taleo Question Table.

• CA/USA EE Answer
Remove country elds that do not apply.
Valid Answer Number.
Must exist in Taleo Answer Table.

• ContestNumber-1
Search Target set to PreselectionApplication.

• ContestNumber-1
This eld is mandatory. The same information as ContestNumber-1 eld above must be sent a second time with
Net Change.
Search Target set to Requisition.

• ProleStudyDisplaySequence-1
This eld is mandatory when importing collections of studies.

• ProleStudyInstitution-1
Valid CieInstitution Number.
Must exist in Taleo CieInstitution Table.

• ProleStudySubjectMajor-1
Valid CieProgram Description.
Must exist in Taleo CieProgram Table.

• ProleStudyDegree-1
Valid StudyLevel Number.
Must exist in Taleo StudyLevel Table.

• ProleExperienceDisplaySequence-1
This eld is mandatory when importing collections of experiences.
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• CustomFieldName

Custom elds can be mandatory or optional depending on their seings.

Candidate Standard Export  
The Candidate Standard Export uses the Candidate entity as the root entity to extract internal candidate information
from the Taleo product.

Projections
All of the data is extracted as basic eld projections.

Filters
• Last Run Date

InclusiveLastModiedDate is used as reference for last run date.

• InternalApplication

The eld value is compared to the value true for equality.

Department Standard Net Change  
The department standard net change synchronizes the department data with the Taleo product.

• Identier

Use the same value as the Department number. This value will come back in the results le and facilitate
reconciliation of the results.

• DepartmentNumber

This eld is mandatory and must be unique. It is used as the primary key targeting the Department entity.

• DepartmentName-EN

This eld is mandatory. Add one column for each language in which the Department Name will be imported.
One column must be provided for each and every language supported by the application.

• CostCenter

For customer reference; not used by Taleo. Add one column for each language in which the CostCenter will be
imported. One column must be provided for each and every language supported by the application.

• HiringManager

Valid Username for the Hiring Manager.

Must exist in Taleo User Table.
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• CieLocation
Valid Location Code.
Must exist in Taleo Location Table.

• Organization
Valid Organization Code.
Must exist in Taleo Organization Table.

• ParentNumber
Valid Department number.
Must exist in Taleo Department Table.

• PayFactor
For customer reference; not used by Taleo

• Recruiter
Valid Username for the Recruiter.
Must exist in Taleo User Table.

• State,Number
This eld is mandatory.

• DepartmentInformation,CustomFieldName
Custom elds can be mandatory or optional depending on their seings.

JobField Standard Net Change  
The JobField standard net change synchronizes the JobField data with the Taleo product.

• Identier
Use the same value as the JobFieldCode. This value will come back in the results le and facilitate reconciliation
of the results.

• JobFieldCode
This eld is mandatory and must be unique. It is used as the primary key targeting the JobField entity.

• ParentCode
Valid JobFieldCode.
Must exist in Taleo JobField Table.

• Name-en
This eld is mandatory. Add one column for each language in which the JobField Name will be imported. One
column must be provided for each and every language supported by the application.
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• NetworkJobField

This eld is mandatory and must be a valid NetworkJobField Number.

• Status

This eld is mandatory. 1-Active, 2-Draft (default), 3-Inactive, 4-Stored

• Sequence

This eld is mandatory. It sets the order of appearance of records in the application.

JobTemplate Standard Net Change  
The JobTemplate standard net change synchronizes the JobTemplate data with the Taleo product.

• Identier

Use the same value as the JobCode. This value will come back in the results le and facilitate reconciliation of
the results.

• Creator

This eld is mandatory and must be a valid User (Creator) Loginname.

• JobCode

This eld is mandatory and must be unique. It is used as the primary key targeting the JobTemplate entity.

• Title-EN

This eld is mandatory. Add one column for each language in which the JobTemplate Title will be imported.
One column must be provided for each and every language supported by the application.

• Organization

Valid Organization Code.

Must exist in Taleo Organization Table.

• PrimaryLocation

Valid Location Code.

Mandatory if EEO Job Category is populated.

Must identify USA or Canada for EEO.

• JobField

Valid JobField code.

• EEOJobCategory

Used for either EEO Job Category OR client custom EEO Job Groups

1=Ocials & Managers; 2=Professionals; 3=Technicians; 4=Sales Workers; 5=Oce/Clerical; 6=Craft Workers;
7=Operatives; 8=Laborers; 9=Service Workers.
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Other EEO Job Categories values can be congured and available if the EEO Job Group Number is enabled.

• EmployeeStatus

1=Regular; 3=Contractual; 4=Temporary; 5=Limited Term.

• JobLevel

1-Entry Level, 2-Individual Contributor, 3-Team leader, 4-Manager, 5-Director, 6-Executive, 7-Manager with
direct Reports, 8-Manager without Direct reports 9-Senior Executive.

• JobSchedule

1-Full-time, 2-Part-time, 3-Work-sharing, 4-Per Diem, 5-Contingent.

• JobShift

1-Day Job, 2-Evening Job, 3-Night Job, 4-On Call, 5-Variable, 6-Flex Time, 7-Weekend, 8-Rotating.

• JobType

1-Standard, 2-Internship, 3-Cooperative, 4-Summer Job, 5-Graduate Job, 6-Temporary Work, 7-Experienced.

• OvertimeStatus

1-Exempt, 2-Non-exempt.

• PayFrequencyBasis

1-Yearly, 2-Weekly, 3-Hourly, 4-Biweekly, 5-Semimonthly, 6-Monthly, 7-Total, 8-Daily.

• StudyLevel

1-None, 2-High School Diploma/GED, 3-Technical Diploma, 4-Associate's Degree/College Diploma, 5-Non-
Degree Program, 6-Bachelor's Degree, 7-Master's Degree, 8-Doctorate Degree, 9-Higher Degree, 10-Other.

• WillTravel

1-No, 2-Yes, 25% of the Time, 3-Yes, 50% of the Time, 4-Yes, 75% of the Time, 5-Yes, 100% of the Time, 6-Yes,
5% of the Time, 7-Yes, 10% of the Time, 8-Yes, 15% of the Time, 9-Yes, 20% of the Time

• DescriptionInternal-EN/DescriptionExternal-EN

1333 for multi-byte or 4000 for single byte. Add one column for each language in which the Descriptions will be
imported. One column must be provided for each and every language supported by the application.

• QualInternal-EN/QualExternal-EN

1333 for multi-byte or 4000 for single byte. Add one column for each language in which the Qualications will
be imported. One column must be provided for each and every language supported by the application.

• UserGroup

Valid UserGroup CustomerCode.

• RequisitionType

Possible values are 1=Professional (default); 2=Hourly; 3=Campus; 4= Contingent; 5=Executives

• Status

Possible values are 1=Active (default); 2=Draft; 3=Inactive
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• CustomFieldName

Custom elds can be mandatory or optional depending on their seings.

Location Standard Net Change  
The Location standard net change synchronizes the Location data with the Taleo product.

• Identier

Use the same value as the LocationCode. This value will come back in the results le and facilitate reconciliation
of the results.

• LocationCode

This eld is mandatory and must be unique. It is used as the primary key targeting the Location entity.

• ParentCode

Valid Location Code.

Must exist in Taleo Location Table.

• Name-en

This eld is mandatory. Add one column for each language in which the Location Name will be imported. One
column must be provided for each and every language supported by the application.

• NetworkLocation

This eld is mandatory and must be a valid NetworkLocation Number.

• Status

This eld is mandatory. 1-Active, 2-Draft (default), 3-Inactive, 4-Stored

• Sequence

This eld is mandatory. It sets the order of appearance of records in the application.

LUDS Standard Net Change  
The LUDS standard net change synchronizes the UDS Element data with the Taleo product.

• Identier

Use the same value as LUDSCode. This value will come back in the results le and facilitate reconciliation of the
results.

• LUDSCode

This eld is mandatory and must be unique. It is used as the primary key targeting the UDSElement entity.

• UDSCode
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This eld is mandatory and must be unique. It is used as the primary key targeting the UDSElement entity.

• CustomerCode

This eld is mandatory. It targets UserDenedSelection entity.

• Active

This eld is mandatory.

• Sequence

This eld is mandatory for new records. Normally defaulted to the same value in all records, it is used to set
order of appearance of records in the LUDS.

• Description-EN

This eld is mandatory for new records. Add one column for each language in which the Description will be
imported. One column must be provided for each and every language supported by the application.

• Organization

Valid Organization Code.

Must exist in Taleo Organization Table.

• Location

Valid Location Code.

Must exist in Taleo Location Table.

• JobField

Valid JobField Code.

Must exist in Taleo JobField Table.

• Complete

Optional eld, it is strongly recommended to set the value to "true" otherwise the LUDS will appear as
incomplete in the interface.

Organization Standard Net Change  
The Organization standard net change synchronizes the Organization data with the Taleo product.

• Identier

Use the same value as the OrganizationCode. This value will come back in the results le and facilitate
reconciliation of the results.

• OrganizationCode

This eld is mandatory and must be unique. It is used as the primary key targeting the Organization entity.

• ParentCode
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Valid OrganizationCode.

Must exist in Taleo Organization Table.

• Name-en

This eld is mandatory. Add one column for each language in which the Organization Name will be imported.
One column must be provided for each and every language supported by the application.

• Industry

This eld is mandatory and must be a valid Industry Number.

• Status

This eld is mandatory. 1-Active, 2-Draft (default), 3-Inactive, 4-Stored

• Sequence

This eld is mandatory. It sets the order of appearance of records in the application.

Position Standard Net Change  
The Position standard net change synchronizes the Position data with the Taleo product.

• Identier

Use the same value as the PositionID. This value will come back in the results le and facilitate reconciliation of
the results.

• DepartmentNumber

This eld is mandatory and must be a valid DepartmentNumber.

• HiringManager

This eld is mandatory and must be a valid User Loginname.

• JobCode

This eld is mandatory and must be a valid JobCode.

• PositionID

This eld is mandatory and must be unique. It is used as the primary key targeting the Position entity.

Requisition Standard Merge  
The requisition standard merge creates the requisition record if it does not exist or updates the record if it does exist.

• Identier
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Use the same value as ContestNumber. This value will come back in the results le and facilitate reconciliation
of the results.

• ContestNumber

Requisition Number.

This eld is optional, if no ContestNumber is provided, one will be automatically assigned based on AWT
seings.

• HiringManager

Requisition hiring manager.

This eld is optional if JobStatus=1 (Draft).

This eld is mandatory if JobStatus=3 (Approved).

• Owner

Requisition recruiter.

This eld is mandatory.

• Language

This eld is optional.

• JobState

This eld is optional, 1=Draft (default), 3=Approved.

• CitizenshipStatus

1=Not Applicable, 2=Must Be a Citizen, 3=H1B Visa Accepted, 4=Other Visa Accepted.

• EmployeeStatus

1=Regular, 3=Contractual, 4=Temporary, 5=Limited Term.

• JobLevel

1-Entry Level, 2-Individual Contributor, 3-Team leader, 4-Manager, 5-Director, 6-Executive, 7-Manager with
direct Reports, 8-Manager without Direct reports 9-Senior Executive.

• JobSchedule

1-Full-time, 2-Part-time, 3-Work-sharing, 4-Per Diem, 5-Contingent.

• JobShift

1-Day Job, 2-Evening Job, 3-Night Job, 4-On Call, 5-Variable, 6-Flex Time, 7-Weekend, 8-Rotating.

• JobType

1-Standard, 2-Internship, 3-Cooperative, 4-Summer Job, 5-Graduate Job, 6-Temporary Work, 7-Experienced.

• Justication

1=New Position, 2=Replacement, 3=Modication, 4=Extemsion.

• OvertimeStatus
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1=Exempt, 2=Non-Exempt.

• PayFrequencyBasis

1=yearly, 2=weekly, 3=hourly, 4=biweekly, 5=semimonthly, 6=monthly, 7=Total, 8=Daily.

• StudyLevel

1-None, 2-High School Diploma/GED, 3-Technical Diploma, 4-Associate's Degree/College Diploma, 5-Non-
Degree Program, 6-Bachelor's Degree, 7-Master's Degree, 8-Doctorate Degree, 9-Higher Degree, 10-Other.

• StudyProgram

Valid CieProgram Description.

Must exist in Taleo CieProgram Table.

• WillTravel

1-No, 2-Yes, 25% of the Time, 3-Yes, 50% of the Time, 4-Yes, 75% of the Time, 5-Yes, 100% of the Time, 6-Yes,
5% of the Time, 7-Yes, 10% of the Time, 8-Yes, 15% of the Time, 9-Yes, 20% of the Time.

• EEOJobCategory

Used for either EEO Job Category OR client custom EEO Job Groups1=Ocials & Managers; 2=Professionals;
3=Technicians; 4=Sales Workers; 5=Oce/Clerical; 6=Craft Workers; 7=Operatives; 8=Laborers; 9=Service
Workers- Other EEO Job Categories values can be congured and available if the EEO Job Group No is enabled.

• JobField

This eld is mandatory.

Valid JobField code.

• Organization

Valid Organization Code.

Must exist in Taleo Organization Table.

• PrimaryLocation

This eld is mandatory.

Valid Location Code.

Must exist in Taleo Location Table.

• UserGroup

This eld is optional.

Valid ArtGroup,CustomerCode.

• Title-EN

Title of the requisition, this eld is mandatory.

Add one eld for each language in which the requisition Title is imported.

• ReferenceTitle-EN
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Manager WebTop Job Title, this eld is mandatory.
Add one eld for each language in which the requisition Reference Title is imported.

• DescriptionInternal-EN/DescriptionExternal-EN
1333 multi-byte characters or 4000 single byte characters, maintain line feeds, carriage returns, and formaing
embedded within eld data.
Add one eld for each language in which the internal or external description is imported.

• QualInternal-EN/QualExternal-EN
1333 multi-byte characters or 4000 single byte characters, maintain line feeds, carriage returns, and formaing
embedded within eld data.
Add one eld for each language in which the internal or external qualication is imported.

• RequisitionType
This eld is mandatory if many requisition types are activated in Taleo AWT. 1=Professional (default), 2=Hourly,
3=Campus, 4= Contingent, 5=Executives.

• JobCode
This eld is a link to JobTemplate, it can not be updated by integration.

• CustomFieldName
Custom elds can be mandatory or optional depending on their seings.

User Standard Net Change  
The user standard net change synchronizes the user data with the Taleo product.

• Identier
Use the same value as the Loginname. This value will come back in the results le and facilitate reconciliation of
the results.

• Loginname
This eld is mandatory and must be unique. It is used as the primary key targeting the User entity.

• Password
This eld is mandatory.
Set Advanced options: updatable=false.

• RolesCollection
When the collection is reset, all roles must be sent for each user. Also note that some business rules apply so
that not all combinations of roles are possible.

• Role-1
This eld is mandatory.
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• Role-2

A user can have multiple roles.

Multiple roles can be imported by adding as many role columns as necessary to cover the maximum a user can
have according to your data.

• FirstName

This eld is mandatory.

• LastName

This eld is mandatory.

• ContentLanguages

Languages in which the user will create requisitions and templates, en by default.

Multiple languages are separated by a comma, for example: en,fr,es.

These are the Career Section Languages.

• CorrespondenceLanguage

Language used for correspondence with the user.

These are the WebTop Languages.

• ForceChangePassword

This eld is mandatory.

Set Advanced options: updatable=false.

• Title-en

Add one eld for each language in which the user Title is imported.

• GroupCollection

When the collection is reset, all groups must be sent for each user.

• Group-1

This eld is mandatory.

• Group-2

A user can belong to multiple groups.

Multiple groups can be imported by adding as many group columns as necessary to cover the maximum a user
can have according to your data.

• CustomFieldName

Custom elds can be mandatory or optional depending on their seings.

165



Talent Acquisition Cloud
Using Connect Client

Chapter 7
Templates

166



Talent Acquisition Cloud
Using Connect Client

Chapter 8
Advanced Queries

8  Advanced Queries

Introduction  
In this section you will nd examples of queries in SQL and their equivalent in XML. These examples can be used as
models to create custom queries. Since the XML queries are converted to Oracle SQL queries during the extraction
process, you will nd a table of reserved words that can not be used as an alias in your XML queries.

Inserting Complex Queries  
Taleo Connect Client is running and ready for use.

An export editor based on the entity on which the complex queries will be applied is open.

This procedure applies to complex projections, complex lters, complex sorting, complex projection sorting, and all
advanced tab functions.

1. Click on Projections tab.
a. Click on Add.
b. Select Add a complex projection.
c. Click on OK.

The Complex projection pane displays: <quer:projection xmlns:quer="http://www.taleo.com/ws/
integration/query"/>

2. Enter or paste code in Complex projection pane.

<quer:projection alias="Candidate_Anonymous" xmlns:quer="http://www.taleo.com/ws/integration/query">
 <quer:switchByValue>
 <quer:baseValue>
 <quer:field path="Candidate.Anonymous"/>
 </quer:baseValue>
 <quer:cases>
 <quer:case>
 <quer:integer>1</quer:integer>
 <quer:string>Anonymous candidate</quer:string>
 </quer:case>
 <quer:case>
 <quer:integer>0</quer:integer>
 <quer:string>Non anonymous candidate</quer:string>
 </quer:case>
 </quer:cases>
 <quer:defaultValue>
 <quer:string>Unknown</quer:string>
 </quer:defaultValue>
 </quer:switchByValue>
</quer:projection>
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Examples  

Between  

SQL
SELECT CSUSER01.CSUSERNO AS CSUSERNO01 
 FROM CSUSER CSUSER01 
 WHERE (CSUSER01.CSUSERNO BETWEEN 1 AND 10))

XML query API
<filtering> 
 <between 
 <field path="no"/> 
 <integer>1</integer> 
 <integer>10</integer> 
 </between> 
</filtering>

Case (Switch by criterion)  

SQL

SELECT CASE
 WHEN (CSUSER01.ANONYMOUS=1) THEN
 'Anonymous candidate'
 WHEN (CSUSER01.ANONYMOUS=0) THEN
 'Non anonymous candidate'
 ELSE
 'Unknown candidate'
 END AS firstName01
 FROM CSUSER CSUSER01

XML query API

<projection projectedField="firstName">
 <switchByCriterion>
 <cases>
 <case>
 <isTrue>
 <field path="anonymous"/>
 </isTrue>
 <string>Anonymous candidate</string>
 </case>
 <case>
 <isFalse>
 <field path="anonymous"/>
 </isFalse>
 <string>Non anonymous candidate</string>
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 </case>
 </cases>
 <defaultValue>
 <string>Unknown candidate</string>
 </defaultValue>
 </switchByCriterion>
</projection>

Case (Switch by value)  

SQL

SELECT CSUSER01.CSUSERNO AS CSUSERNO01,
 CASE CSUSER01.ANONYMOUS
 WHEN 1 THEN
 'Anonymous candidate'
 WHEN 0 THEN
 'Non anonymous candidate'
 ELSE
 'Unknonw candidate'
 END AS firstName01
 FROM CSUSER CSUSER01

XML query API

<projection projectedField="firstName">
 <switchByValue>
 <baseValue>
 <field path="anonymous"/>
 </baseValue>
 <cases>
 <case>
 <boolean>true</boolean>
 <string>Anonymous candidate</string>
 </case>
 <case>
 <boolean>false</boolean>
 <string>Non anonymous candidate</string>
 </case>
 </cases>
 <defaultValue>
 <string>Unknown candidate</string>
 </defaultValue>
 </switchByValue>
</projection>

Concatenate  

SQL

SELECT ((CSUSER01.FIRSTNAME || ' ') || CSUSER01.LASTNAME) AS FIRSTNAME01
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FROM CSUSER CSUSER01

XML query API

<query alias="testConcatenate" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection projectedField="firstName">
 <concatenate>
 <concatenate>
 <field path="firstName"/>
 <string> </string>
 </concatenate>
 <field path="lastName"/>
 </concatenate>
 </projection>
 </projections>
</query>

Connect By  

SQL

SELECT STUDYLEVEL01.STUDYLEVELNO AS STUDYLEVELNO01
FROM STUDYLEVEL STUDYLEVEL01
WHERE 1=1
CONNECT BY PRIOR STUDYLEVEL01.STUDYLEVELNO=STUDYLEVEL01.PARENTSTUDYLEVELNO
START WITH (STUDYLEVEL01.STUDYLEVELNO=5)

XML query API

<query alias="testHierarchicalFiltering" projectedClass="com.taleo.akirademo.entity.StudyLevel">
 <projections>
 <projection>
 <field path="no"/>
 </projection>
 </projections>
 <hierarchicalFilterings>
 <hierarchicalFiltering>
 <hierarchicalFilter>
 <equal>
 <field path="no"/>
 <field path="parent"/>
 </equal>
 </hierarchicalFilter>
 <startWithFilter>
 <equal>
 <field path="no"/><integer>5</integer>
 </equal>
 </startWithFilter>
 </hierarchicalFiltering>
 </hierarchicalFilterings>
</query>
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Count  

SQL

SELECT COUNT((CSUSER01.CSUSERNO)) AS keyCount FROM CSUSER CSUSER01

XML query API

<query alias="testCount" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="keyCount">
 <count>
 <field path="no"/>
 </count>
 </projection>
 </projections>
</query>

dbms_lob.getlength  

SQL

SELECT dbms_lob.getlength(CSUSERATTACHEDFILE01.FILECONTENT) AS blobLength
 FROM CSUSERATTACHEDFILE CSUSERATTACHEDFILE01
 WHERE (CSUSERATTACHEDFILE01.CSUSERATTACHEDFILENO=10291)

XML query API

<query alias="testLobLength" projectedClass="com.taleo.akirademo.entity.AttachedFile">
 <projections>
 <projection alias="blobLength">
 <lobLength>
 <field path="fileContent"/>
 </lobLength>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <equal>
 <field path="no"/>
 <integer>10291</integer>
 </equal>
 </filtering>
 </filterings>
</query>
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dbms_lob.instr  

SQL

SELECT DBMS_LOB.INSTR(CSUSERATTACHEDFILE01.FILECONTENT, 'a') AS blobIndexOf
 FROM CSUSERATTACHEDFILE CSUSERATTACHEDFILE01
 WHERE (CSUSERATTACHEDFILE01.CSUSERATTACHEDFILENO=10291)

XML query API

<query alias="testLobIndexOf" projectedClass="com.taleo.akirademo.entity.AttachedFile" >
 <projections>
 <projection alias="blobIndexOf">
 <lobIndexOf>
 <field path="fileContent"/>
 <string>205465737420</string>
 </lobIndexOf>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <equal>
 <field path="no"/>
 <integer>10291</integer>
 </equal>
 </filtering>
 </filterings>
</query>

dbms_lob.substr  

SQL

SELECT DBMS_LOB.SUBSTR(CSUSERATTACHEDFILE01.FILECONTENT, 3, 4) AS blobSubstring
 FROM CSUSERATTACHEDFILE CSUSERATTACHEDFILE01
 WHERE (CSUSERATTACHEDFILE01.CSUSERATTACHEDFILENO=10291)

XML query API

<query alias="testLobSubString" projectedClass="com.taleo.akirademo.entity.AttachedFile">
 <projections>
 <projection alias="blobSubstring" projectedValueType="string">
 <lobSubstring>
 <field path="fileContent"/>
 <integer>4</integer>
 <integer>3</integer>
 </lobSubstring>
 </projection>
 </projections>
 <filterings>
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 <filtering>
 <equal>
 <field path="no"/>
 <integer>10291</integer>
 </equal>
 </filtering>
 </filterings>
</query>

Decode  

SQL

SELECT DECODE(CSUSER01.FIRSTNAME, 'Sebastien', 'Seb', 'Benoit', 'Ben', CSUSER01.FIRSTNAME) AS FIRSTNAME01
 FROM CSUSER CSUSER01
 WHERE 1=1

XML query API

<query alias="testDecode" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <decode>
 <field path="firstName"/>
 <string>Sebastien</string>
 <string>Seb</string>
 <string>Benoit</string>
 <string>Ben</string>
 <field path="firstName"/>
 </decode>
 </projection>
 </projections>
</query>

Distinct  

SQL

select distinct currency from csuser

XML query API

<query alias="subQuery" preventDuplicates="true" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="currency"> 
 <field path="currency"/> 
 </projection>
 </projections>
</query>
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Dual  

SQL

SELECT 1 FROM DUAL

XML query API

<query alias="MyDualQuery" projectedClass="DUAL_META_CLASS">
 <projections>
 <projection alias="myProjection">
 <integer>1</integer>
 </projection>
 </projections>
</query>

Exists / Not Exists  

SQL

SELECT CSUSER01.FIRSTNAME AS FIRSTNAME01
 FROM CSUSER CSUSER01
 WHERE (EXISTS
 (SELECT CSUSER02.SALARY AS SALARY01 FROM CSUSER CSUSER02 WHERE 1=1))

SELECT CSUSER01.FIRSTNAME AS FIRSTNAME01
 FROM CSUSER CSUSER01
 WHERE NOT (EXISTS
 (SELECT CSUSER02.SALARY AS SALARY01 FROM CSUSER CSUSER02 WHERE 1=1))

XML query API

<query alias="testExists" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="firstName"/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <returnsResults>
 <query alias="subQuery" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="salary"/>
 </projection>
 </projections>
 </query>
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 </returnsResults>
 </filtering>
 </filterings>
</query>

<query alias="testExists" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="firstName"/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <not>
 <returnsResults>
 <query alias="subQuery" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="salary"/>
 </projection>
 </projections>
 </query>
 </returnsResults>
 </not>
 </filtering>
 </filterings>
</query>

Greater Than  

SQL

SELECT CSUSER01.CSUSERNO AS CSUSERNO01
 FROM CSUSER CSUSER01
 WHERE (CSUSER01.SALARY > 50)

XML query API

<query alias="testGreatherThan" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="no"/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <greaterThan>
 <field path="salary"/>
 <integer>50</integer>
 </greaterThan>
 </filtering>
 </filterings>
</query>
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Group By  

SQL

SELECT APPLICATION01.CANDIDATENO AS candidate,
 COUNT(APPLICATION01.CANDIDATENO) AS appCount
FROM APPLICATION APPLICATION01
WHERE 1=1
GROUP BY APPLICATION01.CANDIDATENO

XML query API

<query alias="testReportQueryWithGrouping" projectedClass="com.taleo.akirademo.entity.BaseApplication">
 <projections>
 <projection alias="candidate">
 <field path="candidate"/>
 </projection>
 <projection alias="appCount">
 <count>
 <field path="candidate"/>
 </count>
 </projection>
 </projections>
 <groupings>
 <grouping>
 <field path="candidate"/>
 </grouping>
 </groupings>
</query>

Having  

SQL

SELECT CSUSER01.CITY AS CITY01, COUNT(CSUSER01.CITY) AS cityCount
FROM CSUSER CSUSER01
WHERE 1=1
GROUP BY CSUSER01.CITY
HAVING(COUNT(CSUSER01.CITY) > 5)

XML query API

<query alias="testGroupingFilteringInReportQuery" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="city"/>
 </projection>
 <projection alias="cityCount">
 <count>
 <field path="city"/>
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 </count>
 </projection>
 </projections>
 <groupings>
 <grouping>
 <field path="city"/>
 </grouping>
 </groupings>
 <groupingFilterings>
 <groupingFiltering>
 <greaterThan>
 <count>
 <field path="city"/>
 </count>
 <integer>5</integer>
 </greaterThan>
 </groupingFiltering>
 </groupingFilterings>
</query>

In  

SQL

CSUSER01.CSUSERNO AS entityKey
FROM CSUSER CSUSER01
WHERE (CSUSER01.CSUSERNO IN (SELECT CSUSER02.CSUSERNO AS entityKey
 FROM CSUSER CSUSER02
 WHERE (CSUSER02.FIRSTNAME LIKE 's%' ESCAPE '\')))

SELECT CSUSER01.CSUSERNO AS entityKey
FROM CSUSER CSUSER01
WHERE (CSUSER01.CSUSERNO IN (1, 2, 3))

XML query API

<query alias="testIncludedIn" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <includedIn>
 <field path="no"/>
 <query alias="candidateSubQuery" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
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 <string>s*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 </includedIn>
 </filtering>
 </filterings>
</query>

<query alias="testIncludedIn" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <includedIn>
 <field path="no"/>
 <list>
 <integer>1</integer>
 <integer>2</integer>
 <integer>3</integer>
 </list>
 </includedIn>
 </filtering>
 </filterings>
</query>

Inner Join  

SQL

SELECT APPLICATIONTRACKINGHISTORY01.APPLICATIONTRACKINGHISTORYNO AS APPLICATIONTRACKINGHISTORYNO01
 FROM APPLICATIONTRACKINGHISTORY APPLICATIONTRACKINGHISTORY01,
 APPLICATION APPLICATION01,
 CSUSER CSUSER01
 WHERE APPLICATION01.CANDIDATENO=APPLICATIONTRACKINGHISTORY01.CANDIDATENO
 AND APPLICATION01.REQUISITIONNO =
 APPLICATIONTRACKINGHISTORY01.REQUISITIONNO
 AND APPLICATION01.PROFILELOCALE =
 APPLICATIONTRACKINGHISTORY01.PROFILELOCALE
 AND CSUSER01.CSUSERNO=APPLICATION01.CANDIDATENO
 AND ((CSUSER01.CSUSERNO) > 0)

XML query API

<query alias="testInnerJoin" projectedClass="com.taleo.akirademo.entity.ApplicationTrackingHistoryItem">
 <projections>
 <projection>
 <field path="no"/>
 </projection>
 </projections>
 <filterings>
 <filtering>
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 <greaterThan><key path="application=,candidate="/>
 <integer>0</integer>
 </greaterThan>
 </filtering>
 </filterings>
</query>

Intersect  

SQL

SELECT CSUSER01.CSUSERNO AS entityKey
 FROM CSUSER CSUSER01
 WHERE (CSUSER01.FIRSTNAME LIKE 'a%' ESCAPE '\')
INTERSECT
SELECT CSUSER02.CSUSERNO AS entityKey
 FROM CSUSER CSUSER02
 WHERE (CSUSER02.FIRSTNAME LIKE 's%' ESCAPE '\')

XML query API

<intersect alias="testIntersect">
 <queries>
 <query alias="testIntersect2" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
 <string>a*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 <query alias="candidateSubQuery" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
 <string>s*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 </queries>
</intersect>
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Less Than  

SQL

SELECT CSUSER01.CSUSERNO AS CSUSERNO01
 FROM CSUSER CSUSER01
 WHERE (CSUSER01.SALARY < 50)

XML query API

<query alias="testGreatherThan" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="no"/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <lessThan>
 <field path="salary"/>
 <integer>50</integer>
 </lessThan>
 </filtering>
 </filterings>
</query>

Like  

SQL

SELECT CSUSER01.CSUSERNO AS entityKey
 FROM CSUSER CSUSER01
 WHERE (CSUSER01.FIRSTNAME LIKE 's%' ESCAPE '\')

XML query API

 <query alias="testLike" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
 <string>s*</string>
 </matches>
 </filtering>
 </filterings>
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 </query>

Minus  

SQL

SELECT CSUSER01.CSUSERNO AS entityKey
 FROM CSUSER CSUSER01
 WHERE (CSUSER01.FIRSTNAME LIKE 'a%' ESCAPE '\')
MINUS
SELECT CSUSER02.CSUSERNO AS entityKey
 FROM CSUSER CSUSER02
 WHERE (CSUSER02.FIRSTNAME LIKE 's%' ESCAPE '\')

XML query API

<minus alias="testMinus">
 <queries>
 <query alias="candidate" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
 <string>a*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 <query alias="candidate2" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
 <string>s*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 </queries>
</minus>

181



Talent Acquisition Cloud
Using Connect Client

Chapter 8
Advanced Queries

NVL  

SQL

SELECT NVL(CSUSER01.FIRSTNAME, 'Unknown') AS FIRSTNAME01
 FROM CSUSER CSUSER01
 WHERE 1=1

XML query API

<query alias="testReplaceNull" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <replaceNull>
 <field path="firstName"/>
 <string>Unknown</string>
 </replaceNull>
 </projection>
 </projections>
</query>

Or  

SQL

SELECT CSUSER01.CSUSERNO AS entityKey
 FROM CSUSER CSUSER01
 WHERE ((CSUSER01.FIRSTNAME LIKE 'a%' ESCAPE '\') OR
 (CSUSER01.FIRSTNAME='Sam'))

XML query API

<query alias="testIntersect2" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <or>
 <matches>
 <field path="firstName"/>
 <string>a*</string>
 </matches>
 <equal>
 <field path="firstName"/>
 <string>Sam</string>
 </equal>
 </or>
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 </filtering>
 </filterings>
</query>

Order By  

SQL

select csuserno from csuser order by csuserno asc

select csuserno from csuser order by csuserno desc

XML query API

<query alias="testOrderByAsc" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="no" /> 
 </projection>
 </projections>
 <sortings>
 <sorting ascending="true">
 <field path="no" /> 
 </sorting>
 </sortings>
</query>

<query alias="testOrderByDesc" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="no" /> 
 </projection>
 </projections>
 <sortings>
 <sorting ascending="false">
 <field path="no" /> 
 </sorting>
 </sortings>
</query>

Outer Join  

SQL

SELECT APPLICATION01.CANDIDATENO AS CANDIDATENO01
 FROM APPLICATIONTRACKINGHISTORY APPLICATIONTRACKINGHISTORY01,
 APPLICATION APPLICATION01
 WHERE APPLICATION01.CANDIDATENO(+) =
 APPLICATIONTRACKINGHISTORY01.CANDIDATENO
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 AND APPLICATION01.REQUISITIONNO(+) =
 APPLICATIONTRACKINGHISTORY01.REQUISITIONNO
 AND APPLICATION01.PROFILELOCALE(+) =
 APPLICATIONTRACKINGHISTORY01.PROFILELOCALE

XML query API

<query alias="testOuterJoin" projectedClass="com.taleo.akirademo.entity.ApplicationTrackingHistoryItem">
 <projections>
 <projection>
 <field path="application+,candidate+"/>
 </projection>
 </projections>
</query>

Rownum  

SQL

SELECT CSUSER01.CSUSERNO AS CSUSERNO01, rowNum AS rowIndex
 FROM CSUSER CSUSER01
 WHERE 1=1

XML query API

<query alias="testRowindex" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <field path="no"/>
 </projection>
 <projection alias="rowIndex">
 <customValue>
 <expression>rowNum</expression>
 </customValue>
 </projection>
 </projections>
</query>

SubString  

SQL

SELECT SUBSTR(CSUSER01.LASTNAME, 0, 2) AS LASTNAME01
 FROM CSUSER CSUSER01
 WHERE 1=1

XML query API
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<query alias="testSubString" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <substring>
 <field path="lastName"/>
 <integer>0</integer>
 <integer>2</integer>
 </substring>
 </projection>
 </projections>
</query>

ToChar  

SQL

SELECT TO_CHAR(LOCALTIMESTAMP(0)) AS tocharnow,
 TO_CHAR(LOCALTIMESTAMP(0), 'yyyy-MM-dd') AS tocharnowFormat,
 TO_CHAR(2.24567, '0.99') AS tochardouble
 FROM Dual Dual01
 WHERE 1=1

XML query API

<query alias="testToCharFunction" projectedClass="DUAL_META_CLASS">
 <projections>
 <projection alias="tocharnow">
 <toChar>
 <date type="now" xsi:nil="true"/>
 </toChar>
 </projection>
 <projection alias="tocharnowFormat">
 <toChar>
 <date type="now" xsi:nil="true"/>
 <string bound="false">yyyy-MM-dd</string>
 </toChar>
 </projection>
 <projection alias="tochardouble">
 <toChar>
 <double>2.7689340174</double>
 <string bound="false">0.99</string>
 </toChar>
 </projection>
 </projections>
</query>

Trim  

SQL

SELECT TRIM(CSUSER01.LASTNAME) AS LASTNAME01
 FROM CSUSER CSUSER01

185



Talent Acquisition Cloud
Using Connect Client

Chapter 8
Advanced Queries

 WHERE 1=1

XML query API

<query alias="testTrim" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <trim>
 <field path="lastName"/>
 </trim>
 </projection>
 </projections>
</query>

Truncate  

SQL

SELECT TRUNC(CSUSER01.SALARY) AS SALARY01 FROM CSUSER CSUSER01 WHERE 1=1

XML query API

<query alias="testTruncate" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <truncate>
 <field path="salary"/>
 </truncate>
 </projection>
 </projections>
</query>

Union  

SQL

SELECT CSUSER01.CSUSERNO AS entityKey
 FROM CSUSER CSUSER01
 WHERE (CSUSER01.FIRSTNAME LIKE 'a%' ESCAPE '\')
UNION
SELECT CSUSER02.CSUSERNO AS entityKey
 FROM CSUSER CSUSER02
 WHERE (CSUSER02.FIRSTNAME LIKE 's%' ESCAPE '\')

XML query API

<union alias="testUnion">
 <queries>
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 <query alias="testUnion2" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
 <string>a*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 <query alias="candidateSubQuery" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
 <string>s*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 </queries>
</union>

Union All  

SQL

SELECT CSUSER01.CSUSERNO AS entityKey
 FROM CSUSER CSUSER01
 WHERE (CSUSER01.FIRSTNAME LIKE 'a%' ESCAPE '\')
UNION ALL
SELECT CSUSER02.CSUSERNO AS entityKey
 FROM CSUSER CSUSER02
 WHERE (CSUSER02.FIRSTNAME LIKE 's%' ESCAPE '\')

XML query API

<unionAllowDuplicates alias="testUnionAll">
 <queries>
 <query alias="testUnion2" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
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 <field path="firstName"/>
 <string>a*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 <query alias="candidateSubQuery" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection alias="entityKey" tag="entityKey">
 <key path=""/>
 </projection>
 </projections>
 <filterings>
 <filtering>
 <matches>
 <field path="firstName"/>
 <string>s*</string>
 </matches>
 </filtering>
 </filterings>
 </query>
 </queries>
</unionAllowDuplicates>

Other Custom Functions  

SQL

SELECT CUSTOM_FUNCTION_NAME(myField,'param1','param2') AS myField01
FROM CSUSER CSUSER01 
WHERE 1=1

XML query API

<query alias="testCustomFunction" projectedClass="com.taleo.akirademo.entity.Candidate">
 <projections>
 <projection>
 <customFunction name="CUSTOM_FUNCTION_NAME">
 <field path="myField"/>
 <string>param1</string>
 <string>param2</string>
 </customFunction>
 </projection>
 </projections>
</query>

Custom Function Example  

SQL
SELECT REGEXP_REPLACE(CSUSER01.USERNAME,?,?) AS USERNAME01 
FROM CSUSER CSUSER01 
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WHERE 1=1

XML query API
<query alias="testRegexpReplace" projectedClass="com.taleo.akirademo.entity.Candidate"> 
 <projections> 
 <projection> 
 <customFunction name="REGEXP_REPLACE"> 
 <field path="username"/> 
 <string>a</string> 
 <string>b</string> 
 </customFunction> 
 </projection> 
 </projections> 
</query>

Oracle Reserved Words  
Oracle reserved words cannot be used as an Alias for an export query. The following table list words that are reserved in
Oracle.

Oracle Reserved Words

ABORT
 

ACCEPT
 

ACCESS
 

ADD
 

ALL
 

ALTER
 

AND
 

ANY
 

ARRAY
 

ARRAYLEN
 

AS
 

ASC
 

ASSERT
 

ASSIGN
 

AT
 

AUDIT
 

AUTHORIZATION
 

AVG
 

BASE_TABLE
 

>BEGIN
 

BETWEEN
 

BINARY_INTEGER
 

BODY
 

BOOLEAN
 

BY
 

CASE
 

CHAR
 

CHAR_BASE
 

CHECK
 

CLOSE
 

CLUSTER
 

CLUSTERS
 

COLAUTH
 

COLUMN
 

COMMENT
 

COMMIT
 

COMPRESS
 

CONNECT
 

CONSTANT
 

CRASH
 

CREATE
 

CURRENT
 

CURRVAL
 

CURSOR
 

DATA_BASE DATABASE DATE DBA
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Oracle Reserved Words

       

DEBUGOFF
 

DEBUGON
 

DECIMAL
 

DECLARE
 

DEFAULT
 

DEFINITION
 

DELAY
 

DELETE
 

DESC
 

DIGITS
 

DISPOSE
 

DISTINCT
 

DO
 

DROP
 

ELSE
 

ELSIF
 

END
 

ENTRY
 

EXCEPTION
 

EXCEPTION_INIT
 

EXCLUSIVE
 

EXISTS
 

EXIT
 

FALSE
 

FETCH
 

FILE
 

FLOAT
 

FOR
 

FORM
 

FROM
 

FUNCTION
 

GENERIC
 

GOTO
 

GRANT
 

GROUP
 

HAVING
 

IDENTIFIED
 

IF
 

IMMEDIATE
 

IN
 

INCREMENT
 

INDEX
 

INDEXES
 

INDICATOR
 

INITIAL
 

INSERT
 

INTEGER
 

INTERFACE
 

INTERSECT
 

INTO
 

IS
 

LEVEL
 

LIKE
 

LIMITED
 

LOCK
 

LONG
 

LOOP
 

MAX
 

MAXEXTENTS
 

MIN
 

MINUS
 

MLSLABEL
 

MOD
 

MODE
 

MODIFY
 

NATURAL
 

NATURALN
 

NETWORK
 

NEW
 

NEXTVAL
 

NOAUDIT
 

NOCOMPRESS
 

NOT
 

NOWAIT
 

NULL
 

NUMBER
 

NUMBER_BASE
 

OF
 

OFFLINE
 

ON
 

ONLINE OPEN OPTION OR

190



Talent Acquisition Cloud
Using Connect Client

Chapter 8
Advanced Queries

Oracle Reserved Words

       

ORDER
 

OTHERS
 

OUT
 

PACKAGE
 

PARTITION
 

PCTFREE
 

PLS_INTEGER
 

POSITIVE
 

POSITIVEN
 

PRAGMA
 

PRIOR
 

PRIVATE
 

PRIVILEGES
 

PROCEDURE
 

PUBLIC
 

RAISE
 

RANGE
 

RAW
 

REAL
 

RECORD
 

REF
 

RELEASE
 

REMR
 

RENAME
 

RESOURCE
 

RETURN
 

REVERSE
 

REVOKE
 

ROLLBACK
 

ROW
 

ROWID
 

ROWLABEL
 

ROWNUM
 

ROWS
 

ROWTYPE
 

RUN
 

SAVEPOINT
 

SCHEMA
 

SELECT
 

SEPERATE
 

SESSION
 

SET
 

SHARE
 

SIGNTYPE
 

SIZE
 

SMALLINT
 

SPACE
 

SQL
 

SQLCODE
 

SQLERRM
 

START
 

STATEMENT
 

STDDEV
 

SUBTYPE
 

SUCCESSFUL
 

SUM
 

SYNONYM
 

SYSDATE
 

TABAUTH
 

TABLE
 

TABLES
 

TASK
 

TERMINATE
 

THEN
 

TO
 

TRIGGER
 

TRUE
 

TYPE
 

UID
 

UNION
 

UNIQUE
 

UPDATE
 

USE
 

USER
 

VALIDATE
 

VALUES
 

VARCHAR
 

VARCHAR2
 

VARIANCE
 

VIEW
 

VIEWS WHEN WHENEVER WHERE
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Oracle Reserved Words

       

WHILE
 

WITH
 

WORK
 

WRITE
 

XOR
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9  Security

Data Condentiality  
Taleo strongly recommends the enforcement of "Full SSL" as the supported communications protocol. The SSL
communications protocol properties can be congured with the SmartOrg Communications Protocol Editor by a
user with an Integrator role. When "Full SSL" mode is enforced, the Taleo-hosted environments only accept HTTPS
requests. This communication protocol conguration ensures that only secure connections are accepted and that all
data transmied is properly encrypted. All Integration points created with TCC should conform to this protocol at the
handshake. TCC supports TLS 1.2.

To support organizations with limited HTTPS capabilities, TCC allows HTTP based communications. When this protocol
is selected, the data is not encrypted during transmission between TCC and the Taleo-hosted environments. HTTP
communication should only be used when the organization’s network does not support HTTPS communications.

User Authentication  
TCC supports basic user name and password authentication as well as certicate based authentication.

Web Services Security (WS-S)
Oracle Taleo announced the deprecation of support for Username Token Prole 1.1 using the PasswordDigest scheme in
release 14B. Any customers using this method for authenticating with the Oracle Taleo Enterprise Edition 14B and above
zones, will be required to make modications and replace Password Digest with Basic Authentication. Conguration that
were using this scheme will now automatically default to basic authentication.

Basic Authentication
When using the basic authentication, TCC provides user credentials in the form of a user name and password, as HTTP
headers.

Certicate Based Authentication
TCC supports the signing of communication between TCC and the Taleo zone. The authentication is used to sign the
requests and responses between Connect Client and Taleo. This is in addition to basic authentication.

Stored Passwords  
Taleo Connect Client (TCC) communicates to Taleo hosted products using an authenticated user and password. In
addition, if proxy servers are installed within the environment additional user credentials can be required by TCC.
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Integration User password
TCC maintains the Integration User password locally to establish a connection with a Taleo hosted product. Passwords
can be stored in the following locations:

• Default conguration board le: default.board.xml

• Environment le: *.properties

• Conguration les: *_cfg.xml

The Integration User password is encrypted by an AES algorithm with a key size of 128 bits. It is stored in an XML le:

EncryptedPassword=Base64 (AES:128 (password))

Encryption Key Server (EKS)
With release 14A, an encryption key server is delivered with Taleo Connect Client (TCC) which can be used to augment
existing password management services. The EKS can be used to generate a key that encrypts passwords within the
TCC application.

Encryption Key Server Installation
Step 1. Copy the encryptionkey-server.jar le from the server folder under the TCC installation folder, to a location on the
network. It is recommended that this be a dierent location than the TCC installation. The encryptionkey-server.jar le is
the default EKS delivered for enhancing password management.

Step 2. By default, the EKS runs using a local host IP address and port 1126. To use another address or port, a folder and
le must be created at the server root location. (A server restart is required following any modication.)

Folder and le name:

• conf/EncryptionKeyServer.conf File content:

• HOST_PORT=YOUR_SERVER_PORT

• HOST_ADDRESS=YOUR_SERVER_ADDRESS

Step 3. The encryption server can now be started, call your_java_location –jar encryptionkey-server.jar.

a. On Windows platform - the following screen prompts is displayed to the user. The user should enter a passphrase
value. This value is masked with *.
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b. On platform - command line will prompt user for passphrase entry.

On starting the EKS for the rst time, an AES symmetric encryption key is generated. This will be automatically saved
into the conf/ClientKey.key le. The user entered passphrase is used to protect access to the encryption key value
stored in this le. Each new installation of the EKS will generate a dierent & unique encryption key. Due to this, it is
strongly recommended that a backup of the key le is made and saved in a secured location. In doing so, it is possible to
recover encrypted data if there is a failure with the original implementation. Using the same passphrase would unlock
the encryption key needed to decrypt the data. At all subsequent EKS startups, the entered passphrase will be used to
unlock the encryption key needed to decrypt any encrypted data.

Conguring TCC using an Encryption Key Server
It is necessary for TCC to be provided with the host address and port of the EKS that was setup and congured in the
previous step. This can be added when a new instance of TCC is being installed via the setup dialog step illustrated
below. This information is captured during the installation process of the new version of TCC and stored in the
TaleoConnectClient.ini le.

If more convenient, the EKS can be installed at a later time, and the relevant host and port information can be added
directly into the TaleoConnectClient.ini le as illustrated below:

• -Dcom.taleo.integration.client.encryption.key.hostPort=Your_Server_Port

• -Dcom.taleo.integration.client.encryption.key.hostAddress=Your_Server_Address

Please note that using a dierent encryption server will imply modifying the conguration les to use the new
encryption key.

In TCC, no modications are visible in the UI. When creating a new prole or conguration board entry, if both
properties have been specied, the encryption from the server is used to encrypt the password. Otherwise, the default
encryption mechanism is used.

Encrypt Password Tool
An additional tool is provided to encrypt individual string values. It is located in the Tools > Encrypt Password  menu.

Enter the string value to encrypt in the text box and click Encrypt. If the encryption server properties are dened, this
will be used to encrypt the value. Otherwise, the default encryption mechanism will be used. The encrypted result is
displayed at the boom of the page. Click Copy to save to clipboard. Click Close to close the window.

Proxy Password Management Using EKS
TCC uses a System Properties le to authenticate itself against proxy servers needed to access the internet. The
required System properties are:

-Dhttp.proxyHost=myproxyhostname

-Dhttp.proxyPort=portnumber

-Dhttp.proxyUser=username

-Dhttp.proxyPassword=hello123

-Dhttps.proxyPassword=securedHello123
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Note:  Values dened for properties hp.proxyPassword and hps.proxyPassword need to be encrypted. The
new Encryption Password Tool can be used to encrypt dierent String values. The presence of the Encryption
Key Server address and port properties is used to determine the encryption mode.

The two following properties must be added to use the Encryption Key Server:

-Dcom.taleo.integration.client.encryption.key.hostAddress=your_server_address

-Dcom.taleo.integration.client.encryption.key.hostPort=your_server_port

There are two dierent ways to set up System properties, depending on the way TCC is launched.

1. On windows via the GUI:

When running TCC through the Windows GUI, all System properties must be dened in the
TaleoConnectClient.ini le located at the root of the installation folder.

2. Launching TCC through the Command Line interface:

When running TCC in a Command Line interface, the System properties must be included in the
TaleoConnectClient.bat (Windows) or TaleoConnectClient.sh (Linux) les.

To be able to run TCC from command line without any issue it is recommended to use the following Java
options (don't forget to replace the variables with the values that are best for the type of operations that are
done).

JAVA_OPTS=" 
-ms${JAVA_MIN_MEM}M 
-mx${JAVA_MAX_MEM}M 
-XX:NewSize=${NEWGEN}m 
-XX:MaxNewSize=${MAXNEWGEN}m 
-XX:PermSize=${PERMGEN}m 
-XX:MaxPermSize=${MAXPERMGEN}m

EKS Logging Service
A logging service is available for operations related to the encryption key server. Logging is wrien in le log/
EncryptionServerLog.log. Default level is INFO. It is possible to change the logging level using a property at startup. Here
are the possibilities:

• -Dlog.le.level=LEVEL_TO_USE

• -Djava.util.logging.cong.le=YOUR_LOGGING_PROPERTIES_FILE_PATH

Here is an example of logging properties le content: com.taleo.integration.client.encryption.key.level=FINE

Specifying Integration Password  
Specifying Integration user password as ENCRYPTED_PASSWORD symbol when using the command line to invoke TCC.

Using ENCRYPTED_PASSWORD symbol improves security since the integration passwords do not have to be unveiled to
TCC script developers.

1. Encrypt the integration password.
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a. Use the command line tool provided by TCC.

[TCCHome]>EncryptPassword.bat TheSecretPassword
Encrypting password using command line argument.
Encrypted password:
xH/JD4X3xuVTMz7pO1fdxcFUBUlFWGrZqTfNDw/DLpo=

b. Copy the encrypted password to the clipboard.
2. Start TCC.
3. Open the default conguration board,  File>Open>Conguration Board.
4. Create a new symbol.

a. Name: ENCRYPTED_PASSWORD
b. Value: [DECRYPT("paste generated password here")]

Make sure to use the complete syntax using all the control characters: square brackets, parenthesis, and
double-quotes.

5. Update the endpoint and use the [ENCRYPTED_PASSWORD] symbol in the Password eld.

Make sure the symbol is enclosed in square brackets as shown.

Note: The runtime symbol function DECRYPT can only be used in Authentication Password elds.

Override ENCRYPTED_PASSWORD  
To pass the password at the command line, add the following system property when invoking the TCC application:

• clear text password

-Dcom.taleo.client.symbol.ENCRYPTED_PASSWORD=TheSecretPassword

• encrypted password

-Dcom.taleo.client.symbol.ENCRYPTED_PASSWORD=[DECRYPT(\"xH/JD4X3xuVTMz7pO1fdxcFUBUlFWGrZqTfNDw/DLpo=\")]

HTTP Proxy  
In certain corporate networks, IT policies enforce the use of a proxy to funnel all external HTTP requests. This is an
important part of the overall network security.

The Taleo Connect Client fully supports the use of an HTTP proxy both in the runtime execution script andthrough
the design environment. The conguration of the HTTP proxy follows the Java standard documented at hp://
docs.oracle.com/javase/1.5.0/docs/guide/net/properties.html (these are the same specications as for the 1.6 hp://
docs.oracle.com/javase/6/docs/technotes/guides/net/properties.html or 1.7 hp://docs.oracle.com/javase/7/docs/
technotes/guides/net/properties.htmlversion).

According to these specications, the conguration of the HTTP proxy is done at the JRE level; that is the runtime
environment in which the integration process is invoked. The connectivity information is passed as system properties in
either the runtime execution script or the design environment initialization le.
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Hence, assuming the corporate HTTP proxy is available at  proxy.acme.net  on port  3128 , the TaleoConnectClient.bat
script should be changed to add

%JAVA_HOME%\bin\java.exe

-Dhttp.proxyHost=proxy.acme.net

-Dhttp.proxyPort=3128

-Djava.endorsed.dirs=%IC_HOME%\lib\endorsed

Certain corporate HTTP proxy implementations require an explicit authentication. This information can be provided
with two extra system properties as in the following example:

%JAVA_HOME%\bin\java.exe

-Dhttp.proxyHost=proxy.acme.net

-Dhttp.proxyPort=3128

-Dhttp.proxyUser=acmeuser

-Dhttp.proxyPassword=secret

-Djava.endorsed.dirs=%IC_HOME%\lib\endorsed

Please note that we also fully support the http.nonProxyHosts property as dened in the Java specications.

If the use of an HTTP proxy is required also in the design environment, then the following lines should be added to the
TaleoConnectClient.ini le:

vmargs

-Djava.endorsed.dirs=lib/endorsed

-Dorg.apache.commons.logging.Log=org.apache.commons.logging.impl.Log4JLogger

-Dhttp.proxyHost=proxy.acme.net

-Dhttp.proxyPort=3128

In previous versions, the conguration of the HTTP proxy was done in the client conguration le itself. This is no longer
supported in favor of the standard way described above (see the section for more details).

Certain implementations support the https.proxyHost property although it is not part of the Java standard. The Taleo
Connect Client only supports http.proxyHost, which is used for all HTTP requests (HTTP or HTTPS protocol).

Encrypting Proxy Password  
1. Open a command line interface.
2. Execute the utility with the password as argument.

C:\Program Files\Taleo Connect Client>EncryptPassword.bat MySecre7P4ssword

Encrypting password using command line argument.
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Encrypted password:

F0r6f9UebDtC+5cOeI0z0WQxYxA6m410vqqTr9OR1FE=

3. Copy encrypted password.
4. Open system properties le.
5. Paste encrypted password as Dhttp.proxyPassword.

-Dhttp.proxyPassword=F0r6f9UebDtC+5cOeI0z0WQxYxA6m410vqqTr9OR1FE=

Microsoft NTLM Support  
TCC supports both Microsoft’s NTLM V1 and V2 proxy server authentication schemes. Clients with network security
policies leveraging only this authentication method can now install TCC within their infrastructure in compliance with
their internal policy.

Things to Consider
• Technical limitations prevents password digest retrieval from the system.

• The proxy password cannot be read from the network automatically; it must be manually entered in the batch
le.

• Users must keep the password in the batch le synchronized with the Windows domain password.

• All proxy passwords MUST be encrypted.

Proxy System Properties Conguration
The Microsoft NTLM proxy server authentication scheme must be congured in les located at the root of the TCC
installation folder.

• Launching TCC using Windows user interface

When running TCC on Windows, all system properties must be dened in the TaleoConnectClient.ini le.

• Launching TCC using the command line

When running TCC using the command line, all system properties must be passed using the command line.
Insert the system properties in the TaleoConnectClient.bat le for Windows or in the TaleoConnectClient.sh le
for Unix/Linux.

System Properties for NTLM Proxies
The following list contains system properties you can congure for the proxy:

• -Dhttp.proxyHost=myproxyhostname

• -Dhttp.proxyPort=8080

• -Dhttp.proxyUser=username (Windows Domain User Name)

• -Dhttp.proxyPassword=encrypted password (Windows Domain Password)
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• -Dhttp.proxyNTDomain=ACMEDOMAIN (Windows Domain Name)

Note: "hp.proxyNTDomain" is only required for NTML proxy authentication.

Data at Rest  
Standard TCC implementations have no data retention capabilities. Data-at-rest encryption capabilities are not required.
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10  Appendix

Appendix A  

Volume Limits  
The volume limits species maximums for the number of records per day or transaction.

Basic Oering
All Customers using Taleo Connect Client and Taleo Managed Integrations immediately get access to the basic oering
and are subject to the following volume limits:

• Maximum of 500 000 extracted records per day.

• Maximum of 100 000 records per extraction transaction.

• Maximum of 50 000 imported records per day.

• Unrestricted number of records per import transaction.

Concurrent Integrations
It is possible to run parallel Taleo Connect integrations against a customer’s zone. Currently this is set to 4 Concurrent
Integrations per Taleo Product. So it is possible to run 4 imports at a time, or 3 import and 1 export at a time, etc, or 4
exports at a time per Taleo Product.

All subsequent requests will be queued and run later when there is an available slot to execute them.

Planned Exception Framework
In the situation where a project is being undertaken and volume limits need to be modied to accommodate temporary
changes a planned exception can be requested.

Taleo recognizes the following types of project types with corresponding volume limits.

Project Type Daily Import Daily Export Per Transaction Export

Data Migration (New Customer) 350 000 500 000 100 000 records, 256 MB

Data warehouse initial extract N/A 10 million 100 000 records, 256 MB

Final Extract N/A 10 million 100 000 records, 256 MB

Large scale data refresh or
modications

350 000 5 million 100 000 records, 256 MB

Planned Exception Process
Submit a Support ticket at minimum of 10 days in advance of the planned exception.
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The content of this ticket must contain the following text with the appropriate answers describing the volume limits
modication.

• Incident Information:

• Request Type: Conguration

• CS Priority: High

• Change Request: Seing Change / Activation

• Product: Taleo Connect

• Component: Taleo Connect Client or Taleo Connect Broker

• Zone: Production (only)

• Zone URL: xxxx.taleo.net

• Title: Request for modication for Volume Limits

• Description:

• When are the volume limit modications needed to be in place, please specify the to & from dates in the
following format. YYYY-MM-DDThh:mm:ss-TZD

• Please specify the reason for this request (i.e. Initial load Special event…)

The volume limit request should be one of the previous Project Type

Conrmation will be made via the Support ticket.

For additional oversight, customers may wish to engage their Client Executive in the notication process for the request
for a planned exception, though this is not required.

Customers are only permied a maximum of 3 planned exceptions per calendar year.

Unplanned Exception Process
Submit a Support ticket at the point that integration is identied as being the cause of the business impact on a
customer’s zone.

The content of this ticket must contain the following text with the appropriate answers describing the volume limits
modication.

• Incident Information:

• Request Type: Conguration

• CS Priority: Business Stand

• Change Request: Seing Change / Activation

• Product: Taleo Connect

• Component: Taleo Connect Client or Taleo Connect Broker

• Zone: Production (only)

• Zone URL: xxxx.taleo.net

• Title: URGENT request for modication for Volume Limits

• Description:

• Please specify the reason for this request (i.e. Initial load Special event…)

The unplanned exception volume limit request will be reviewed. Conrmation will be made via the Support ticket.
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For additional oversight, customer should inform their Client Executive of the escalation if possible, though this is not
required.

The key dierence is that this process is driven by a business stand CS Priority.

Appendix B  

TCC Errors  
TCC Errors usually occur during log in and return an error code.

302
Problem: Protocol HTTP and Port 80 is not a valid combination.

Solution: Select HTTPS and port 443.

401
Problem: the User Name and/or Password and/or ZoneName is invalid, and/or the User Role is dierent than System
Integration

Solution : Validate that you can manually log in the Taleo Administrator WebTop with this User, verify the User Role,
make corrections to your TCC environment le if required, and log in to TCC again

402
Problem: the Taleo zone in currently in maintenance, e.g. Taleo is performing an update or migration (ex: SP, EP, version)

Solution: You have to wait until the Taleo update or migration is completed

403
Problem: Forbidden Access, User does not have the right privileges to access this product, can also happen in
desynchronisation.

Solution: Verify that user name, password, role, and communication protocols are valid for connection to Taleo zone.

404
Problem: You have selected a version of the data model in TCC (ex: 7.5) that is higher than your Taleo zone (ex: 7.0)

Solution: Close TCC, and log again using the data model version that corresponds to your Taleo zone

407
Problem: There is a Proxy authentication error

Solution : Verify your taleoconnectclient.ini le with the proxy information (see User Guide)
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500
Problem: Internal server error, zone received document but failed to process it, usually because document is invalid

Solution: Run the TCC import/export again

The Taleo product could not be accessed
• Problem: the ZoneName is invalid (ex: stagingzone750.taleo.net)

Solution: Make corrections to your TCC connectivity information and log in to TCC again.

• Problem: Protocol HTTP and Port 443 is not a valid combination.

Solution: Select HTTPS and port 443.

The entity is already booked
• The entity record to update is currently being edited by a User. After a certain delay this error message is

returned since the record can’t be updated.

For example:

"Index","Identifier","Status","TransactionType","Result","Message" 
"1","atemplate001","error","jobtemplate.merge",,"The entity is already booked.;"

Out of Memory
• Java heap size memory management parameter -Xmx<maximum heap size> has been added to the

taleoconnectclient.bat and taleoconnectclient.sh scripts. If out of memory errors occur when launching TCC
from the command line, increase the parameter value or add the parameter if it's missing.

Appendix C  

Compatibility  
Taleo Connect Client compatibility with Taleo products is guaranteed one version up, when the same reference model is
used. When the reference model used to create an integration point changes, compatibility is not guaranteed.

Architecture
Taleo Connect Client (TCC) communicates with Taleo Connect Server (TCS) that is embedded in every Taleo product.
TCS uses internal reference models that describe each Taleo product entity available for integration. The reference
models are related to the version of the business engine; the business engine contains sets of business rules that
integration must follow. The reference models are not automatically compatible with each other. Taleo products are
enhanced and modied from one version to the next. The business rules change to comply with the enhancements and
modications.
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For information on the integration reference model changes for each release, refer to the following Notes.

• See: Taleo Enterprise - Taleo Integration Release Notes (MOS under Release Notes, Maintenance Packs, Express
Packs, and Incidents Resolved History)

Example
An integration point built with reference model 11 X for a version 11.X product will continue to function after the product
is upgraded to version 12 X, as long as the reference model remains unchanged. In this case, compatibility is guaranteed.

Product and model compatibility

If the reference model is modied, to take advantage of a new eld for example, then compatibility is not guaranteed.
In this case, the integration points must be re-tested and modied if necessary. A modication to a business rule may
aect integration in a minimal way. Testing is required.

Note: Integrations built using the 7.5 reference model are expected to cease to be formally supported mid to late
2014, though formal communication will be made 12 months in advance of full compatibility support stopping. It is
recommended in preparation to upgrade integration scripts currently on 7.5 to the latest data model version appropriate
for your zone’s version or at least begin the planning activities associated with this upgrade, subsequent testing and
deployment.

The Recruiting/Professional and SmartOrg models have changed considerably from 7.5 upwards and it is recommended
referencing the following guides for further information.

• See: Taleo Integration Migration Guide (MOS under Release Notes, Maintenance Packs, Express Packs, and
Incidents Resolved History)

• See: Product Data dictionaries (MOS under Release Notes, Maintenance Packs, Express Packs, and Incidents
Resolved History)
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Migration  
Given the dependence on the Taleo zone data model for successful integrations, it is important to maintain
compatibility by migrating and upgrading integrations to newer data model versions.

This may require an upgrade to new versions of TCC or simply the application of newer versions of PIP les to an
existing instance of TCC.

Migration Process
The following process should be followed to upgrade an integration script.

1. Download and install the latest version of the product PIP le appropriate for your zone..
2. Install the PIP le in the default location for PIP for your TCC instance.
3. Open TCC and select the migration helper tool.
4. Using the migration helper tool, select the import or export les to upgrade from the existing model to the new

model corresponding to the PIP downloaded in step 1.
5. The output from the migration helper tool is a new le named with the extension *_migration_*.xml. Modify

the extension and location to correspondence to your existing deployment package requirements and setup.

During migration, some elds may not be migrated because they no longer exist or are not available in the new model.
When this happens, a Migration Warning appears in the report indicating that a manual migration must be done to
complete the process. The elds that must be deleted or replaced are clearly identied.
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